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CH-1 COMPUTER A WONDER
Exercises
A. 1. Calculate, 2. Natural, 3. Petrol, 

4. Man-made, 5. Machine
B. 1. False, 2. False, 3. False, 4. False, 5. True
C. 1. (a), 2. (a), 3. (c), 4. (b), 5. (c)
D. 1. (d), 2. (a), 3. (e), 4. (b), 5. (c)
E. 1. Aero plane, car

2. Mixer, Washing Machine
3. (i) Work very fast, (ii) Save time
4. Plant, sun
5. Sewing Machine, Rickshaw

Activity Based Questions
1. Computer, 2. Rock, 3. Plant, 4. Chair
5. Cart

CH-2  COMPUTER USED IN OUR LIFE
Exercises
A. 1. records, 2. calculate, 3. messages,

4. music, 5. games
B. 1. True, 2. False, 3. True, 4. True, 5. False 
C. 1. (c), 2. (c), 3. (a), 4. (c)
D.

E. 1. (a) To type letters.
     (b) Send or recieve messages.
2.  Railway station, airports, office.
3. Yes, we can do our homework on a 

computer.

Contents
Computer - 1
Computer - 2
Computer - 3
Computer - 4
Computer - 5

Drawing pictures Send and receive 
E-mail

Book ticket Office work

Activity Based Questions
1. Withdraw money þ

2. Send and receive E-mail þ

3. Swimming ý

4. Calculation þ

5. Play games þ

6. Run ý

CH-3  PARTS OF A COMPUTER
Exercises
A. 1. Input, 2. Monitor, 

3. Central Processing Unit, 4. Data
5. Pointing

B. 1. False, 2. False, 3. True, 4. False, 5. True
C. 1. (a), 2. (a), 3. (a), 4. (c)
D.

E. 1. CPU is the brain of computer.
2. Monitor is the part of computer is 

used to display result.
3. Keyboard is used to type letters, 

numbers or words.
4. Visual Display Unit (VDU) 

Activity Based Questions
Monitor 3
Keyboard 4
Mouse 6
CPU 1

CH-4 HOW TO START A COMPUTER
Exercises
A. 1. Desktop, 2. Start button, 3. Shut down,

4. Icons
B. 1. False, 2. True, 3. False, 4. False, 5. True
C. 1. (b), 2. (b), 3. (b), 4. (a)

Mouse MonitorCPUKeyboard
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D. 1. (c), 2. (d), 3. (a), 4. (b)
E. 1. Cortana is an intelligent personal 

assistant (or simply IPA).
2. The graphical symbol on desktop is 

know as Icons.
3. Click on power button and option.
4. 1. Maintain silence in the lab.
    2. Enter computer lab in a queue.

Activity Based Questions
Across – 1. Icons

   2. Taskbar
Down – 1. Start

  2. Desktop

CH-5 KNOW ABOUT KEYBOARD
Exercises
A. 1. keyboard, 2. number, 3. Spacebar,

4. Backspace, 5. two
B. True, 2. True, 3. False, 4. True, 5. True
C. 1. (c), 2. (a), 3. (b), 4. (b), 5. (b)
D. 1. (c), 2. (d), 3. (b), 4. (a)
E. 1. Backspace key act like an eraser.

2. Spacebar key is used to insert spaces 
between words.

3. 26 keys are there on a keyboard.
4. Two enter keys are there on a key 

board.
5. Special key are used to perform special 

task.
Activity Based Questions
Do yourself

CH-6 USING A MOUSE
Exercises
A. 1. Draw, 2. 3, 3. open, 4. tail, 5. click
B. 1. True, 2. False, 3. True, 4. False, 5. False
C. 1. (a), 2. (c), 3. (a), 4. (b)
D.

To move the mouse 
pointer

To open an item

To select an item
The mouse pointer 

looks like
Click

Rotate

Double click

E. 1. We fix the tail of a mouse to CPU.
2. We clicking right button to see the 

possible action that can be applied on 
the selected item.

3. Index finger must be placed on the left 
mouse button.

4. Pointer moves on the screen when we 
move the mouse.

5. We call clicking the pressing of mouse 
button.

Activity Based Questions
Do yourself

CH-7 MS PAINT
Exercises
A. 1. Ribbon, 2. Tab, 3. Paint,  4. Quick 

Access, 5. Eraser
B. 1. True, 2. False, 3. True, 4. True, 5. True
C. 1. (c), 2. (b), 3. (b), 4. (c)
D.

E. 1. Pencil tool, Brush tool.
2. Size button is used to change the 

thickness of a line.
3. Pencil tool is used to draw a free 

hand drawing.
4. Line tool is used to draw a line.
5. We use eraser tool to remove the 

extra or wrong drawing.
F. Do yourself
Activity Based Questions
Do yourself

CH-8 TUX TYPING
Exercises
A. 1. Tux typing, 2. Tux penguin, 

3. spacebar, 4. Esc keys

Paint button

TitleBar Ribbons

Group

Drawing Area
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B. 1. True, 2. False, 3. True, 4. True
C. 1. (b), 2. (b), 3. (a), 4. (c)
D. 1. Step-1: In menu option choose fish 

cascade.
    Step-2: Select the level.
    Step-3: Select the option.
    Step-4: Select he alphabet option.
2. Tux Penguin start eating the fish when 

press a particular alphabet on keyboard 
in a fish cascade game.

3. Tux typing is a simple typing tutor 
program.

4. In Comet Zap game Tux Penguin defends 
the Earth from the meteonites impact.

MODEL TEST PAPER-1
1. a. (iii), b. (iii), c. (i), d. (i), e. (iii)
2. a. Input, b. Central Processing Unit,

c. music, d. games, e. natural
3. a. True, b. False, c. False, d. True, e. False
4. 1. Rickshaw and sewing machines need 

Human power.
2. Hospital, Bank and Railway station 

computers are used.
3. Monitor is used to display result.
4. Start menu is displayed on clicking 

start button.
5. Visual Display Unit (VDU)

5.

MODEL TEST PAPER-2
1. a. (ii), b. (i), c. (ii), d. (i), e. (iii)
2. a. Number, b. Open, c. Quick Assess,

d. Tux Penguin, e. Click
3. a. True, b. False, c. False, d. True, e. False
4. a. Two enter keys are there on a 

keyboard.
 b. In comet zap game Tux Penguin def-

        ends the earth from he meteorites impact.
c. Index finger must be placed on the left 

mouse button.
d. Pencil tool is used to draw a freehand 

drawing.
e. Tux Penguin start eating the fish when 

press a particular alphabet on keyboard 
in a fish cascade game.

5.

Drawing pictures Send and receive 
E-mail

Book ticket Office work

To move the mouse 
pointer

To open an item

To select an item
The mouse pointer 

looks like
Click

Rotate

Double click
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CH-1 COMPUTER A MACHINE
Exercises
A. 1. E-mails, 2. Books, 3. Items, 4. Medical
B. 1. True, 2. False, 3. False, 4. True
C. 1. (b) , 2. (a) , 3. (c), 4. (c)
D. 1. (c), 2. (a), 3. (b), 4. (e), 5. (d)
E. 1. Hospitals, Banks

2. (i) Desktop computer, 
    (ii) Laptop computer,
    (iii) Tablet computer.

3. (i) Storage : Computer can store a 
large information.

  (ii) Speed : Computer work very fast 
and do many job at the same time.

(iii) Accuracy : Computer does not 
make any mistake.

4. Uses of computer in a bank:
1. The details of our accounts in the 

bank.
2. Withdraw money from ATM.
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My Activity
Type Letter þ Jump ý

Print bills ý Jog ý

Book Tickets þ Walk ý

Play music þ

Store records þ

CH-2 PARTS OF A COMPUTER
Exercises
A. 1.Electronic, 2.Four, 3. Power, 4. Mouse, 

5. 104
B. 1. False, 2. True, 3. True, 4. False, 5. True
C. 1. (c), 2. (c), 3. (a), 4. (c), 5. (c)
D. 1. Monitor, CPU, Mouse and Keyboard 

is a main parts of a computer.
2. CPU called the brain of computer.
3. Keyboard is enter information into a 

computer.
4. Mouse is used to point, move and select 

any item on the monitor. Mouse is used 
to play games and draw pictures.

5. There are three types of printers:
     1. Dotmarix, 2. Inkjet, 3. Laser Printer

My Activity
Do it yourself.

CH-3 HOW DOES A COMPUTER WORKS
Exercises
A. 1. Data, 2. Input, 3. Device, 4. Output, 5. Fast
B. 1. True, 2. False, 3. True, 4. False, 5. True
C. 1. (d), 2. (d), 3. (b), 4(a)
D. 1. The three steps on a computer works

Input – Processing – Output (I-P-O)
2. Keyboard and Mouse are used to enter 

data into a computer.
3. Monitor is the part of a computer which 

display the output.
4. Computer : 

1. It has very large memory.
2. It can work on numbers and alphabets.
Calculator
1. It has less memory.

           2. It can work only on numbers.
E. 1. (c), 2. (a), 3. (b)
My Activity

1. Input, 2. Output, 3. Processing, 4. Input, 
5. Output, 6. Processing

CH-4 OPERATING A COMPUTER
Exercises
A. 1. Power, 2. UPS, 3. Start, 4. Icon, 5. Right
B. 1. True, 2. True, 3. True, 4. True, 5. False
C. 1. (b), 2. (b), 3. (b), 4.(a)
D. 1. (e), 2. (c), 3.(d), 4. (b), 5. (a)
E. 1. The Steps are:

    (a) Switch ON the main power supply 
button.

    (b) Switch ON the UPS.
(c) Switch ON the power supply 

button of the CPU.
(d) Finally Switch ON the Monitor 

button.
2. The computer is switched on, a screen 

will display on the monitor called des
        -ktop.

3. An icon is a small picture of the program 
shown on the desktop.

4. The blue Title bar indicate means 'it 
is active'.

5. The use of Recycle Bin is stores all the 
deleted folders and files.

My Activity
1. Desktop, 2. Title bar, 3. UPS

CH-5 THE KEYBOARD
Exercises
A. 1. Spacebar key, 2. Number, 3. Delete, 4. 

Shift, 5. Right arrow.
B. 1. False, 2. True, 3. False, 4. False, 5. 

False, 6. False
C. 1. (a), 2. (d), 3. (a), 4. (b), 5. (b), 6. (c)
D. 1. (c), 2. (a), 3. (e), 4. (b), 5. (d)
E. 1. Three types of keys on the keyboard

(a) Alphabet keys
(b) Number keys
(c) Special keys
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2. & (and sign)
3. Special keys are:

1. Spacebar Key, 2. Enter key, 3. Caps 
Lock key, 4. Backspace key

4. Arrow keys help us to move cursor 
on the screen.

5. Delete key and Backspace keys are 
used to erase the typed letters.

My Activity
  - Top Left  Function keys
  - Top Right  Number keys
  - Bottom Left  Space bar
  - Bottom Right  Arrow Keys

CH-6 MICROSOFT PAINT 2016
Exercises
A. 1. Paint, 2. Command, 3. Title, 4. Blank, 

5. Eraser
B. 1. False, 2. False, 3. True, 4. False, 5. True
C. 1. (a), 2. (b), 3. (c), 4.(a)
D. 1. (e), 2. (c), 3.(b), 4. (a), 5. (d)
E. 1. Title bar displays the program name 

and file name.
2. Tab is the part of window which contains 

tool arranged in different groups.
3. Drawing area is used to draw and 

colour a picture.
4. Eraser tool is used to erase a drawing.

My Activity
1. Drawing Area, 2. Rectangle Tool,
3. Eraser Tool, 4. Save Button
5. Quick Access Toolbar

CH-7 MICROSOFT WORD 2016
Exercises
A. 1. MS Word, 2. Create, 3. File, 4. Ctrl + N, 

5. Ctrl + O
B. 1. False, 2. True, 3. True, 4. True, 5. False
C. 1. (c), 2.(a), 3.(c), 4. (c), 5. (b)
D. 1. These steps are opening MS Word:

 1. Click on Start button.
2. Select All apps option in Start menu.
3. A menu in alphabetical order will 

open.

4. Click MS Word 2016 will appear.
2. These steps are create a new file:

1. Click on the file tab.
2. Select New option.
3. Caps list will appear Double–click 

on the blank document. A new file 
will open.

3. To exit MS Word, Click on Exit in 
File tab. The MS Word will be closed.

4. To open and existing file following 
these steps:
1. Click on the File tab and select 

open option.
2. A pane on right side will be open 

and click on browse to find the 
saved file which you want to open.

3. The open dialog box will appear.
4. Select the file by clicking on its 

name and click the open button.
   5.The file tab is the button that gives 

you have basic commands like New, 
Open, Save, Print, Exit, etc. This is 
the place to come when you need to 
create a new document. Open a saved 
file or print a document etc.

My Activity
1. Title bar, 2. Zoom control, 
3. Document Area, 4. Status bar

CH-8 TUX IN MATH
Exercises
A. 1. 999, 2. Hall of frame, 3. meteors, 4. 1, 5. 

igloos
B. 1. True, 2. True, 3. False, 4. True, 5. False
C. 1. (a), 2. (a), 3. (c)
D. 1. Tux math is an educational as well as re- 

creational game that helps the practice of 
simple arithmetic operations of addition, 
subtraction, multiplication and division.

2. Max-answer option sets the maximum 
value that any of the operands or the re- 
sult can hold in any of the operations.

3. Fraction-to-keep is a percentage expressed 
as decimal number between 0 and 1, and 
indicates the number of operation.
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4. For each of the operations we can 
decide if we allow the player to answer 
the result (last) or also allow the 
unknown to solve is one of the operators 
(first and middle).

5. The failed questions are asked again in 
random order if the value is 1. The 
game continues until all the questions 
have been answered correctly or  igl-

           oos have been destroyed.
If the value is 0, all issues failed or not 
are re-inserted at the end of the list of 
questions. The game can only end wh

           -en all igloos are destroyed.
MY ACTIVITY QUESTIONS 

MODEL TEST PAPER-1
A. 1. (c), 2. (c), 3. (a), 4. (a)
B. 1. False. 2. True, 3. True, 4. False
C. Output à processing à Input
D. 1. Three types of computers are:

     (i) Desktop computer, (ii) Laptop 
computer, (iii) Tablet computer

2. CPU is called the brain of the 

computer.
3. Keyboard is used to enter data into a 

computer.
4. The Title bar is gray in colour it means ' 

the file is not active the title bar.

MODEL TEST PAPER-2
A. 1. (a), 2. (b), 3. (c), 4. (a)
B. 1.   Clicking, 2. Enter, 3.  Drag, 4. Backspace
C. 1. False, 2. True, 3. True, 4. True
D. 1. Special keys are:

    (i) Spacebar key, (ii) Enter key,
    (iii) Caps Lock key,
    (iv) Backspace key
2. In most cases, a double click with the 

left mouse button and is used to open 
or execute a file, folder, or software 
program.

3. It is a collection of related commands.

Computer-3

CH-1 PARTS OF A COMPUTER
Exercises
A. 1. Information, 2. Store, 3. Input, 4. CU,

5. CPU
B. 1. False, 2. True, 3. False, 4. False, 5. True
C. 1. (a), 2. (c), 3. (a), 4. (b) 
D. 1. Computer is an electronic device that 

works on the principal of IPO (Input 
Process Output) cycle. It takes input, 
process it according to given 
instruction and gives output.

2. CPU is made of three main parts:
1. MU (Memory Unit)
2. CU (Control Unit)
3. ALU (Arithmetic and Logical Unit)

3. CU stands for Control Unit. This unit 
controls and manages the working of 
all the port of a computer.

4. CPU is known as the brain of a 
computer.

5. Computer has a features:
1. Speed : Computer performs 

calculation at a very high speed. 
2. Storage : A computer can store huge 

amount of data and information it 
has hard disk that stores data and 
information.

E. 1. Printer,  2. Joystick
My Activity

       1. Speaker      2. Monitor 3. Printer

4. Mouse 5. Scanner 6. Joystick

CH-2 HARDWARE AND SOFTWARE
Exercises
A. 1. Hardware, 2. Storage device,
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3. Output devices, 4. Opening system,
5. Software

B. 1. True, 2. False, 3. True, 4. True, 5. False
C. 1. (a), 2. (a), 3. (b), 4. (b)
D. 1. Parts of a computer that we can touch 

and fell called hardware. Hardware 
includes all the input device.
Example : Keyboard, Mouse, Scanner, 
etc.

2. A group of instructions given to the 
computer is called software.

            Example: MS Paint, MS Word.
3. Hardware

1. Hardware is physical part of 
computer.

2. Hardware consists of electrical and 
mechanical components.

3. Hardware is important for software.
Software

1. Software is a set program.
2. Software consists of instruction in 

computer language.
3. Software is also important for 

hardware.
4. Operating system is a part of system 

software that makes computer run. It 
manages all the input and output 
operations.

               Example: MS-DOS, Windows.
5. Multimedia software is used to play 

movies on computer.
6. Communication software is used to 

connect to computer to each other to 
transfer the data. 

     Example: Phone Dialer, Dial up networking. 
E. 1. Printer,  2. Graphical Software
My Activity

Reason : It is an application and it is a part of 
computer software.

CH-3 UNDERSTANDING WINDOWS
Exercises
A. 1. Taskbar, 2. Task view,  

3. Window store, 4. Customization, 
5. Start

B. 1. True, 2. True, 3. True, 4. True, 5. False
C. 1. (a), 2. (b), 3. (b), 4. (a), 5. (a)
D. 1. Window is an operating system. It is 

made by a company named Microsoft 
Corporation USA. When we switch on 
the computer the operating system 
gets loaded into the computer which is 
called windows.

2. Taskbar is located at the bottom of the 
desktop. Row of buttons and icons in 
the taskbar. It consists of start button 
Tool box, Task manager, system tray. 
Area and notification.

3. Features of Windows 10:
1. Windows 10 is more attractive 

having a complete set of new 
pictures, themes and icons.

2. Window 10 provides a window store 
application. We can get a lot of free 
apps, games and songs.

4. Start button is present at the bottom 
left corner of the taskbar. On clicking 
start button a list option appears. This 
list is called Start menu. This menu 
contains many options like all Apps, 
Cortana search box, pair options and 
same other applications.

5. A screen saver is a program that usu- 
ally displays various images on the 
screen that is on but not in use.

E. To add the screen saver do the following 
steps:
1) Click on the Windows icon in the 
lower left of your screen right next to the 
search bar.
2) Click on Setting > Personalization > 
Lock Screen.
3) Scroll down the Lock Screen settings 
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and click on Screen Saver Settings in the 
right pane.
4) Here you can adjust the setting 
according to your preferences.
Windows 10 offers the following six 
screen savers 3D Text, Blank, Bubbles, 
Mystify, Photos and Ribbons.

              MY ACTIVITY QUESTIONS 
CH-4 TUX PAINT
Exercises 
A. 1. Tux Paint, 2. drawing area, 3. selector,

4. Two, 5. Rain
B. 1. True, 2. True, 3. False, 4. True, 5. False 
C. 1. (a), 2. (d), 3. (b), 4. (c)
D. 1. Tux Paint has following features:

1. Tux paint is a free software which 
can be downloaded from internet.

2. It contains many tools which have 
various functions.

3.  It is an easy to use software.
4. Select a tool, it plays a funny sound 

effect.
5. It provide many stamp tool.

2. Stamp tool enables you to put a stamp 
and add an image in a drawing. Stamp 
is a readimade part that can be used to 
make some pattern by  repeating. 
Follow the steps given below to apply 
stamps:
1. Click stamp button.
2. Choose the stamps.
3. Use slope bar to increase or decrease 

the size of stamp.
4. Place the mouse on canvas and click, 

the select stamp will be pasted.
5. Click on mirror option and select 

mirror button to paste mirror 
image of stamp.

3. Bricks tool is a small and large bricks 
using. The bricks tools have small 
bricks and large bricks.
These are following steps to use bricks 
tool in drawing:

(i) Select the Brick tool (small and 
large) from the sub-tool bar of 
magic tool.

(ii) Click on the canvas and you want draw 
bricks and click there Bricks will we 
drawn at the desired location.

4. Rain tool is used to add rain drops in 
your drawing.
These are following steps apply it in 
drawing.
(i) Click magic tool and choose the 

Rain tool from the sub-tool bar.
(ii) Click on the canvas and where you 

want to add rain effect and click 
there.

Activity Based Questions:
Ananya should use ‘Brick Tool’ to draw a     
pucca house. She must use following steps  
to draw a pucca house:
1. Select Brick tool ( small or large) from 

the sub-tool bar of magic tool.
2. Place the cursor on the canvas where 

you want to draw and click there. 
Bricks will be drawn at the desired 
location.

CH-5 EDITING TEXT IN MS WORD 2016
Exercises
A. 1. Editing, 2. Overtype, 3. Moving,

4. Ctrl+C, 5. thesaurus
B. 1. True, 2. True, 3. False, 4. True, 5. True
C. 1. (b), 2. (c), 3. (c), 4. (b), 5. (c)
D. 1. MS Word 2016 is a latest version of 

application software used for word 
processing. It was introduced by 
Microsoft Corporation on 22 Sept-

           ember 2016. We can do following 
things with the help of MS Word 2016:
1. Produce letters, reports, notices, etc 

quickly and in a presentable manner.
2. Insert graphics and make use of various 

drawing tools to draw pictures.
3. Copy and move the text from one 

location to another.
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2. Features of MS Word 2016:
1. Moving, copy and delete the text.
2. Checking Spelling and Grammar.
3. Using Thesaurus.

3. Moving Text : Moving a text means to 
shift text from one location to another 
location in the same document or in 
another document.
Copying Text: Copying a text means to 
prepare and display the copy of selected 
text from one location in a document to 
another location in the same document 
on in another document.

4. Use following steps to make a spell 
check in MS Word 2016:
1.  Right click on the misspelled word.
2. A short-cut menu is display and 

show suggestions to replace the 
misspelled word.

3.  Select the correct spelling.
4.  Automatically replace the incorrect 

spelling with the selected option.
E. Mohit can use ‘Thesaurus’ to replace a 

word with a similar meaning word and 
make bettersense.

Activity Based Questions
1. Undo, 2. Thesaurus, 3. Moving Text,
4. Redo

CH-6 FORMATTING A DOCUMENT
Exercises
A. 1. Home, 2. Super script, 3. Bullets,

4. Calibri, 5. Drop caps 
B. 1. False, 2. True, 3. True, 4. False, 5. True
C. 1. (d), 2. (c), 3. (d), 4. (c), 5. (c)
D. 1. Formatting means changing and 

arranging text in a document to make 
it attractive. Formatting is a process of 
making certain text bold or underline 
or setting its font, size, colour, setting 
lines spacing, tabs, etc.

2. We can change the text colour in MS 
Word the following steps:
1. Select the text and click on Home tab.

2. Click on the drop-down arrow in  
Font colour box.

3. Selected colour and selected text is 
displayed in the colour.

3. Following changes are available in MS 
Word 2016:
Changing Font Type, Text Colour, 
Text Case, Superscript and Subscrip 
etc.

4. A large initial letter that drops below 
the first line of a paragraph is called 
drop cap. It is used to give a graceful 
and fancy look to a document.
To apply drop cap follow these steps:
1. Select the first word of the                                                                                                                        

               document.
2. Click on insert tab and select on          

                Drop Cap button in Text group.
3. Define the parameters in Drop Cap     

               options id required.
4. Click on OK button.

5. Superscript option: Superscript option 
places the selected text slightly above 
the baseline.
Subscript option: Subscript option 
places the selected text slightly below 
the baseline.

6. To apply border and shading effect 
following steps:
1.  Select the text and click on the drop-

down next to the border button in 
paragraph group in Home tab.

2. Select the Borders and shading option.
3. The border and shading dialog box 

appears.
4. Select the line style using the scroll 

bar in style section.
5. Select the desire colour from the 

colour section.
6. Choose the line width from the 

width section.
7. Click on OK to finalize the selections 

made.
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E. 1. Yes, we can apply in our document. 
We have to apply drop cap common 
on that letter. To apply drop cap follow 
these steps:

v Select the first word of the document.
v Click on Insert tab > and select on 

drop cap button in text group.
Define the parameters in Drop cap 
option is required click on OK button.

2. To enhance the beauty of the text, we 
can add a variety of borders and 
shading effects to a paragraph or to 
entire page. 
To apply border and shading effect do 
following steps:
1. Select the text and click on the drop-

down next to the border button in 
paragraph group in Home tab.

2. Select the border and shading 
option.

3.  The Border and shading dialog box 
is appears.

4.  Select the line style using the scroll 
bar in style section a drop down 
menu is displayed.

5.  Select the desired colour from the 
colour section.

6.  Choose the line width from the width 
section.

7.   Click on OK to finalize the selection 
made.

Activity Based Questions
1. (b) To apply drop cap

2. (a) To subscript

3. (e) To apply superscript

4. (c) To apply bullet

5. (d) To apply border and shading

CH-7 WORKING WITH MS PAINT
Exercises
A. 1. Top left, 2. Resize, 3. Select, 4. MS-

Paint, 5. Undo

B. 1. False, 2. False, 3. True, 4.False, 5. True
C. 1. (b), 2. (c), 3. (a), 4. (a), 5. (b)
D. 1. MS-Paint is a program which used to 

draw picture and paint them with 
different colour.

2. There are seven selection tools:
1. The Rectangle select.
2. The Ellipse select.
3. The Free select (the Lasso)
4. The select contiguous Regions (the 
magic)
5. The select by colour.
6. The select shapes from image (intelligent 

scissors)
7. The foreground select.

3. To resize of an object to the following 
steps:

v Select the drawing by covering its 
boundary using Select tool.

v Select the part of drawing using Select 
tool.

v Select the resize option in Image group 
on Home tab.

v Click on OK to finalize the selections.
4. There are two ways to flip a picture, 

horizontal and vertical. To flip a part 
an object, perform the following steps:

v Click on the select tool and select the 
picture.

v Select the rotate option in the Image 
group on the Home tab.

v A list of options display for changing 
the rotation or fliping.

v Select desired option displayed list and 
OK button.

5. Text tool use to add a text below the 
drawing.

E. He can use copy tool to copy it.
Activity Based Questions:

1. SELECT,   2. FLIP,   3. RESIZE,
4. MAGNIFIER,   5. TEXT TOOL
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CH-8 SIMPLE SPRITE MOVEMENT ON 
SCRATCH

Exercises
A. 1. Baby, 2. Look, 3. Sound, 4. Stop All 

Sounds, 5. Set Volume to ()%
B. 1. True, 2. False, 3. False, 4. True, 5. True
C. 1. (b), 2. (c), 3. (d), 4. (c), 5. (c)
D. 1. The following steps are creating a new 

project in scratch:
1. Click on File menu from the menu 
bar.
2. Select New option from the drop-
down menu.
3. Select the desired option. If you 
want save or not save your project.
4. New scratch window will be 
opened.

2. 1. Say ()
2. Think ()

3. Sound block use to play the sound of a 
sprite.

4. To import a sound follow the steps 
given below.
1. Click sound tab on Script tab.
2. Click on import button. The import 

sound box containing different sound 
effects.

3. Select the desired sound and click 
OK.

5. Components of sound block:
1. Play sound: As this block plays a 

sound without a delay in its script, it 
is mainly used when a sound must be 
played without bothering the script.

2. Play sound () Until Done (block): 
As this block plays a sound and 
sound pause in its script until the 
sound is done, it is mainly used when 
a sound must be played and the 
script must be kept from continuing 
until the sound has finished playing.

3. Play Drum () for () Beats (block): 
As the block plays an instrument, it 

is widely used when a song is played 
with the sound blocks.

E. Deepak need to do following steps to 
record  the prayer:
v Click sound tab on script area.
v Click on Record button. Sound 

Recorder dialog box will be opened.
v Click on red circle to record the 

desired sound.
v After finishing click stop button.
v Click OK to save your recorded 

sound.
Activity Based Questions

CH-9 MAINTENANCE OF COMPUTER
Exercises
A. 1. Unplug, 2. Keyboard, 3. Dry,

4. Disk scanner, 5. dust, heat 
B. 1. True, 2.False, 3. True, 4. False, 5 False.
C. 1. (b), 2. (b), 3. (b), 4. (c), 5. (a) 
D. 1. We should wipe the case gently and clear 

the ventilation part for any hindrances. 
Compressed air is considered good for 
this.

2. Moisture and heat are two deadly 
enemies of the PCs.

3. A disk scanner program is used to repair 
and detect hard disk errors, fix file 
allocation table (FAT) errors and 
reconstruct some damaged information. 
It searches and remove the unnecessary 
files from the computer.

4. Cleaning the unwanted files can help 
to speed up our computer. We can 

Script Editor

Play all actions

Block palette
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clean these files using the disk 
cleaning program.

5. Defragmentation is a program that 
rearranges, the stored files in a logical 
order. To overcome the fragment 
problem we need to defragment the 
hard disk at least once a month.

E. It happens due to the accumulation of 
unwanted files. Cleaning these unwanted 
files can help to speed up her computer. 
She can clean these files using the disk 
cleaning program.
The Disk Cleanup program is used to 
remove unwanted or temporary files. It 
helps to free up space on the computer's  
hard disk.

     Activity Based Questions
Do yourself

MODEL TEST PAPER-1
A. 1. (b), 2 (b), 3. (a), 4.(a), 5. (b)
B. 1. Store, 2. Hardware, 3. Task view, 

4. Tux Paint, 5. Editing
C. 1. False, 2. False, 3. True, 4. True, 5. True
D. 1. Features of MS Word 2016:

1. Moving, copy and delete the text.
2. Checking Spelling and Grammar.
3. Using Thesaurus.

2. Stamp tool enable you to put a stamp 
and add on image in a drawing. Stamp 
is a ready made part that can be used to 
make some pattern by  repeating. 
Follow the steps given below to apply 
stamps:
1. Click stamp button.
2. Choose the stamps.
3. Use slope bar to increase or decrease 

the size of stamp.
4. Place the mouse on canvas and 

click, the select stamp will be pasted.
5. Click on mirror option and select 

mirror button to paste mirror image 
of stamp.

3. A screen saver is a program that usually 

displays various images on the screen 
that is on but not in use.

4. Hardware
1. Hardware is physical part of 

computer.
2. Hardware consists of electrical and 

mechanical components.
3. Hardware is important for software.

Software
1.  Software is a set program.
2. Software consists of instructions in 

computer language.
3. Software is also important for 

hardware.
5. Computer has a features.

1. Speed : Computer performs 
calculation at a very high speed. 

2. Storage : A Computer can store 
h u g e  a m o u n t  o f  d a t a  a n d  
information it has hard disk that 
stores data and information.

E.

Reason : It is application and it is a part of 
computer software.

MODEL TEST PAPER-2
A. 1. (a, b, c),  2 (a), 3. (c), 4. (b), 5. (b)
B. 1. Un plug, 2. Baby, 3. Top left, 4. Home,

5. Resize
C. 1. True, 2. True, 3. True, 4. False, 5. True 
D. 1. We can change the text colour in MS 

Word the following steps:
1. Select the text and click on Home tab
2. Click on the drop-down arrow in 

Font colour box.
3. Selected colour and selected text is 

displayed in the colour.
2. There are seven selection tools:

1. The Rectangle Select.
2. The Ellipse select.
3. The Free select (the Lasso).
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CH-1 KNOWING  ABOUT  YOUR

    COMPUTER

Exercises

A. 1. Output, 2. brain, 3. key, 4. Flash 
drive, 5. microphone, 6. laser

B. 1. True, 2. False, 3. False, 4. False, 5. 
True, 6. False

C. 1. (c), 2. (a), 3. (a), 4. (b), 5. (b) 

D. 1. Input à Processing à Output
2. A scanner is an input device that help us 

to put printed pictures, tents and 
illustrations into a computer. It reads the 
images and translates the information 
and send the information to the 
computer.

3. Web camera is a camera that help us to 
put images into a computer by directly 
clicking them. It is used for Web Chart 
as it helps us to see the person we are 
chatting with.

4. The device through which we enter 
data and instructions in the computer 
are called input devices. The most 
commonly used input device are 
keyboard, Mouse.

5. ALU is (Arithmetic and Logic Unit) this 
unit performs arithmetic operations such 
as addition, subtraction, multiplication 
and division. It also perform logical ope-

           ration. Such as equal to greater than, less 
than and not equal to.

6. Dot Matrix printer
    1. It print the images and text in a 

form of tiny dots.

4. The select contiguous Regions (the 
magic).

5. The select by colour.
6. The select shapes from image 

(intelligent scissors).

7. The foreground select.
3. Text tool use to add a text below the 

drawing.
4. 1. Say (), 2. Think ()
5. Cleaning the unwanted files can help 
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2. This printer is slow and noisy and 
does not produce high quality 
output.

3.  It can print only in black and white.

4.  This printer is also called impact 
printer.

Inkjet printer

1. Inkjet printer prints character by 
spraying little droplets of ink on a 
paper.

2.  This printer is much faster than the 
dot matrix printer.

3.  It can print both black white and 
colour prints.

4.   This printer is called non-impact printer.

E. 1. She play game in computer with the 
help of joystick.

2. With the help of scanner and printer, 
we can take the photocopy of her 
notebook.

My Activity

1. Webcam 2. Barcode Reader

3. Light Pen  4. Microphone

5. Joystick 6. Hard disk

CH-2 MANAGING FILES AND FOLDERS

Exercises

A. 1. Microsoft corporation, 2. File Explorer

3. Shortcut, 4. File, 5. Recycle Bin

B. 1. False, 2. True, 3. True, 4. True, 5. True

C. 1.(b), 2.(d), 3.(b), 4. (a), 5. (d)



D. 1. Three features of window 10 are :

(i) The cortana virtual assistant : 
Microsoft virtual assistant, which has 
been preset in its phone operating sys- 
tem. The most popular features of wi- 
ndows 10.

(ii) The new and improved start menu : 
The new start menu of windows 10 gives 
us quick access to app and services.

(iii) Multiple Desktops: Windows 10 has 
a ability to open multiple desktops at 
the same time.

2. The Cortana is Microsoft's virtual 
assistant. It is directly accessible from 
the desktop with either a click or a 
voice command. It is used as a handy 
helper when we need to get stuff done.

3.(i) File : A file is a collection of related 
information. It contains all programs 
and data, and the computer reads and 
writes files. Files are identified by a 
shot 'extension' at the end of their 
home.

(ii) Folder : A folder can contain one or 
more files and it can be emptied 
with just a name. Folder provided a 
method for organizing files. Folders 
are also called directories and they 
are created on the hard disk.

4. To save a file do the following steps:-
    v Click on File menu.
v Select save option and save your 

document in your document folder.
5.Short cut provides a quick and easy 

access to a program. It allow to create 
links to program in any folder, start 
button, taskbar, Desktop or other 
location on the computer.

6.This PC Icon can be use add as well as 
remove file or folder.

E. 1.Isha need to do following step to re- 
name the folder:-
v Select the file or the folder that has 

to be renamed.
v Right click the mouse button and 

select the Rename option. Now 
type the new name that you wish to 
give to the file or folder.

 2. Pooja Need to perform following  steps 
to create a new folder:

 v First of all she navigate to the location
            where she wants to create a Folder.
v Right click on a blank space in the 

folder location. A drop menu will 
appear.

v Select New folder. A New folder will 
created.

v Give a name to it and press Enter key.

CH-3 MORE ON SCRATCH

Exercises

A. 1. Visual, 2. Scratch, 3. Ask, 4. Variable,
 5. Sprite

B. 1. True, 2. True, 3. False, 4. True, 5. True

C. 1. (d), 2. (b), 3. (c), 4. (b), 5. (b)

D. 1. Scratch is a free visual programming 
language. It was developed by Lifelong 
kindergarden Group within the MIT 
Media Lab.
The features of scratch are as follows:-
v Scratch is available free of cost.
v It is easy to understand and learn.
v It has modified GUL.
v Variable can show and hide.
v It supports for resolution as small as 

800-600.
2. The scripts Area is where scripts can be 

assembled. To code in Scratch simply 
drag blocks out form the eight paletters 
and assemble them in the scripts Area.

3. To open Scratch do the following steps:
v Click on Start window.
v Go to All Apps and click on scratch 

1.4.
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v The Scratch window will appear.
4. To Add a new sprite do the following 

steps:
v Click on File menu on the ribbon.
v Then click new option. A message 

will display save or not save your 
work as you want.

v Then a new sprite will open.
5. Play Instrument in scratch follow the 

given steps:
v Click on Sound menu.
v A drop down menu having several 

menu will come.
v Click set the instrument. After 

clicking a number of instrument will 
be displayed select any one instrument 
you want.

v Click on play button. The sound will 
be played.

E. 1. Aniket perform the following steps to 
play the guitar.
v Click on Sound menu.
v A drop down menu having several 

menu will come.
v Click set the instrument after clicking 

a number of instrument will be 
displayed. Select any one instrument 
you want.

v Click on play button. The sound 
will be played.

             MY ACTIVITY QUESTIONS 

CH-4 MORE ON WORD 2016

Exercises

A. 1. Word processing, 2. Cut and paste, 3. 
Formatting, 4.Calibri, 5. Left align

B. 1. True 2. True,3. False, 4. False, 5. True

C. 1. (a), 2. (c), 3. (c), 4. (a), 5. (d)

D. 1. Text Formatting means changing the 
look of text or document.

2. Copy and Paste textile do the following 
steps:-
v Select the text you want to copy.
v Click on Home tab.
v Click on copy option in Clipboard 

group.
v Place the cursor where you want to 

paste the copied text.
v Click on Home tab > clipboard 

group > paste.
v The copied text will be placed at 

the new place.
3. MS Word has Four types of alignment 

starts. These are:-

1. Left Alignment: Left alignment 
text set each line along the left 
margin of the document.

2. Right Alignment: It align the 
beginning of each line of text along 
the right margin of the document.

3. Center Alignment: It align the 
text in the center of each line 
leaving same margin on both side.

4. Justified Alignment: When the 
text is justified each line fills the 
entire space from left to right.

4. To set the page properties, follow the 
steps:-
v Click on File tab.
v Click on Info option in the right 

side properties option will be 
displayed.

v Click the down arrow and select 
advanced properties.

v A pop up window will appear. In 
this window make the required 
change.

5. To preview and print the document, 
follow the steps given below:
v Save your document.
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v Click on File tab.
v Click the Print option from the left 

side of the file screen.
v Use the button at the bottom of the 

screen to set page.
v After completing page set up, 

check the printer connection to 
your PC printer is ready.

v Click on Print button. You will get 
the hard copy of your document.

E. 1. Ananya need to perform following 
steps to bold the heading.
v Select the heading.
v Select Bold (B) button in font group.
Ananya have to perform following steps 
to highlight the important points:-
v Select the text to be highlighted.
v Go to font group under Home tab.
v Choose a color you to highlight the text.

My Activity

CH-5 MORE ABOUT FORMATTING

Exercises

A. 1. Bullet, 2. Capital, 3. top, bottom, 4. 
Word Art, 5. Alt+H

B. 1. True, 2. True, 3. True, 4. False, 5. False

C. 1.(b), 2.(c), 3. (d), 4. (d), 5. (d)

D. 1. Difference between bulleted and number  
list:

 Bulleted is a symbol which is used to 
marked individual item in a list. We can 
use different types of bullets to mark the 
list items.

   Number list: We can create a number 

list. Numbered list is used, where the 
order of the item is to be given.

 To create a bulleted list following the 
steps:-
v Type the text to be place in list in 

different line.
v Select all the lines containing list 

items.
v Select Bullet button in the Paragraph 

group under Home tab.
v Bullet style will be appear.
v Click on the desired style.
v Select bullet will be applied in the list.

2. Inserting a Special Symbols–
      To insert a special symbols follow the 

steps given below:
v Click the area in the document where 

special symbols to the inserted.
v Click on Insert tab. Go to symbols 

group and click symbol and then click 
More symbols.

v The symbol dialog box will appear. 
Click on special characters in this 
box.

v A number of special characters will 
appear. Select the desired character 
and click Insert.

v Click close.
3. Insert page number in a document 

follow the given steps.
v Click the Insert tab.
v Select page Number from header & 

footer group. A drop down list 
appears.

v Select the location for the page 
number.

v Select the desired style and click 
Close Header and footer from 
Close group in the Design tab.

Font Type

Text Highlight

Font Size Numbering
Bullets Border

Font Color Centre Align

Justify
Right Align

Left Align
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4. Difference between superscript and 
subscript.
1. A subscript or superscript is a 

number, letter or symbol that is set 
slightly below or above the normal 
line of type.

2. Subscripts appear below the baseline 
while superscripts appear above the 
baseline.

3. For Example: A footnote or endnote 
number reference is an example of 
superscript. (Footnote') and Subscript 
(H O ).2 2

5. To add WordArt, follow the steps given 
below :
v Click the Insert tab. Go to the Text 

group and click WordArt  option. A 
box containing different text styles will 
appear.

v Select the desired WordArt style.
v Replace the existing text with the 

selected text in the document.
v Click outside the text box to place 

designer text on your document.
v If you want to change the size of your 

WordArt, use the resizing handles.

E. 1. Varsha need to follow given steps here 
below : 
(i) Open the webpage that she  want to 

save. 
(ii) All browsers have the ability to save 

a webpage, along with all of the 
media on it. You can quickly open 
this window by pressing  Ctrl+S, or 
by doing the following:

 vChrome - Click the Chrome Menu
           button (☰) and select "Save page as".

v Internet Explorer - Click the Gear 
           button, select "File", and then "Save as". 
        If you don't see the Gear button, press Alt 

to show the menu bar, click "File" and then 
select "Save as".

v Firefox - Click the Firefox Menu
           button (☰) and select "Save Page".

(iii)  Give the saved page a name. 
(iv)  Select a location to save the page.

2. To add a  change colour of the page Rohit 
need to perform following steps:
1. Click Design > Page Colour.
2. Pick the colour you want under Theme 

Colours or Standard Colours.

My Activity

CH-6 MORE ABOUT TUX PAINT

Exercises

A. 1. Tux Paint, 2. 360°, 3. Drip magic, 
4. Eraser, 5. Open dialog

B. 1. True, 2. False, 3. True, 4. True, 5. True

C. 1. (b), 2. (d), 3. (b), 4. (d), 5. (c)

D. 1. The following steps for using shapes 
tool are:
v Click the shapes tool in the tool box.
v Choose rectangle from the sub-

tool box on the right side.
v Select color of your choice.

A C M D Y Z I Z L T N

V F O R M A T T I N G

B O L D A L A L N A B

U N P L C I L D E C D

L T N Y M G I M S E F 

L B Q Z Y N C N P G H

E D R Y G M O T A I J

T M T T K E B V C K C

S T V W T N U A I M N

Z Y W U V T N K N O P

J U S T I F Y X G T C
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 v Place the mouse pointer to the 
drawing area.

 v Select a point on the drawing 
which will acts as the centre.

 v Click and drag the mouse to draw 
the rectangle according to size you 
want. Release the mouse button.

 v A spin arrow will appear. This 
arrow is used to spin the image at 
any angle from the centre point. 
Use this arrow in any direction to 
spin the rectangle.

v After completing the drawing, click in 
the drawing area to see the final image.

2. Drip magic is available in magic tool. 
Drip magic tool is used to scatten 
colour/ink and drip away like water. 
This tool also gives a dripping effect to 
drawing.

3. Noise effect is add random noise to your 
picture. We must have experienced while 
watching television, the TV signals 
suddenly goes off. TV screen is filled with 
gray  and  black  dots  along  with  a  noise.

4. The following steps of using real 
rainbow effects are:
v Open a new file with sky blue 

background.
v Click Magic tool in the tool box 

and select the Real Rainbow 
magical effect.

v Place the pointer on the area want 
to draw rainbow and the mouse to 
draw a rough sketch of rainbow.

v After completing the drawing release 
the left mouse button. A real rainbow 
effect will appear on the screen.

5. Exit Tux Paint by following steps:
v Close window ý button on Tux 

Paint title box.
v Clicking Alt + F4 keys or

v Pressing Shift + Control + Escape 
key in squence.

E. Vishal have to use Eraser Tool to delete 
unwanted things by following these steps :
v Place the mouse pointer in the drawing 

area.
v Click the left mouse button and drag 

the eraser to the area which you want to 
erase.

My Activity
1. Edge Effect (d)
2. Foam Effect (e)
3. Grass Effect (f)
4. Real Rainbow Effect (a)
5.. Wave Effect (c)
6. Noise Effect (b)

CH-7 MICROSOFT POWERPOINT 2016

Exercises

A. 1. Presentation, 2. Quick Tool Access Bar, 
3. Status bar, 4. Ctrl Shift +>, 5. Alt + F4

B. 1. False, 2. True, 3. False, 4. False, 5. True

C. 1. (b), 2 (d), 3.(b), 4. (b), 5.(d)

D. 1. To create a presentation following these 
steps:-
v  Click on File tab.
v Select New Option.
v Click Blank Presentation Option. 

Blank slide will be opened.

  The following steps to save a presentation:
v Click on File tab and select the save 

option.
v Click save or save as option.
v Save As dialog box is appears. Select 

any one option to save file.
v Type the name of presentation in File 

name box.
v Click the save button.

2. PowerPoint presentation is made up of a 
Keys Computer (1-5) 19



collection of several pages called slide.
3. The three uses of a presentation are:

(i) Presentation present views and ideas 
effectively by creating a good visual 
impact on the audience.

(ii)People associated with business can 
use it to present information about 
their product or company in seminars 
and meeting.

(iii)Presentation organize the course 
content in the classroom and encourage 
student's learning.

4. The following steps to open presentation 
are:
v Click on File tab.
v Click the open option.
v Open dialog box will display on the 

screen.
v Select the file list displayed in the 

open dialog box.
v Click open button.

5. Exit from power point simply by 
clicking ý the button on right corner 
of Title bar.
The computer will ask to save your 
presentation if not saved.
Click the appropriate button to close 
PowerPoint.

            MY ACTIVITY QUESTIONS 
E. Teacher's Note: Make a group of four 

students each and guide them the steps of 
making a presentations.

CH-8 WORKING WITH SLIDES IN
      POWERPOINT 2016

 Exercises
A. 1. Copy, 2. Slide-master, 3. Control, 4. 

Home, 5. Crop
B. 1. True, 2. True, 3. False, 4. False, 5. True
C. 1.(d), 2. (b), 3.(c), 4. (d), 5. (b)
D. 1. To insert a new slide in a presentation, 

follow the steps given below:

(i) Open an saved presentation. Click 
on New Slide button on the Standard 
toolbar.

(ii) On right side of the window. Slide 
Layout task pane will appear.

(iii)Select any layout as you wish and 
click on it.

(iv) Your new slide is inserted to the 
presentation.

2. Slide show is a collection of pages 
arranged in sequence that contain text 
and images for presenting to an 
audience.

3. To make change to new slide in our 
presentation, follow the steps given 
below :
v  Click the View tab and click the 

Slide Master command.
v The Slide Master tab will be 

selected on the ribbon and the 
presentation will switch to Slide 
Master View.

v Scroll up and select the first slide in 
the left navigator pane. This is the 
slide master.

v Make the desired changes to the 
slide master like change theme, 
background etc.

v Move or delete slide objects as 
required.

v Click the Close Master View command 
on the Slide Master tab when you 
completed your work. The change will 
apply to all slides of the presentation.

4. Rotating : Make a change in the angle of 
any object is called rotating. We can rotate 
the objects in MS PowerPoint. We can 
rotate objects to change their position.

Resizing : Make a change in the size of 
any object is called resizing. We can easily 
resize the objects in MS PowerPoint. 
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Steps to rotate a picture:
v Click the object that to be rotated.
v Click the rotation handle at the top 

of the object and drag it in the 
direction in which you  want to 
rotate. To increase the rotation 15 
degree. Press and hold Shift key 
while dragging the rotation.

5. We need to perform following steps for 
transition of slides:
v Select the slide to which slide 

transition is to be applied.
v Select a slide transition style from 

Transition to This Slide group from 
Transition tab or from More 
button.

v If slide transition effect is to be put 
to all the slides of presentation, 
click on Apply to All.

v Selected slide transition is applied. 
It can be viewed it by playing slide 
show.

E. Simpi need to perform following steps to 
delete unwanted slide:
v Click the View tab.
v Click on the Normal in the 

presentation view group.
v Click the slide tab on the left pane that 

contains the outline and slide tab. Now, 
right click the slide you want to delete 
then click Delete slide.

CH-9 MULTIMEDIA AND INTERNET

Exercises

A. 1. CD-ROMs, 2. Homepage, 3. Internet, 4. 
E-mail 5. Websites

B. 1. True, 2. True, 3. False, 4. True, 5. True

C. 1.(c), 2.(d), 3. (b), 4.(b), 5.(d)
D. 1. When the components of media such 

as text, pictures, sounds graphics and 
animations are used to present the 

information is called multimedia.
2. Components of multimedia:

1. Text, 2. Images, 3. Audio, 4. Video, 5. 
Animation

3. (i) Web page: It is an individual 
page of Website that contains lots 
of information which is put on 
internet in a digital format and 
this page is called web page.

(ii) Web Browser: A Web browser is a 
program that allow you to access 
different website. It also allow you 
to see all the picture, text, videos, 
animation present in a web site. 
Example of some web browsers are 
Internet Explorer, Mozilla Firefox, 
Google Chrome etc.

4. Following hardware and software are 
required to get the internet connection:
v To connect internet a modem, an 

Ethernet cable, and an internet 
connection are required.

v Need  an  internet service 
provides(ISP) for internet 
connection. An ISP provides to 
access the internet.

v The connection can be set up by 
cable company, phone company or 
a private internet provider.

v Needed  Modem, router to share 
internet access with multiple com

                  -puters.
v IP address, a subnet mask and a 

default gateway.
5. A web browser is an application that 

allows you to access different website. 
It also allow to see all the picture, text, 
videos, animation present in a web site. 
Internet Explorer and Google Chrome 
are the some examples of web browser.

E. Steps for booking Indian Railway tickets:
v Login to URL 

https://www.irctc.co.in/mobile with 
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your existing IRCTC user ID and Pass- 
word.

v Click on Book Ticket and fill in det-
          ails for plan my travel.
v Select the train and continue the boo-

          king.
v Use existing passenger list or add pas-

           sengers.
v Confirm booking details and play 

through credit/debit card to get 
successful.
MY ACTIVITY QUESTIONS 

MODEL TEST PAPER-1

A. 1.(c), 2.(b), 3.(d), 4.(b), 5.(c)

B. 1. Microphone, 2. laser, 3. Visual, 4. File 
Explorer, 5. Shortcut

C. 1. True, 2. False, 3. True, 4. True, 5. True
D. 1. Input à Processing à Output

2. A scanner is an input device that help us 
to put printed pictures, texts and 
illustrations into a computer. It reads the 
images and translates the information 
and send the information to the 
computer.

3. To save a file do the following steps:-
    v Click on File menu.
v Select save option and save your 

document in your document folder.
4. Short cut provided a quick and easy 

access to a program. It allow to create 
links to program in any folder, start 
button, taskbar, Desktop or other 
location on the computer.

5. To Add a new sprite do the following 
steps:
v Click on File menu on the ribbon.
v Then click new option. A message 

will display save or not save your 
work as you want.

v Then a new sprite will open.

E. 1. Isha need to do following step to 
rename the folder:-
v Select the file or the folder that has 

to be renamed.
v Right click the mouse button and 

select the Rename option. Now, 
type the new name that you wish to 
give to the file or folder.

 2. Pooja need to perform following steps 
to create a new folder:
v First of all she navigate to the 

location where she wants to create 
a Folder.

v Right click on a blank space in the 
folder location. A drop menu will 
appear.

v Select New folder. A New folder 
will created.

v Give a name to it and press Enter 
key.

MODEL TEST PAPER-2

A. 1. (b), 2. (d), 3. (c), 4. (d), 5. (c).

B. 1.360°, 2. Drip magic, 3. WordArt, 
4. Alt+H, 5. Formatting, Calibri.

C. 1. True, 2. False, 3. True, 4. False, 5. True.

D. 1. The following steps for using shapes tool 
are:
 v Click the shapes tool in the tool box.
 v Choose rectangle from the sub-tool 

box on the right side.
 v Select color of your choice.
 v Place the mouse pointer to the 

drawing area.
 v Select a point on the drawing which 

will acts as the centre.
 v Click and drag the mouse to draw the 

rectangle according to size you want. 
Release the mouse button.

 v A spin arrow will appear. This arrow 
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is used to spin the image at any angle 
from the center point. Use this arrow 
in any direction to spin the rectangle.
v After completing the drawing, 

click in the drawing area to see the 
final image.

2. Drip magic is available in magic tool. 
Drip magic tool is used to scatter 
color/ink and drip away like water. 
This tool also gives a dripping effect to 
drawing.

3. To preview and print the document, 
follow the steps given below:
v Save your document.
v Click on File tab.
v Click the Print option from the left 

side of the file screen.
v Use the button at the bottom of the 

screen to set page.
v After completing page set up, 

check the printer connection to 
your PC printer is ready.

v Click on Print button. You will get 
the hard copy of your document.

4. Insert page number in a document 
follow the given steps.
v Click the Insert tab.
v Select page Number from header & 

footer group. A drop down list 
appears.

v Select the location for the page 
number.

v Select the desired style and click 
Close Header and footer from 
Close group in the Design  tab.

5. Difference between superscript and 
subscript.
1. A subscript or superscript is a number  

letter or symbol that is set slighty  
below or above the normal line of type.

2. Subscripts appear below the baseline 
while superscripts appear above the 
baseline.

3. For Example: A footnote or endnote 
number reference is an example of 
superscript. (Footnote') and Subscript 
(H O ).2 2

E. 1. Varsha need to follow given steps here 
below : 
(i)  Open the webpage that she  want to 

save. 
(ii) All browsers have the ability to save a 

webpage, along with all of the media 
on it. You can quickly open this 
window by pressing  Ctrl+S, or by 
doing the following:

vChrome - Click the Chrome 
Menu button (☰) and select 
"Save page as".

v Internet Explorer - Click the 
Gear button, select "File", and 
then "Save as". If you don't see 
the Gear button, press Alt to 
show the menu bar, click "File" 
and then select "Save as".

v Firefox - Click the Firefox Menu 
button (☰) and select "Save 
Page".

(iii)  Give the saved page a name. 
(iv)  Select a location to save the page.

2. To add a  change colour of the page 
Rohit need to perform following steps:
1. Click Design > Page Colour.
2. Pick the color you want under 

Theme Colours or Standard 
Colours.

MODEL TEST PAPER-3
A. 1. (c), 2. (d), 3. (c), 4. (d), 5. (b)
B. 1. CD-Rom, 2. Home Page, 3. Home, 
      4. Crop, 5. Ctrl + Shift +>
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C. 1. True, 2. True, 3. False, 4. False, 5. False
D. 1. When the components of media such 

as text, pictures, sounds, graphics and 
animations are used to present the 
information is called multimedia.

2. Components of multimedia:
1. Text, 2. Images, 3. Audio, 4. Video, 5. 
Animation

3. To make change to new slide in our 
presentation, follow the steps given 
below :
v  Click the View tab and click the 

Slide Master command.
v The Slide Master tab will be 

selected on the ribbon and the 
presentation will switch to Slide 
Master View.

v Scroll up and select the first slide in 
the left navigator pane. This is the 
slide master.

v Make the desired changes to the 
slide master like change theme, 
background etc.

v Move or delete slide objects as 
required.

v Click the Close Master View 
command on the Slide Master tab 
when you completed your work. 
The change will apply to all slides 
of the presentation.

4. Rotating : Make a change in the angle 
of any object is called rotating. We can 
rotate the objects in MS PowerPoint. 
We can rotate objects to change their 
position.

Resizing : Make a change in the size 
of any object is called resizing. We 
can easily resize the objects in MS 
PowerPoint. 

Steps to rotate a picture:
v Click the object that to be rotated.

v Click the rotation handle at the top 
of the object and drag it in the 
direction in which you  want to 
rotate. To increase the rotation 15 
degree. Press and hold Shift key 
while dragging the rotation.

5. The three uses of a presentation are:
   (i) Presentation present views and ideas 

effectively by creating a good visual 
impact on the audience.

  (ii) People associated with business can use 
it to present information about their 
product or company in seminars and 
meeting.

(iii)  Presentation organize the course content 
in the classroom and encourage 
student's learning.

E. 1. Steps for booking Indian Railway 
tickets:

v Login to URL 
https://www.irctc.co.in/mobile with 
your existing IRCTC user ID and 
Password.

v Click on Book Ticket and fill in details 
for plan my travel.

v Select the train and continue the 
booking.

v Use existing passenger list or add 
passengers.

v Confirm booking details and play 
through credit/debit card to get 
successful.

2. Simpi need to perform following steps 
to delete unwanted slide:

v Click the View tab.
v Click on the Normal in the 

presentation view group.
v Click the slide tab on the left pane that 

contains the outline and slide tab. Now, 
right click the slide you want to delete 
then click Delete slide.
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Computer-5

CH-1 EVOLUTION OF COMPUTER

Exercises

A. 1. Compute, 2. Abacus, 3. Tabulating 
machine, 4. UNIVAC I, 5. Personal 
Computer.

B. 1. True, 2. False, 3. True, 4.False, 5. True.

C. 1. (C), 2. (B), 3. (C), 4. (b),  5. (c).

D. 1. Abacus is the first device that allowed 
you to perform calculations. It was 
invented more than 5000 years ago. It 
was made of a wooden frame with 
rods, each having beads. It was used 
in China for counting. It was used to 
do mathematical calculations like 
addition, subtraction, multiplication 
and division.

2. In the course of early IT inventors, 
certain men have breathed life into 
groundbreaking technologies that 
most users now take for granted., 
we’ve compiled a list of inventors who 
have helped shape IT with their 
inventions:
v Charles Babbage, a British mat

              -hematician who originated 
the concept of programmable 
computer is known as the fath

               -er of computers.
v Augusta Ada Lovelace, is known as 

the ‘First Programmer’ who suggest 
Binary Data storage (0 and 1) 
instead of decimal number system.

v George Boole, who linked the 
complex mathematical problems 
with the binary number system and 
represented the positive results by 1 
and the negative ones by 0. This 
theory of Boolean Logic became the 
fundamental principle for the 
design of computer circuitry.

v Dr. Herman Hollerith, invented a 

machine called Tabulating 
machine.

v John von Neumann was the person 
who started the practice of storing 
data and instructions in binary code, 
in memory. He joined hands with 
Presper Eckert and John Mauchly in 
consulting role and EDVAC was built 
using binary code.

v Howard Aiken, was the primary 
engineer in IBM. He developed 
Mark I in 1944.

3. It was the first computer to handle both 
numeric and text data. It was also the 
first computer to come equipped with 
magnetic tape unit and to use buffer 
memory.

4. The evolution of computers can be divided 
into five generations. Each generation 
represents technological evolutions over 
the period of time. Each generation of 
computers resulted in better, cheaper and 
smaller computers that are more 
powerful, faster and efficient than the 
previous generation. The five generation 
of computers with their technological 
advancements are discussed below.
First Generation (1940 - 1956), 

               Second Generation (1956-1963), 
               Third Generation (1964 - 1971), 
                Fourth Generation (1971 - present), 
                Fifth Generation (Future).

5.  Microcomputers
v Microcomputers are also known 

as Personal Computers or PCs.
v These computers are small in size 

and cheaper.
v  They are powerful machines.
v They are mainly used in schools, 

homes, offices,  banks,  shops  and  
hotels.

v Examples are C64, IBM PC.
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Mainframe Computers
v They are big computers with a large 

memory and high speed.
v The are mainly used by big organizations 

like bank and government offices.
v They are very powerful computers but 

are very expensive.
v Examples are PDP–10, IBM 390 and 

System Z10.

E. Ananya should use Supercomputer to 
know weather forecasting.

CH-2 MORE ON WINDOWS 10

Exercises

A. 1. Microsoft Windows, 2. Desktop, 
3. Recycle bin, 4. Application icons, 

       5. Mail

B. 1. True, 2. True, 3. False, 4. True, 5. False

C. 1. (a), 2. (b), 3. (c), 4. (b), 5. (b)

D. 1. Features of Windows 10 are following:-
v It is easy to use.
v It is more interactive and provides 

you the ability to redecorate desktop.
v Backgrounds, colors, themes and 

icons.
v Windows 10 introduces contain, 

which helps to search anything on 
your System or the web directly play 
music, videos, write notes, set alarms 
and reminders performs calculations, 
change wallpapers, send e-mails and 
a lot more, via voice commands.

v The application windows store 
provides a group of updated apps 
such as videos, music, photos, 
movies, maps, mail, messaging, 
calendar, etc.

v Using the Task view button can 
create multiple desktops for 
different set of applications.

v Snap assist is a useful feature that 
help rearrange window to make 
best use of screen space.

vThe Windows Hello feature help 
access computer by showing face, 
finger prints or iris. It provides extra 
security.

2. Five Icons present at desktop are:

1. This PC: It gives a view of available 
drives and their contents stored on 
the Computer System.

2. Application Icons: These are the 
graphical images that give a quick 
access to the related application.

3. Shortcut Icons: Shortcut icons 
contain a direct link to a specific 
application, document, or a folder.

4. Network icons: It enables to access 
the shared files or devices on diffe

              -rent computers.

5. Recycle Bin: The file folder delete 
gets stored in Recycle Bin.

3. The start menu appears when click 
Start button at the lower left corner of 
desktop. Click on the Start button get 
two panels side by side. The left column 
display the pinned, recently added and 
most used apps.

4. Follow the given steps to create a 
group of tiles:
vDrag a tile to the bottom of the right 

pane in the Start menu.
vA transparent horizontal bar will display 

with heading Name group on the left 
side and two small horizontal lines on 
the right.

vClick on Name group and type a name.
vNow, you can add the relevant tiles 

in this group.
5. The given steps to change the colour 

scheme of the computer screen.
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vRight click on the blank area of 
desktop and select the personalize 
option.

vClick the colours option and select 
any color to change the colour 
scheme of Start menu and other 
windows.

vA preview of the selected colour 
scheme will appear in the (preview) 
section.

vTurn on the Automatically pick an 
accent colour from background option.

vTo apply the same colour to these 
components of the desktop. Turn on 
the show colour on Start taskbar, 
action center and title bar option.

vTo apply transparent effect turn on 
the Make Start, taskbar, and action 
center transparent option.

vThe colour scheme will be applied 
to desktop.

E. Ananya requires mail app which enables 
her to manage all her mail accounts at 
one place. It provides notification for 
incoming mails, allow her to read mail. 
and revert back to a sender. To use this 
app she need to sign in with her account.

CH-3 WORKING WITH TABLES 

    IN MS WORD 2016

Exercises

A. 1. Row, 2. Complete table, 3. Table Resize 
handle, 4. Formatting, 5. Merging.

B. 1. True, 2. False, 3. True, 4. False, 5. True.

C. 1.(c), 2.(b), 3.(b), 4.(c), 5.(b).

D. 1. Steps to create a table by using Insert 
tab dialog box:
v Click the Insert tab and then click the 

Table button. 
vChoose the Insert Table option from 

the drop-down menu.

v The Insert Table dialog box will be 
appeared.

v  Set the number of columns and rows 
and click OK.

2. To insert a new column, select the 
column by clicking on its top border, 
adjacent to which you want to insert a 
new column. 
The Table Tools tab appears on the 
ribbon. Click on the Layout tab under 
it. Select as you need either the Insert 
Left or Insert Right button in the Rows 
& Columns group. An empty column 
will be inserted in the table as per the 
chosen option.

3. To split a cell, follow the steps given 
below:
v Select the cell that you want to split.
v Click the Layout tab.
vClick Split Cells button from the 

Merge group.
vThe Split Cells dialog box appears.
vSpecify the number of rows and 

columns, in the respective spin 
boxes, into which you wish to split 
the selected cell. Click OK.

4. To merge cells:
v Select the cells you want to merge. 

Click on the Layout tab.
v Click Merge Cells from the Merge 

group.
v The data gets merged into a single 

cell.
5. You can perform simple calculations 

on the numeric data inserted in a table. 
For doing calculation in table.
v Enter the data in a table.
v Click the Layout tab.
v Click on the cell where you want to 

Keys Computer (1-5) 27



display the result. Select the Formula 
button in the Data group.

vThe Formula dialog box appears.
vNote that the SUM formula is alre

                -ady displayed. Click OK.
v The result will be displayed in the 

selected cell.
6. To insert pictures in a table:
v Click on the cell in the table where 

you want to insert a picture.
vClick on the Insert tab. In the Illus

                  -trations group, select the Pictures  
option.

vThe Insert Picture dialog box will 
appears. Browse and select the pict 
-ure you want to insert.

vClick on the Insert button.
vThe selected picture will be inserted 

in the table cell.

E. Viraj need to perform following steps to 
convert text into table:
vEnter the text.
vSelect the text.
vClick on the Insert tab > Table button 

and from the drop down menu. 
vSelect the Convert Text to Table option.
vThe Convert Text to Table dialog box 

will open.
vSpecify the columns and rows under 

the Number of columns and Number 
of rows respectively.

vClick OK. The selected text will appear 
in the table form.

CH-4 MAIL MERGE

Exercises

A. 1. Data Source, 2. Main document, 
3. Type a new list, 4. Mail Merge Recipient, 
5. Enter

B. 1. True, 2. False, 3. True, 4. False, 5. False

C. 1. (a), 2. (b), 3. (b), 4.(a), 5.(b)

D. 1. Data Source: Data source contains 
name, address, city, PIN, telephone 
number, etc. The data is organized in 
the form of table with the field names.

Recipient List : A recipient list is a 
collection of names and addresses used 
by an individual or an organization to 
send material to multiple recipients.

Main Document : It consists of the 
message that we want to send to all the 
recipients.

2. Following are the basic steps to create a 
mail merge documents:
v Create a main document
v Specify a data source
vMerge the data source with the main 

document.
    3.To create main document follow the  

steps given
v Create a new document in MS Word 

and type a letter or open an existing 
letter in that is to be sent to different 
people at their addresses.
v Click on the Mailings tab click on 

the start Mail Merge Drop down 
arrow and select the step by step 
mail merge wizard option. In the 
start mail merge group.
vThe mail merge task pane will appear 

on the right side of the application 
window.

v Select document type section. Click 
the Letter radio button.

vClick the Next starting document 
under step 1 to 6 section at the bot

                 tom of the task pane.
vChoose the type of set up for letter.
vClick on Use the current document 

radio button.
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vClick on the Next select recipients 
under step 2 of 6 section.

vView the merged data on the screen.
vMailings tab, click on the Preview 

Results button on the Preview 
Results group or click the Next 
Preview.

vThe first record will be appear. To 
view the next record of the data 
source. Click on the Next Record 
button in the preview results group.

       4. To View Merged Data :
   vTo view merged data ,to check 

whether word has picked up the data 
source according to the merged fields 
or not

   vOn the mailings tab Click on the 
preview Results button or click the 
Next :Preview your letters. 

   vTo View  the next  record of  the  data  
source  click  on  the  Next  Record 
button  in  the Preview  Results  groups 

       5. Following are the steps given print out 
the letter:-

v On the Mailings tab click on the 
Finish & Merge button in the finish 
group. Select the print Document 
option from the drop-down menu or 
click on the Next. Complete the 
merge under step 5 or 6 section in 
the task pane and after that click on 
the print option under merge 
section.

vMerge to printer dialog box will 
open and print settings and click 
OK.

v The selected records will get printed 
separately along with the letter.

E. Ansh need to perform following steps to 
view  the merged data to check whether 
Word has picked up the data source 
according to the merged fields or not.

 vFor this, on the Mailings tab click on the 
Preview Results button icon the Preview 
Results group or click the Next. Preview 
your letters (wizard step) under 'Step 4 of 
6' section.

 v

the next record of the data source. Click 
on the Next Record button in the Preview 
Results group.

CH-5 MORE ON POWERPOINT 2016

Exercises

A. 1. colorful, 2. Comment, 3. Smart lookup, 
4. Three, 5. Outline

B. 1. True, 2. False, 3. True, 4. False, 5. True, 
6. True

C. 1. (b), 2. (c), 3. (b), 4. (a), 5. (b)

D. 1. Follow the given steps to create a photo 
album:
vClick on Insert tab, select the New 

photo Album option.
v The Photos Album dialog box will open 

click the File/ Disk tab to pick images 
from computer under the Insert picture 
from selection. The New pictures  dialog  
box will appear.

vChoose the location and select the 
pictures to insert in the album.

vClick on the files the pictures will 
get added under the pictures in 
album box. Pictures display in the 
preview pane and rearrange picture 
by clicking up and down below 
arrows the pictures in album box.

vClick the picture layout and the 
photo frame shape in the Album 
Layout section. When all the files 
have been added click on the create 
button. A new photo album will be 
created.

2. Comments are mostly like sticky notes 
that can be added to an object, text or 
to entire slide. They can also used to 
collaborate and work together on a 
presentation.

The first record will be appear. To view 
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To add comments in a slide the follo- 
wing steps :-
v Navigate the cursor on the 

object/text where the comment is 
to be added.

v Select the Review tab and click the 
New comment button.

v A comment icon appears and the 
comments task pane will opens.

v Write the comment and click out 
side the comment box. Then Close 
the comments task pane.

v Viewing the comment, click on the 
show comments button in the 
comments group on the Review tab.

3. Highlight the text in presentation fol- 
lowing the steps :-
vUnder the pens tab select the 

highlighter tool in the write group.
v Select a highlighter from the different 

options under the pens group.
v Drag pen or stylus over the text highlight 

done, release the mouse.
4. MS PowerPoint provides different views 

to presentation first of the normal view, 
second slide sorter and third slide show 
view.

1. Normal View: It is the main editing 
view. In Normal view you can add 
text, sound, graphics, animation and 
other effects to slides.

2. Slide Sorter View: The Slide Sorter 
View display all slides at the same 
time in miniature form. Slide sorter 
view is useful to change the order of 
slides, insert or delete the slides, add 
transitions and set the timing for the 
slide.

3. Slide Show View: It will show all the 
slides in your presentations one by 
one on the full screen.

5. The slides of a presentation can be 
arranged in Normal, Outline and Slide 
Sorter View.

v In Normal View
For arranging slides in  Normal View:
vOpen the presentation in  Normal View.
v Select the thumbnail of the slide in 

the Slides Navigation pane and drag 
it to the required position.

v In Slide Sorter View
For arranging slides in slide sorter view.
vOpen the presentation in Slide Sorter 

View.
v Select the thumbnail of the slide 

you want to move and drag it to 
the required area.

v In Outline View
       For arranging slides in this view
vOpen the presentation in Outline 

View.
v From the Outline Pane select the 

thumbnail and drag it to the place 
your want. A horizontal line appears 
as you drag the slide.

6. Comments used to give feedback and 
suggestions to others about their 
presentation. They can also be used to 
collaborate and work together on a 
presentation. They are mostly like sticky 
notes that can be added to an object, text, or 
to entire slide. You can turn a comment on 
or off anytime in a slide.

7. Ink annotation enables to annotate 
with Ink, to write notes, highlight a key 
concept, create shapes and much more 
and convert the hand drawn shapes to 
uniform geometric shapes.

E. Rahul need to perform following steps to 
change the background colour:
vClick the Design tab.
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v Select the Format Background 
button, present in the Customize 
group. The Format Background task 
pane will appear.

vChoose any Fill style option from 
the displayed list under the 'Fill' 
section.

vClick on the Colour button. Select 
the More Colours option from the 
list if you want to apply other colour 
than the displayed colour.

v The Colours dialog box will appear.
vClick on the Standard tab and 

choose the colour you want.
v You can also select the custom tab 

and create your own colour scheme. 
Click OK.

CH-6 FORMATTING A PRESENTATION

Exercises

A. 1. Two, 2. Slide title placeholder, 
3. presentation, 4. Table, 5. Smart Art

B. 1. True, 2. True, 3. False, 4. False, 5. True

C. 1. (c), 2.(b), 3.(c), 4. (b), 5. (a)

D. 1. Create a new custom layout following 
these steps:
vClick the view tab select the slide 

master button in the master views 
group.

v Select the Blank Layout slide displayed 
list present in the slide Master task pane.

v Click on the border of the placeholder 
to remove any unwanted or default 
placeholder then press the Delete key.

v Click on the Insert Place-holder drop-
down arrow in the Master Layout 
group to add a place-holder on the 
slide master.

v Right click on the selected Layout 
thumbnail and click the Rename 
Layout option from the context 

menu.
v Rename Layout dialog box will appear. 

In it type a new name. Click on the 
Rename button.

v Click the File tab and click the save 
As option.

v Write File name in the File name box. 
Select the PowerPoint Template and 
click on save option.

vClick on close Master view button.
vThe layout will appear in the list of 

standard built-in layouts Normal 
view present at the Home tab, in the 
slides group.

2. Change the background colour 
following these steps:-
v Select the Format Background 

button present in the customize 
group.

vChoose any fill style option from 
the 'Fill section'.

vClick on the colour button. Select the 
More colours option from the list.

vThe colours dialog box will appear.
vClick on the standard tab and choose 

the colour. Select the custom tab and 
create colour scheme. Click ok.

vTo apply the colour scheme to all the 
slides click on the Apply to Alt  tab. 
Click on the Close button to close the 
Format Background task pane.

3. Smart Art graphics is a graphics tool that 
allows to add text to predefined art design. 
These graphics help to present ideas and 
messages easily and effectively. 
Insert in a slide these steps are:
v Insert Smart Art in a slide select the 

Title and content layout.
vClick the Insert a SmartArt Graphic 

icon present on the slide.
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v Select a category on the left and 
choose the desired layout like on the 
right-side then click OK.

vA blank organization chart will 
appear and see the Design and format 
tabs with layouts and smart Art Styles.

vTo add text a box in the SmartArt 
graphic click inside the box.

v Selecting the change colours drop-down 
arrow in the SmartArt styles group under 
the Design tab of smart Art Tools.

4. A table is a group of cells arranged in 
rows and columns. It is very useful in 
organsing and representing the data in 
an effective manner.
vTo insert a Table:
vClick the Title and content layout 

slide in a presentation.
vClick on the Insert Table icon present 

on the slide.
vSpecify the number of row and 

columns and click OK.
vA new table will be inserted according 

to the specified rows and columns.
vThe  mouse pointer in the first cell 

of the table and type heading press 
the Tab key.

vTab and Arrow keys use insert data 
for other cells in the table or clicking 
in the cell.

5. Change the colour scheme of a slide in 
the following steps:
vClick on the Design tab, go to Themes 

group.
v Click on the theme or Right click on 

the select theme. A context menu 
will appear, select the Apply to all 
slides option.
v Click on More drop-down arrow in 

the variants group and select the 
colours option.

v Select the required colour scheme.
v Right click on the colour scheme and 

select the apply to all slides option.
E. Rahul need to perform following steps to 

change the background colour:
 v Click the Design tab.
vSelect the Format Background button, 

present in the customize group. The 
format Background task pane will 
appear.

v Choose any Fill style option from the 
displayed list under the 'Fill' section.

v Click on the Colour button. Select the 
More colours option from the list if 
you want to apply other colour than 
the displayed colour.

v The Colours dialog box will appear.
v Click on the standard tab and choose 

the colour you want. 
vYou can also select the Custom tab 

and create your own colour scheme. 
Click OK.

CH-7 PROGRAMMING IN SCRATCH

Exercises

A. 1. Answer, 2. Operators, 3. True , 4. Data, 
5. One

B. 1. True, 2. False, 3. True, 4. True. 5. True

C. 1.(b), 2. (a), 3. (c), 4. (b), 5. (c)
D. 1. The sensing block palette in scratch is 

used to sense the keyboard input while 
executing the Script. These block asks 
the user to type input using the key 
board and answer block stores the 
keyboard input as answer. The question 
appears in a voice bubble on the screen. 
The program waits until the user types 
in his response by either pressing the 
Enter
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 key or clicking the check mark.
We need to perform following steps to 
create a small block stack by using the 
Sensing instructions and execute it.
vRemove the Cat 

Sprite from the 
stage by deleting 
it.
v Click on the Choose sprite from library 

button and add the Kai Sprite from the 
people folder. Select the appropriate 
Costume, Kai-b for the Sprite.
v Click the Stage thumbnail on the left 

and select the Choose backdrop 
from library button, Import the 
House 1 background on the stage.

v By dragging and placing the three 
blocks Create the script.

v The                             block allows 
the user to type input by using the 
keyboard.

v Drag and drop          the block on 
the text field of the               block. 
Click on the green flag button.

v The message "How are you?" gets 
displayed on the stage along with a 
text box.

v Enter the answer in the text box. 
Press the Enter key or click on the 
check mark present on the answer 
text box.

v The answer "Fine" will be displayed 
in the voice bubble on the stage for 
the specified number of seconds. 

2. For performing calculations in Scratch 
project follow the given steps:
vDrag the block                   from the 

Events block category under the 
Scripts tab and place it in the Script 
area.

v Pull the                                          and
                              blocks from the Looks 

block and snap them together below 
the                       block.

vClick and drag the            block  
from the Operators block category 
and add it inside the                 block.

vEnter the text and numbers inside 
the block.

vClick on any block to 
run the script and 
not the Sprite calculating the given 
numbers.

vChange the numbers and note the 
Sprite displaying change in the 
result.

3. In the Operators block, palette, there 
are some blocks that compare the 
numbers. In mathematics, you use less 
than (<), greater than (>) and equal to 
(=) sign to compare two numbers. 
Likewise in Scratch, the (less than) 
block states true if the first value is less 
than the second value, the (equal to) 
block states true if the two numbers 
are equal and (greater than) block 
states true if the first value is greater 
than the second value.

4. A condition is applied to a program to 
put a check in any problem. It allows the 
program to select an action, based upon 
the user's input. Scratch provides various 
blocks enabled with conditional 
programming concepts. In Scratch, 'if ', 
or 'if else' are the conditional blocks 
available in the Control block category.

5. Variable is a box in Scratch's memory 
that is used to store a changing value. 
Variables can have only one value at a 
time. These value can be either 
numbers or string.

for           secs2
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For creating a variable following the 
steps:-
vClick on Make a variable block in 

the Data block palette.
vEnter name in the variable name text 

box. Choose a button the variable is 
for all sprites or for this sprite only 
click ok.

vThe Name block will be added under 
the Variables block menu.

vDrag the blocks to create a script 
using the different block palettes.

vTo run the script, click on the green 
flag button.

vType name in the answer box displayed 
and press the Enter key.

vThe sprite will speak the answer in a 
voice bubble and it will be stored 
under the variable name on the top-
left corner of the stage.

E. Simpi have to you block along with other 
blocks to create a bouncing ball all around 
the state. She need to create new Scratch 
project using Beach ball Sprite and the 
blocks.

CH-8 ONENOTE

Exercises

A. 1. Headings, 2. Sign in, 3. Templates, 4. 
Note Pages, 5. Close.

B. 1. True, 2. False, 3. False, 4. False, 5. True.

C. 1.(b), 2.(b), 3.(b), 4.(b), 5.(b)

D. 1. OneNote is an electronic notebook in 
which you can create and store notes 
reminders, ideas  or other pertinent 
information.

Features of OneNote :
vOneNote provides an open canvas 

where users can write or draw in a 
variety of text, images and graphics 
formats.

v It allows users to add, shift and 
delete anything on its interface.

vYou can create additional space when 
ever and wherever you need. 

vYou can also drag your entries into 
separate notebooks or sections for 
optimal organization.

vYou can transfer and customize all 
the data stored in OneNote.

vYou can insert files or documents 
into their submissions or e-mail 
them to friends and family.

vOneNote is also a hub for recording 
audio and video notes, which can be 
played back edited or shared with 
other OneNote users at any time.

2. Following are the steps to add title to a 
page in OneNote:
vFor adding title to the page, click on 

the blank header (over the horizontal 
line), type a title and press the Enter 
key.

vThe title also appeared on the Page 
tab in the right pane.

vYou can also add title by right Clicking 
on the Page tab, select Rename option 
and type a name.

3. OneNote facilitate you with a group of 
pre-designed layouts called Templates. 
These templates make your notebook 
more beautiful and attractive. Follow 
the given steps to apply a template:
vClick the Insert tab and select the Page 

templates option in the Pages group.
vThe Templates task pane will appear 

on the right side of the window.
v Select the required Category. It will 

expand and display many options.
vTo apply template, select its name in 

the list. A new page appears.
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v Click on the Close button to close the 
Templates task pane.

4. To create a quick note, follow the steps 
given below:

vPress Windows key + N on keyboard. 
A small Quick Note window will open 
in your OneNote notebook.

vType your notes in the window. If 
you need, format the text with the 
help of mini toolbar.

vClick the three small dots displayed 
on the top of the Quick Note window 
to view the OneNote ribbon.

vTo view the quick note in full screen 
mode. Click on the Full Page View 
on the View tab.

vYou can also set Quick Note to your 
screen by clicking on the OneNote 
tab and selecting the Always on Top 
option from the Window group.

vQuick Note window will not show 
you the save button. This is because 
a Quick. Note is saved automatically 
under the 'Quick Notes' section 
present at the bottom of the 
Notebook pane.

5. To create a video recording, follow the 
given steps:

v Navigate the cursor where you want 
to insert the recording.

v Click the Insert tab > Record Video 
option in the Recording group. A 
media icon will insert on the page 
and the video recording will start.

E. Ankita need to perform following steps 
to attach a file:

vChoose Insert > File Attachment.

vThis option attaches a file by placing 
the file icon at the cursor position.

vTo open the attached file in a separate 
window. You can double-click on the icon.

CH-9 INTRODUCTION TO

    MICROSOFT EXCEL 2016

Exercises

A. 1. Spreadsheet, 2. Cell, 3. Formula, 4. à ,

 5. numbers.

B. 1. False, 2. True, 3. True, 4. False, 5. True.

C. 1.(c), 2.(c), 3.(c), 4.(a), 5.(a)

D. 1. Microsoft Excel is an spreadsheet software 
developed by Microsoft. It is a part of MS 
Office suite. It enables you to store, organize, 
calculate and manipulate data. It is one of 
the most popular and useful spreadsheet 
software used today. The data in a 
spreadsheet is lies in the form of table.

2. Features of MS Excel:

v MS Excel contains formulas which 
are used for performing simple and 
complex mathematical calculations. 

v Functions are the built-in formulas 
used for calculating percentage, 
average, interest, etc.

v If any change is made in a single cell 
the data is automatically recalculated 
in the entire worksheet.

v Data can be searched quickly and if 
required replaced instantly.

v Auto fill function on allow you to 
quick data entry in a large series of 
cells.

v Data can be seen in a graphical 
form, such as charts, which help 
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to understand, analyze, 
compare data in an effective 
manner.

3. Workbook : The Excel window that opens 
on the screen is called a Workbook. By 
default it has a temporary name as Book1. 
Workbook is just like a notebook, which 
contains a number of pages called 
Worksheets. 

Worksheet: A Worksheet is made up 
of rows and columns, in it, you can 
enter and work with data. By default 
an Excel workbook displays a single 
worksheet, with the name Sheet1. You 
can add any number of worksheets in a 
workbook according to the limits of 
memory available on your computer.

4.  Components of workbook:

Name Box : Name Box is present 
above the Column heading on the left 
side of the window. It displays the 
position of the cell pointer.

Formula Bar : The Formula Bar is 
present to the right of the Name Box. 
This bar shows the characters and 
Formula that you enter in an active cell.

Column Headings : Alphabets on the 
top border of each worksheet are 
known as column headings. These 
headings identify columns with letters 
A to Z, AA.. . .  AZ, BA.. . .BZ, 
....XAA....XFD. Every Worksheet 
contains 16,384 columns.

5. There are three types of data which can be 
entered in a Microsoft Excel worksheet 

1. Text 2. Number 3. Formulae

6. We need to perform following steps to add 
a new worksheet:

v To add a new worksheet, select the 
sheet before which you want to 
insert a new worksheet.

v Right-click on the Sheet tab and select 
the Insert option. The Insert dialog 
box appears with the Worksheet 
option selected. Click OK. You will 
find that a new worksheet gets inserted 
before the selected worksheet. Or

v Click on the New Sheet icon present 
besides to the Sheet tab. A new 
worksheet will be added or select 
the Insert > Insert Sheet option in 
the Cells group on the Home tab.

E. Suppose Tanvi need to enter report card 
marks of her friends. She need to perform 
following steps :

v Select the blank workbook thumbnail 
from the Start Screen and open a new 
workbook.

v Click on the cell D1 and type ‘Report 
Card. Now, select the cell range where 
you want enter to the text.

  v Click on Merge & Center button in 
the Alignment group on the home 
tab. The selected cells will be merged 
and the text will be centered

v Click on the cell A2 and type 'Name'. 
Press the Right arrow key. Type 
'Maths' in B2 and 'Science' in C2. 
Similarly, enter data in the rest of the 
cells.

vClick on the cell A3. Type 'Ananya' and 
press the Enter key. The cell pointer 
moves to cell A4.
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vType 'Viraj' and press Down arrow key 
to move to cell A5 and type 'Tanvi'.

Similarly, enter the remaining data.

CH-10 INTRODUCTION  TO FLASH CS6

Exercises

A. 1. Text, 2. Property, 3. Polystar, 4. Eraser , 
5. Straighten, 6. Stage

B. 1. False, 2. False, 3. True, 4. True, 5. False. 
6.False

C. 1.(a), 2.(b), 3.(c), 4.(a), 5.(a).

D. 1. Follow given steps to transform an 
object:

v Select the PolyStar Tool from the 
Tools panel and draw a star on the 
stage.

vChoose the Pen Tool and click on the 
star outline. It will display the various 
anchor points by which this shape 
has been formed.

vClick on the drop-down arrow present 
at the lower right corner of the Pen Tool 
and select the Add Anchor Point Tool 
from the displayed list.

vA Plus sign (+) appears next to the 
Pen Tool. Click at the place point 
where you want to add an anchor 
point.

2. Flash is a software package that allows 
users to create animated works. It is used 
for creating animations, games, cartoons, 
text, graphics and other special effects. It 
also helps to design ‘Movies’ on the web. 
The animations and graphics created in 
Flash can be scaled to any size  without 
compromising with clarity or quality. 
Flash originated with the application of 
Smart Sketch, developed by Jonathan Gay.

3. Lasso  tool has 3 options. Magic wand, 
magic wand setting, polygon mode.

4. Paint Bucket : This tool is used to fill 
enclosed areas of an object with colours 
in a single click. It provides modifiers 
that allows you to close gaps in shape 
outlines. You can also use the Paint 
Bucket Tool to fill the areas that are not 
completely closed and change the 
colour of already painted areas.

Ink bottle : It is used to change the 
stroke colour, width and style of lines 
of shape outlines.

5. Components of Flash workspace :

Title Bar: The Title bar displays the 
name of the open document.

Menu Bar: The Menu bar contains 
control for common functions and 
commands, such as opening, editing, 
and saving files etc.

The Stage: This is the white rectangular 
workspace area where we place our 
contents and create our drawings or 
movies. By default, the stage size in flash 
is 550 x 400 pixels.

The Tools Panel: It contains a set of 
tools to create and modify objects and 
graphics in the workspace.

The Properties Panel: It displays 
various properties of the selected object 
(text, symbol, image, or shape). It is 
generally used for changing the settings, 
like stage size, ruler unit, background 
colour of the stage, and frame rate. It is 
also named as Property inspector.
If the Properties panel is not visible, 
then we can select the Window > 
Properties option or press Ctrl + F3 
shortcut key.
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Timeline: It organizes and controls a 
document content in layers and frames. 
It is the area where one controls the 
sequencing and timings of graphics 
and other elements of a movie.

E. Animations in Flash are created with the 
help of frames. Frames in Flash are appear 
on the Timeline. It can be defined as the 
little rectangular cells, Frames are used to 
control and organize the content of your 
movie. We can manage the appearance of 
movie or objects by the help of these 
frames. Keyframes are special types of 
frames where we can define change in the 
objects for an animation, like position, 
colour, shape etc. In frame by frame 
animation we can create the image in 
every frame.

CH-11 INTERNET AND E-MAIL

Exercises

A. 1. Internet, 2. Video conferencing, 

    3. Internal Modem, 4. ISP, 5. Chatting. 

B. 1. True, 2. False, 3. True, 4. False, 5. True, 
6. True.

C. 1.(a), 2.(a), 3.(c), 4.(b), 5.(b), 6.(c).

D. 1. Internet is the most popular and useful 
technology today. It stands for 
'International Network'. It is the biggest 
network of computers. A number of 
small networks of computers are 
connected to each other to make a global 
network of computers which contains a 
million of computers in it. This global 
network is called Internet.

Uses of Internet : Mailing Letters, Online 
Shopping, News and Information, Art 
and Entertainment, Tourism and Travel, 

Chatting, Banking Operations, Video 
Conferencing.

2. Services of Internet :

E-mail: The most popular feature of the 
Internet is electronic mail. It enables you 
to send and receive message in real time. 
You can also attach pictures, videos, and 
sounds to an email.
Online Shopping : With the help of 
internet you can purchase various 
items, like books, electronic goods, 
clothes, etc., from different e-shops 
around the world without actually 
going there. This way of shopping is 
called online shopping.
Video Conferencing : Conducting a 
live conference between two or more 
participants at different locations 
us ing computer  networks  by 
transmitting audio and video data is 
called video conferencing.

3. A Search Engine is a software that allow 
you to search various web pages on the 
World Wide Web for a particular 
information. It needs a user to enter 
information to be searched with the 
help of a key word and displays the 
search results as a list of links to the 
pages on which the keywords are found. 
Examples of search engine are:

GOOGLE: http://www.google.com

BING: http://www.bing.com

YAHOO: http://www.yahoo.com

4. For using the e-mail facility on the 
Internet, first of all you have to create 
your personal e-mail account you have 
to select a username (e-mail address) 
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and provide a secret code (password) 
along with particulars, like Name, 
Address, Date of Birth, etc.

5. To attach a file to an e-mail, follow 
these steps:

v Click on the Attach a file icon on 
the toolbar at the bottom of the 
Compose window.

v The Open dialog box will appear.

v Select the file you want to attach.

v Click on the Open button. The file 
gets attached to your mail. Now, 
click on the Send button.

6. We required Modem, Telephone Line, 
Internet connection to connect our 
computer to the internet.

E. If Tanvi have computer with internet connection 
then she can read many newspapers, online and 
get the information regarding various topics of 
your interest. 

Model Test paper-1

A. 1. (c), 2. (b), 3.(b), 4. (c), 5.(b)

B. 1. Compute, 2. Abacus, 3. ENIAC 4. 
Application Icons, 5. Formatting.

C. 1. True, 2. False, 3. True, 4. False, 5. True

D. 1. Abacus is the first device that allowed you 
to perform calculations. It was invented 
more than 5000 years ago. It was made of a 
wooden frame with rods, each having 
beads. It was used in China for counting. It 
was used to do mathematical calculations 
like addition, subtraction, multiplication 
and division.

2. In the course of early IT inventors, certain 
men have breathed life into groundbreaking 
technologies that most users now take for 
granted., we’ve compiled a list of inventors 

who have helped shape IT with their 
inventions:
vCharles Babbage, a British mathematician 

who originated the concept of 
programmable computer is known as the 
father of computers.
v Augusta Ada Lovelace, is known as 

the ‘First Programmar’ who 
suggested  Binary Data storage (0 
and 1) instead of decimal number 
system.

v George Boole, who linked the complex 
mathematical problems with the 
binary  number  system  and  
represented the positive results by 1 
and the negative ones by 0. This 
theory of Boolean Logic became the 
fundamental principle for the design 
of computer circuitry.

v Dr. Herman Hollerith, invented a 
machine called Tabulating machine.

v John von Neumann was the person 
who started the practice of storing 
data and instructions in binary 
code, in memory. He joined hands 
with Presper Eckert and John 
Mauchly in consulting role and 
EDVAC was built using binary code.

v Howard Aiken, was the primary 
engineer in IBM. He developed 
Mark I in 1944.

3. Features of Windows 10 are following:-

v It is easy to use.
v It is more interactive and provides 

you the ability to redecorate desktop.

vBackgrounds, colours, themes and 
icons.

vWindow 10 introduces contain, which 
helps to search anything or the web 
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directly play music, videos, write notes, set 
alarms and reminder performs calculation, 
change wallpapers send e-mails and a lot 
more, via voice commands.

vThe application windows store provides 
a group of updated apps such as videos, 
music, photos, movies, maps, mail, 
messaging, calendar etc.

vUsing the task view button can 
create multiple desktops for different 
set of applications.

v Snap assist is a useful feature that 
help rearrange window to make 
best use of screen space.

vThe Windows Hello feature help access 
computer by showing face, finger 
prints , or iris. It provides extra security.

4. Five Icons present at desktop are :

1. This PC: It gives a view of available 
drives and their contents store on 
the Computer System.

2. Application Icons: These are the 
graphical images that give a quick 
access to the related application.

3. Shortcut Icons: Shortcut icons 
contain a direct link to a specific 
application, document, or a folder.

4. Network icons: It enables to access 
the shared files or devices on diffe

                -rent computers.

5. Recycle Bin: The file folder delete 
gets stored in Recycle Bin.

5. To split a cell, follow the steps given 
below:

v Select the cell that you want to split.

v Click the Layout tab.

vClick Split Cells button from the 

Merge group.

vThe Split Cells dialog box appears.

vSpecify the number of rows and 
columns, in the respective spin 
boxes, into which you wish to split 
the selected cell. Click OK.

E. 1. Supercomputer: A supercomputer is a 
computer with great speed and memory. 
This kind of computer can do jobs faster 
than any other computer of its generation. 
They are usually thousands of times faster 
than ordinary personal computers made 
at that time. Supercomputers can do 
arithmetic jobs very fast, so they are used 
for weather forecasting, code-breaking, 
genetic analysis and other jobs that need 
many calculations. 

2. Live Titles: Live tiles display latest updates 
and information such as views, Weather 
report, incoming mails, etc. Without 
opening the app. You can resize, rearrange 
and move these titles according to your 
requirement.

3. Table : A table is an arrangement of 
information in rows and columns 
containing cells that make comparing 
and contrasting information easier. As 
you can see in the following example, 
the data are much easier to read than 
they would be in a list containing that 
same data.

4. Data Source : Data source contains 
name, address, city, PIN, telephone 
number, etc. The data is organized in 
the form of table with the field names. 
The data source is attached with the 
main document, so that its field names 
can be used in the main document and 
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it becomes easy to merge addresses 
with the main document.

5. Smart Lookup : Smart Lookup is a nifty 
new feature in Office 2016 software 
suite. The feature automatically finds 
information on the Web using 
Microsoft's Bing search engine without 
forcing users to open up an Internet 
browser and run a search manually.

Model Test Paper-2

A. 1. (b), 2. (b), 3. (a), 4. (b), 5.(a)

B. 1. Data Source, 2. Main document,

        3.Three,  4. Slide title placeholder,

       5. Presentation

C. 1. False, 2. True, 3. False, 4. False, 5. False.

D. 1. Data Source: Data source contains 
name, address, city, PIN,  telephone 
number, etc. The data is organized in the 
form of table with the field names.

Recipient List : A recipient list is a 
collection of name and addresses used by 
an individual or an organization to send 
material to multiple recipients.

Main Document : It consists of the 
message that we want to send to all the 
recipients.

2. Following are the basic steps to create a 
mail merge documents:

v Create a main document.

v Specify a data source.

vMerge the data source with the 
main document.

3. Ink annotation enables to annotate 
with Ink to write notes, highlight a key 
concept, create shapes and much more 
and convert the hand drawn shapes to 

uniform genetic shape.

4. Create a new custom layout following 
these steps:

vClick the view tab select the slide master 
button in the master views group.

v Select the Blank Layout slide from the 
displayed list present in the slides 
Master task pane.

v Click on the border of the placeholder 
to remove any unwanted or default 
place holder  then press the Delete key.

v Click on the Insert Place holder drop-
down arrow in the Master Layout 
group add a place holder on the slide 
master.

v Right Click on the selected Layout 
thumbnail and click the Rename 
Layout option from the context 
menu.

v Rename Layout dialog box will 
appear. In it type a new name. Click 
on the Rename button.

v Click the File tab and click the save 
As option.

v Write File name in the File name 
box. Select the PowerPoint 
Template and click on save option.

vClick on close Master view button.

vThe layout will appear in the list of 
standard built-in layouts Normal 
view present at the Home tab, in the 
slides group.

2. Change the background colour 
following these steps :-

v Select the Format Background button 
present in the customize group.
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vChoose any fill style option from 
the 'Fill section'.

vClick on the color button. Select the 
More color option from the list.

vThe colors dialog box will appear.

vClick on the standard tab and choose 
the colour. Select the custom tab and 
create colour scheme click ok.

vTo apply the colour scheme to all 
the slides click on the Apply to Alt + 
tab. Click on the close button to 
close the Format Background task 
pane.

E. 1. SmartArt is a graphics tool that allows you 
to add text to predefined art designs. 
These graphics help you to present your 
ideas and messages easily and effectively. 
It contains many graphical layouts, like 
Pyraminds, Hierchy, List, Matrix etc. to 
display data in a presentation.

2. Random Variable : Variables in Scratch 
consist of a series of symbols to represent 
a value; mathematically they are symbols 
that represent numbers. A simple way to 
think about variables is a box with 
numbers in it. These numbers can be 
increased and decreased and made to 
control various parts of a project. 

3. Template : a group of pre-designed layouts 
called Templates. These templates make 
your presentation or project more beautiful 
and attractive. They are organized different 
groups, i.e. Academic, Blank, Business, 
Decorative, and Planners. 

4. Text Data : Text data includes 
alphabets, numbers, spaces and special 

characters. If you entered text data, it is 
displayed in the cell as well as in 
Formula bar. By default text data is left 
aligned in a cell. Most often, text entries 
are used for worksheet headings, names, 
and for identifying columns of data.

5. Video Conferencing : Conducting a live 
conference between two or more 
participants at different locations using 
computer networks by transmitting audio 
and video data is called video conferencing.

Model Test Paper-3

A. 1.(b), 2.(c), 3.(a), 4.(a), 5.(b)

B. 1. Headings, 2. Numbers, 3. ISP, 4. 
Internet 5. Close

C. 1. False, 2. True, 3. True, 4. False, 5. True

D. 1. Services of Internet :

E-mail: The most popular feature of 
the Internet is electronic mail. It 
enables you to send and receive 
message in real time. You can also 
attach pictures, videos, and sounds to 
an email.

Online Shopping : With the help of 
internet you can purchase various 
items, like books, electronic goods, 
clothes, etc., from different e-shops 
around the world without actually 
going there. This way of shopping is 
called online shopping.

Video Conferencing : Conducting a live 
conference between two or more 
participants at different locations using 
computer networks by transmitting audio 
and video data is called video conferencing.
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2. Workbook: The Excel window that opens on 
the screen is called a Workbook. By default it 
has a temporary name as Book1. Workbook 
is just like a notebook, which contains a 
number of pages called Worksheets. 

Worksheet: A Worksheet is made up 
of rows and columns, in it, you can 
enter and work with data. By default 
an Excel workbook displays a single 
worksheet, with the name Sheet1. You 
can add any number of worksheets in a 
workbook according to the limits of 
memory available on your computer.

3. Following are the steps to add title to a 
page in OneNote:

vFor adding title to the page, click on 
the blank header (over the horizontal 
line), type a title and press the Enter 
key.

vThe title also appeared on the Page 
tab in the right pane.

vYou can also add title by right Clicking 
on the Page tab, select Rename option 
and type a name.

4. For using the e-mail facility on the 
Internet, first of all you have to create 
your personal e-mail account you 
have to select a username (e-mail 
address) and provide a secret code 
(password) along with particulars, 
like Name, Address, Date of Birth, etc.

5. 1. Internet is the most popular and 
useful technology today. It stands for 
'International Network'. It is the biggest 
network of computers. A number of 
small networks of computers are 
connected to each other to make a 
global network of computers which 

contains a million of computers in it. 
This global network is called Internet.

Uses of Internet : Mailing Letters, Online 
Shopping, News and Information, Art and 
Entertainment, Tourism and Travel, 
Chatting, Banking Operations, Video 
Conferencing.

E. 1. Worksheet: An Excel worksheet is a 
single spreadsheet that contains cells 
organized by rows and columns. A 
worksheet begins with row number one 
and column A. Each cell can contain a 
number, text or formula. A cell can also 
reference another cell in the same 
worksheet, the same workbook or a 
different workbook.

2. Internet: The internet is a globally 
connected network system that uses 
TCP/IP to transmit data via various 
types of media. The internet is a 
network of global exchanges – including 
private, public, business, academic and 
government networks – connected by 
guided, wireless and fiber-optic 
technologies. The terms internet and 
world wide web are often used 
interchangeably, but they are not exactly the 
same thing; the internet refers to the global 
communication system, including 
hardware and infrastructure, while the web 
is one of the services communicated over 
the internet.

3. Quick Note: OneNote allows you to 
create Quick Notes with or without 
opening the OneNote app. Quick note 
can be considered as the electronic 
equivalent of a little yellow sticky note.
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4. Short for modulator-demodulator. A 
modem is a device or program that enables 
a computer to transmit data over, for 
example, telephone or cable lines. 
Computer information is stored digitally, 
whereas information transmitted over 
telephone lines is transmitted in the form 
of analog waves.

5. Smartart : SmartArt is a graphics tool that 
allows you to add text to predefined art 
designs. These graphics help you to present 
your ideas and messages easily and 
effectively. It contains many graphical 
layouts, like Pyraminds, Hierchy, List, 
Matrix etc. to display data in a presentation.
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CH-1 COMPUTER LANGUAGE
Exercises
A. 1. Program, 2. Four, 3. Machine, 

4. Ada Lovelace, 5. High level, 
6. Assembly, 7. Syntax, 8. Off, on.

B. 1. True, 2. True, 3. True, 4. False,  5. False,
 6.  False, 7. True, 8. False.
C. 1. (b), 2. (c),  3. (c),  4. (b).
D. 1. A computer language includes various 

languages that are used to communicate 
with a computer machine. Some of the 
languages like programming language 
which is a set of codes or instructions 
used for communicating the machine. 
Machine code is also considered as a 
computer language that can be used for 
programming.

2. All the languages that are now available 
can be classified into the following 

         categories: Machine language, Assembly 
language, High-level language and 
Fourth generation language.
Assembly Language  : Assembly 
Language is the second generation 
programming language that has 
almost similar structure and set of 
commands as machine language. 
Instead of using numbers in Machine 
Language  here we use words or 
names in English forms and also 
symbols. The programs that have 
been written using words, names and 
symbols in assembly language are 
converted to machine language using 
a Assemble. Because a computer only 
understands machine code languages 
that's why we need a Assembler that 
can convert the Assembly language to 

Machine language. So, that the 
computer gets the instruction and 
responds quickly.

3. The high level languages are the most 
used and also more considered 
programming languages that helps a 
programmer to read, write and 
maintain. It is also the third generation 
language that is used and also running 
till now by many programmers. They 
are less independent to a particular 
type of computer and also require a 
translator that can convert the high 
level language to machine language. 
The translator may be an interpreter 
and compiler that helps to convert into 
binary code for a computer to 
understand. There is various high level 
programming languages like C, 
FORTRAN or Pascal that are less 
independent and also enables the 
programmer to write a program.

4. Interpreter : High Level Language 
programs need to be translated into 
machine language by using the 
translator programs. This translator 
program is used to convert a high level 
language program into machine 
language. An interpreter translates line 
by line, executes the instruction and 
then repeats the procedure for the 
remaining instructions. If any errors 
are found, they are to be removed 
immediately. As the converted form is 
not stored anywhere, so it has to be 
generated at the time of execution of a 
program. Interpreter programs are 
preferred for beginners and are slow in 
execution speed.
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Compiler : It plays an important role 
on the computer as it can convert to 
machine language and also checks for 
errors if any before executing. There 
are several high level languages that 
were used earlier and also now like 
COBOL, FORTRAN, BASIC, C, C++, 
PASCAL, LISP, Ada, Algol, Prolog and 
Java. It is user friendly as the programs 
are written in English using words, 
symbols, characters, numbers that 
need to be converted to machine code 
for processing.

5. Fourth generation languages are 
combination of languages with the 
following features:
v Highly user-friendly and independent 

of any operating system.
v Very high speed of execution. Designed 

to reduce the level of programming 
efforts.

v Designed to reduce the overall time 
it takes to develop software and the 
cost of software development. In 
4GL, the user has to specify only the 
required output they want, while the 
computer determines the sequence 
of instructions that will accomplish 
those results.

E. 1. Mohit's uncle used high level language.
2. Java is an object oriented language. Its 

syntax is common as C and C++. Java 
programs are compiled to byte code.

CH-2  MORE ON WINDOWS 10
Exercises
A. 1. Organize, 2. Copying, 3. Fonts, 

4. Disk Cleanup, 5. Continuum.
B. 1. True, 2. True, 3. False, 4. False, 5. True.
C. 1. (a), 2. (b), 3. (b).
D. 1. Windows Media Player is a media 

player and media library applicator 
developed by Microsoft that is used for 
playing audio, video and viewing 

images on personal computer running 
the Microsoft Windows Operating 
System, as well as on pocket PC and 
windows Mobile based devices.

2. Ripping : We can copy songs from our 
favorite music CDs/DVDs onto our 
computers with Windows Media 
Player. When we rip music, we are 
actually copying songs from a CD to 
computer. After the songs have been 
copied to our computer, we can use 
Windows Media Player to play and 
organize the songs, create play lists, 
and copy music to a portable device.
Burning : When you create a CD or 
DVD, you must tell your PC running 
Windows 10 what you are copying and 
where you interned to play it: Music 
for CD player? Photo Slide shows for 
TV's DVD player? or files to share on 
your computer?

3. Microsoft Windows Hello is a 
biometric identify and access control 
feature that supports fingerprint 
scanners, iris scanners and facial 
recognition technology. Biometric 
logins are secure, fast, and easy to 
create. Windows Hello requires 
appropriate hardware devices to be 
connected to the system for its 
proper working.

4. To create a new desktop, follow the 
steps given below:
v Click on the button situated on the 

taskbar. The Task View Task View 
Pane opens and displays the preview 
of all the open windows.

v Click on the New desktop button 
located at the bottom-right corner of 
the Task View Pane. A new desktop 
thumbnail named 'Desktop 2' 
appears.

v Click on the thumbnail to view the 
newly created desktop. It is a replica 
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of Desktop 1 but doesn't display the 
applications opened in Desktop 1. 
You can open the apps that you want 
to use on this desktop. You can group 
the desktop windows by opening 
similar kind of apps in one desktop.

vClick on the Task View button again 
to switch between desktops.

5. Disk cleanup is a Microsoft Software 
utility first introduced with Windows 
98 and included in all subsequent 
releases of windows. It enables us to 
remove files that are no longer needed 
or that can be safely deleted. Removing 
unnecessary files, including temporary 
files, can help to speed up and improve 
the performance of the computer.

E. 1. Rohit  need to perform Burn Files to a 
Disc option to burn his favorite songs 
to a CD.

2. 'Windows Hello' feature of 
Windows10 can help Deepak to make 
his system secure through biometric 
login. Because Microsoft Windows 
Hello is a biometric identify and 
access control feature that supports 
fingerprint scanners, iris scanners and 
facial recognition technology. 
Biometric logins are secure, fast, and 
easy to create. 

CH-3  FLOWCHARTS AND PROGRAMS
Exercises
A. 1. Diagram, 2. Start/Stop, 3. Processing, 

4. Fortran, 5. Java.
B. 1. (a), 2. (a), 3. (b), 4. (b), 5. (c).
C. 1. (a), 2. (a), 3. (a), 4. (c)
D. 1. A flowchart is a type of diagram that 

represents an algorithm, workflow or 
process, showing the steps as boxes of 
various kinds and their order by 
connecting them with arrows. This 
diagrammatic representation 
illustrates a solution model to a given 
problem. Flowcharts are used in 

analyzing, designing, documenting or 
managing a process or program in 
various fields.

2. A flowchart imparts all information 
visually by using standard symbols to 
represent these different functions. It 
uses arrows to represent the sequence 
in which the instructions should be 
performed.

3. Start/Stop Symbol: This symbol is 
used to show where your flow begins or 
ends.

Input/Output Symbol: This symbol is 
used to indicate the acceptance of 
inputs from a user or the output or the 
result concluded.

Flow Lines: The flowchart symbols are 
connected with the help of flow lines.

Processing Symbol: The symbol is 
used to illustrate a process, action or an 
operation. 

Decision Box: The symbol is used in a 
process flow to as a question. And the 
answer to the question determines the 
arrows coming out of the symbol.

Connector: In flowcharts, this symbol 
is typically small and is used as a 
connector to show a jump from one 
point in the process flow to another.

4. Advantages of flowcharts :
v Communication: Flowcharts are better 

way of communicating the logic of a 
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system to all  concerned or involved.
vEffective Analysis: With the help of 

flowchart, problem can be analysed 
in more effective way therefore 
reducing cost and wastage of time.

vProper Documentation: Program 
flowcharts save as a good program 
documentation, which is needed for 
various purposes, making things 
more efficient.

Disadvantages of Flowcharts:
vComplex logic: Sometimes, the 

program logic is quick complicated. In 
that case flowchart becomes complex 
and clumsy. This will become a pain for 
the user, resulting in a waste of time.

vAlterations and Modifications: If 
alternations are required the 
flowchart may require re-drawing 
completely. This will usually waste 
valuable time.

vReproduction: As the flowchart 
symbols cannot be typed, reproduction 
of  flowchart  becomes  a  problem.

5. a. This flowchart depict the conversion 
of Celsius to Fahrenheit.

b. 2°C = 35.6°F,  10°C = 50°F
6.

D. 1—(b), 2—(a), 3—(b).
E. 1. No I will not write it directly. Because 

a program can be viewed as an 
elaborate algorithm. In mathematics 
and computer science, an algorithm 
usually means a small procedure that 
solves repetitive problem. So I use 
flow chart to write a program.

2. Yes, we can solve many problems of our 
daily by using algorithm and flowchart. 
We can put available resources in 
planned way with the help of flowchart 
and get maximum results which help 
us to reduce the upcoming problems.

My Activity 

CH-4 MORE ON MS POWERPOINT 2016
Exercise
A. 1. Transitions, 2. Text, objects, 

3. Microphone, 4. From Beginning, 
5. Loop until Stopped.

B. 1. True, 2. True, 3.False, 4. True, 
5. False, 6. True.

C. 1. (b),  2. (b),  3. (c),  4. (a).
D. 1. Moving objects, such as text, graphics, 

charts, logos, etc. that are made up of a 
sequence of images displayed after this 
other on the slide are called Animations.
Animation is quite helpful when you 
want to focus on important points. It 
also controls the sequence of the flow 
of information and helps in making 
information more extraordinary. 
Apart from giving visual effects to your 
presentation, you can also sizzle up 
your slide objects – the text, pictures, 

Start

Read A, B, C

S = A + B + C 
A = S/3 
P = A * B * C

Print S, A, P

Stope

Q B A S I C F B
E A L G R G B A
D F O R T R A N
A E G H I T S S
P D O C Q R I J
O W C B V U C X
J A V A C F A Z
A N M L K Y C ++
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shapes, tables, SmartArt graphics, etc. 
by applying sound effects.

2. Transitions are motion effects that 
when in Slide Show view add 
movement to your slides as you 
advance from one slide to another. 
There are many transitions to choose 
from, each one of which allows you to 
control the speed and even add sound.

3. You have perform following steps to 
insert your own sound in a presentation:
vClick the Record button and start 

reading your script.
vClick the Stop button when you want 

to pause recording: click the Record 
button to resume recording.

vYou can click the Play button at any 
time to play back what you have 
recorded so far. Notice that the 
dialog box notes how many seconds 
your recording lasts.

vClick the OK button in the Record 
Sound dialog box when you have 
finished recording the narration for 
you slide.

vThe Audio icon appears on your 
slide to show that your slide is 
accompanied by an audio file.

4. To insert pictures and Clipart in 
presentation:
vOpen the PowerPoint presentation 

you will add the clip art to.
vClick the “Insert” tab and select Clip 

Art from the Images group. A Clip 
Art pane will appear.

vEnter the keyword of the clipart you 
will insert in the Search For field.

vChoose the collection you will search 
for the clip art in the Search In drop-
down menu. 

vOpen the Results Should Be drop-
down menu. Select the clipart you 
will insert. Clipart 

v Click the image in the Clip Art pane 
to insert it in the slide.

5. To import data from word file follow 
the steps given below:
vClick on the View tab and select the 

Slide Sorter button.
v Now click on the New Slide drop-

down menu on the Home tab. Select 
the Slides from Outline option.

vThe Insert Outline dialog box will 
appear. Browse the location of the 
Word file.

vSelect the file and click on the Open 
button.

E. 1. Mohit need to use Transition Effects to 
link every slide to its succeeding slide.

2. See  Q. D.5.
CH-5 MICROSOFT EXCEL 2016
Exercise
A. 1. F4, 2. Ctrl+C, 3. Format, 4. Ctrl+F9, 

5. Enter, Cancel, 6. 15 and 8.43, 
7. End, 

B. 1. True, 2. False, 3. False, 4. True, 
5. False, 6. False, 7. False.

C. 1. (c), 2. (b), 3. (c), 4. (a), 5. (a), 6. (b),
7. (a).

D. 1. Using Edit Mode
vSelect the cell D6. Double-click on 

the cell.
vThe insertion point will blink within 

the cell.
vNote that the Edit mode is 

displayed on the left side of the 
pointer at the desired place and 
modify the contents.

vPress the Enter key. The changes will 
be entered in the current.

vObserve, the Edit mode indicator 
modifies to Ready mode.

2. Inserting a Column/Row
vSelect the column or cell to the left of 

which a new column is to be inserted. 
Here, we have selected column 'E'.

vClick on the drop-down arrow of the 
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Insert button in the Cells group on 
the Home tab and select the Insert 
Sheet Columns option. Excel inserts 
a blank column to the left of column 
'E' and shifts the entries of column 'E' 
to column 'F'.

vSimilarly you can insert a row as you 
insert a column. Select the row or a 
cell above which a new row is to be 
inserted and choose insert sheet 
Rows from the options of Insert 
drop-down menu.

3. v After making changes in a cell, you 
may want to cancel the changes and 
retrieve the earlier data. To undo the 
last action (s) done, use the Undo 
button on the Quick Access Toolbar.

vThe Redo command is used to 
quickly repeat the last action (s) that 
you have undone using Undo 
command. To do so, click on the 
Redo button on the Quick Access 
Toolbar.

4. Copying and Pasting Data
vSelect the cell or a range of cells you 

require to copy. Let us say B4:D4.
vClick on the Copy button in the 

Clipboard group. The dashed line 
will display around the selected cells.

vSelect the destination cell, let us say 
F6 and click on the Paste button in 
the Clipboard group. The text will be 
copied to the new location.

vIf you want to paste the same data 
many times, you require to click on 
the Paste button in different cells.

5. Do the following steps using Drag and 
Drop method:
vSelect a cell or a range of cells. Place 

the mouse pointer at the edge of the 
selected cells.

vObserve that the pointer turns from 
a white cross symbol to a move 
pointer symbol +.

vDrag the selected cell or a range of 
cells to a new destination and release 
the mouse button. The data will be 
moved to a new location.

6. Data can be moved by using following 
steps :
vRight-click on the cell to open
vShortcut menu and choose the Cut 

command. 
vNow, select the destination cell, right-

click on it and select Paste option.
7. Flash Fill is a time-saving feature of MS 

Excel, which recognises the data fill 
pattern that you use repeatedly in a 
worksheet and then fills the unfinished 
series accordingly.
Let us try it practically.
vMake two columns, NAMES and 

INITIALS, in the Excel sheet.
vFill the data in NAMES column as 

shown in the figure.
vThe INITIALS column should have 

data that is a combination of the first 
letters of first name and the Last 
name, Like RK for Ravi Kumar.

vType RK in the INITIALS column 
and press Enter key.

vClick on the Fill drop-down arrow 
located on the Home tab in the 
Editing group and select the Flash Fill 
option. You  can  also  use  the  shortcut  
key  Ctrl + E.

vThe initials of the remaining entries 
will be automatically added to the 
cells of the INITIALS column.

8. To modify the row Height
vSelect the row.
vIn the cells group on the Home tab. 

Click on the drop-down of arrow the 
Format button.

vClick on the Row Height option.
vThe Row Height dialog box displays. 

Enter the required value and click 
OK.
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vThe change will be shown on the 
selected row.

To modify the Column Width
vSelect the column.
vClick on the drop-down arrow of the 

Format button on the Home tab. 
From the displayed list of options, 
click on Column Width.

vThe Column Width dialog box 
displays. Enter the required value 
and click OK.
Notice the change on the selected 
column.

9. The Auto Fill is the easiest way to fill 
data automatically in the worksheet 
cells. Do the following steps to fill data 
automatically in the worksheet cells.
vType 'January' in cell B1.
vPlace the pointer at the lower right 

corner of the cell.
vThe mouse pointer turns into a black 

"+" cross symbol.
vHold down the left mouse button 

and drag the fill handle up to cell B5. 
Release the button.

vThe months February to May would 
display in the cells B2 to B5.

E. 1. Manish need to perform following 
steps to insert a new column:
vSelect the column or cell to the left of 

which a new column is to be inserted. 
Here, we have selected column 'E'.

vClick on the drop-down arrow of the 
Insert button in the Cells group on 
the Home tab and select the Insert 
Sheet Columns option. Excel inserts 
a blank column to the left of column 
'E' and shifts the entries of column 'E' 
to column 'F'.

2. Manjit can use Auto Fill to finish his 
assignments quickly. He need to 
perform following steps:
vType 1' in cell B1 and Type 2 in B2.
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vSelect both rows and place the 
pointer at the lower right corner of 
the cell.

vThe mouse pointer turns into a black 
"+" symbol.

vHold down the left mouse button and 
drag the fill handle up to cell B100. 
Release the button.

vThe counting 1 to 100 would display 
in the cells B1 to B100.

3.  A . D4 = B4 + C4
D6 = B6 + C6
D9 = D4 + D5 + D6 + D7 + D8

B. B2
C. C8
D. Enter. 

CH-6 FORMULAS AND FUNCTIONS
Exercises
A. 1. calculation, 2. Equal to (=), 

3. Cell reference, 4. Absolute reference, 
5. Concentration, 6. Arguments, 
7. Parenthesis, 8. &.

B. 1. True, 2. True, 3. True, 4. True, 5. True, 
6. True, 7. True, 8. True.

C. 1. (a), 2. (c), 3. (c), 4. (a), 5. (b), 6. (a).
D. 1. Formulas are the user defined 

instructions to perform arithmetical 
calculations, whereas, Functions are 
the pre-defined on in built formulas 
that come with Excel. 
A formula forms a relationship 
between two or more cells. It is an 
expression that can incorporate cell 
addresses, numbers arithmetic 
operators, and parenthesis. You can 
perform simple as well as complex 
calculations using formulas.
Let us use it to calculate the sum of the 
numbers in B4, B5, and display the 
result in B11.
Follow the steps given below to use a 
formula:
vClick on the cell B11 (where you 
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want to show the result) and type = 
sign.

vClick on the cell B4. A dashed border 
called marquee will display around 
it. Its address will display in the B11 
and in the Formula bar. This process 
of clicking on the cell to add its 
reference to a formula is known as 
Pointing. The Status bar will exhibits 
the status of Point.

vNow Type the + symbol.
vRepeat the above steps till B9 or type: 

= B4 + B5 + B6 + B7 + B8 + B9 in B11. 
You will observe the different color 
borders that display around these 
cells.

vPress the Enter key. Cell B11 will 
show the total of all the values from 
B4 to B9.

2. There are four types of cell reference: 
(i) Relative Reference, (ii) Absolute 
Reference (iii) Mixed Reference, 
Circular Reference.

(i)Relative Reference : By default, all 
cell references are relative references. 
When copied across multiple cells, 
they change based on the relative 
position of rows and columns. For 
example, if the formula in A3 is = A1 
+ A2 and you copy the formula from 
A3 to B3. Excel automatically changes 
the reference to match the position of 
cells, i.e., = B1 + B2 . 

(ii) Absolute Reference : There may be 
situations when you do not want a cell 
reference to change when filling cells. 
Unlike relative references, absolute 
references do not change when copied 
or filled. You can use an absolute 
represent to keep a row and/or column 
constant. An absolute reference is  
designated in a formula by the addition 
of a dollar sign $. It can precede the 
column reference, the row reference or 

both. For example = $A$1+$A$2 To create 
and copy a formula using absolute references:

3. Ways of entering a cell reference in a 
formula:
Using Copy-paste Option: 
vClick on the button New Sheet present 

to the right of the Sheet 1 tab at the 
bottom of the screen. A new worksheet 
with the name Sheet 2 will be added. 
Now, enter the data as shown in the 
Figure.

vClick on the Sheet 1 tab. Now, click 
on cell B11 where the 'SUM' function 
is used.

vCopy the formula using Ctrl+C.
vClick on the Sheet 2 tab. Click on 

the cell B11. Now, paste the formula 
using Ctrl + V. The cell will display 
the result of the formula i.e., 
summation of the cell values.

Using Sheet Reference
In this method, we use sheet number, 
exclamation mark, and cell address to refer 
to a cell a particular worksheet. For 
example, by writing Sheet1! D4, we are 
referring to the cell D4 of Sheet1. Let us try 
to use this method to calculate the total 
salary.
vClick on the cell C4 of Sheet 2.
vType = B4 +Sheet1:D4 in it and press 

Enter. This will add the 'Incentive 
Amount' present in the cell D4 of 
Sheet1 with the 'Salary' present in 
cell B4 of Sheet2.

4. To rename a worksheet do the 
following steps.
vRight-click on the 'Sheet2' tab in the 

worksheet.
vA shortcut menu will appear. Click 

on the Rename option.
vThe Sheet tab gets highlighted. Type 

the new name and press Enter.
vNote that the name of the Sheet2 gets 

changed.
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5. Functions are the pre-defined formulas or 
built-in calculations. Functions save time 
and stop the chance to write wrong 
formulas. They accept Arguments and 
return Values. Functions start with the equal 
to (=) sign followed by the function name 
and then the list of arguments separated by 
comma  within  the  parenthesis.

6. A formula in a cell that directly or 
indirectly refers to its own cell is 
called a circular reference. For 
example, if you enter the formula = 
A1 + A2x3 in cell A2, you are making 
the formula to refer to its own cell 
value, which is not possible. In such a 
case, an alert dialog box indicating 
the problem displays as shown in the 
figure given below. As soon as you 
click on the OK button of the alert 
dialog box, 0 will be returned in the 
cell containing formula. The Status 
bar will also notify you that circular 
reference is found in the workbook 
and the address of that cell will be 
displayed on it.

7. Uses of common functions:

Autosum: Besides being the common 
and the fastest way to find numbers 
in a range, the Autosum option also 
be used like Average, Count, Max, 
Min, etc. This option is available in 
two places :
vIn the Editing group on the Home 

tab.
vIn the Function Library group on the 

Formula tab.
Average ( ) : The Average function 
returns the average of the range values. 
The arguments can be a range of cells, 
simply numbers, or numbers along 
with cell reference (s).
Max (): It is used to find the largest 
value in the given range.

Today ( ) : It is used to show the current 
date.

8. Rules To Enter A Function
v All Excel functions must start with = 

sign.
vFunction name must be a valid Excel 

name. For example, SUM, AVERAGE.
vFunction name must be followed by 

an opening and closing parenthesis.
vArguments  are enclosed in the 

parenthesis.  For example; = SUM 
(A1:A5).

9. Steps to find the GCD of three numbers:
vEnter three integers in cell A1, A2, 

and A3.
vNow, select the cell A4 where the 

GCD of these numbers will be 
exhibited.

vClick on the Math & Trig drop-down 
button in the Function Library on 
the Formulas tab and select GCD 
from the displayed list of options.

vThe Function Arguments dialog box 
comes into sight. Type A1, A2 and 
A3 in Number1, Number2, and 
Number3 text boxes respectively. 
Notice that the result of the formula 
emerges near the bottom of th dialog 
box.

vClick OK. The output will come into 
view in the cell A4.

E. 1. Saurav have to use Max () and Min ( ) 
functions to achieve the task.

2. Step 1 : In A2, type the header With 
10% increase. Since we have a number 
mixed with text, Excel will treat the 
entire cell as text.
Step 2: Press Tab, then in B18, enter 
this Excel percentage formula: =A2 * 
1.10
Alternatively, you can enter the 
formula this way: =A2 * 110%
The Amount is 16150.
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CH-7 USING EXCEL AS DATABASE
Exercises
A. 1. organized, 2. data form, 3. Field name, 

 4. Consolidation, 5. criteria
B. 1. True, 2. True, 3. True, 4. False, 5. False
C. 1. (b), 2. (a), 3. (c), 4. (a), 5. (b)
D. 1. A database is an organized collection 

of data. It is a collection of schemes, 
tables, queries, reports, views and 
other elements. It is an electronic 
system that allows data to be easily 
accessed, manipulated and updated.
In other words, a database is used by an 
organization as a method of storing. 
Managing and retrieving information.

2. Rules to enter the Field Names:
v Field names have to be unique.
v You can space out the title of the field 

and it will still find the topic eg.
v If a label field has no name, it will not 

be shown when the form is viewed, 
only when it is edited.

v Field names can in theory include any 
text, but you should stick to alpha 
numeric characters.

v Leading and trailing spaces are not 
significant.

3. Sorting is the process of arranging data 
into meaningful order so that you can 
analyze it more effectively. We can sort 
data according to a particular. Field 
either in increasing or decreasing order 
in a worksheet.

4. v The excel feature “filter” is a very 
important feature as it saves time and 
reduces workload by many times 
especially for those who use excel all 
day.

v It is used everyday mainly for analysis 
work. Filters are used to find all records 
matching a certain criteria at one place.

v There are different types of filter in 
Excel such as number filter, text filter, 
begins with, end with, contains, display 

top 10.
v The benefits of filters (save time and 

reduces workload) increase 
exponentially when there are more 
than one or two criteria of you have 
50,000 transactions items and suppose 
the type of transaction items and 
suppose the type of transaction that 
you look for only 5 to 10 in number, 
instead of searching manually you can 
use “Filters”.

5. Data Validation is used to restrict the 
cell entries within a specified range.

v Select the range E5:E13. Choose Data > 
Validation. Click the Setting tab.

v In Allow: drop-down list box, select 
Whole number option.

v In Data drop-down list box, between 
option is selected by default.

v In Minimum: text box, type 0 and in 
Maximum: text box type 100.

v Click the Input Message tab. In Title: 
text box, type Validation. In Input 
message: box, type >=0 and <=100.

v Click the Error Alert tab and type 
'Input is wrong' in Error Message box. 
Click OK to close the dialog box.

v If you try to enter data beyond the 
specified limit in the selected range, an 
error message will be displayed. Click 
on Retry to enter another value in the 
cell.

6. A pivot table is a program tool that 
al lows you to recognized and 
summarize selected columns and rows 
of data in a spreadsheet of database 
table to obtain a desired report. A pivot 
table doesn’t actually change the 
spreadsheet or database itself.

7. Sorting takes a set of data and sorts it by  
a chosen metric or letter. The most 
important difference is that sorting 
does not remove entries from the data 
set. Sorting only puts the data into a 
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new order.
8. Filtering on the other hand is useful in 

a different way. While sorting will give 
you the option of choosing which 
metric you want to prioritize. Filtering 
actually removes data that’s irrelevant 
to your analysis.

E. Riya will make worksheets in group by 
using given steps.
v Create a new workbook. The 'Sheet1' 

worksheet is active.
v Press and Hold the Shift key. Click on 

Sheet3 Tab.
v Release the Shift key. Note that all the 

three worksheet tabs have become 
white and the word '[Group]' appears 
in the Title bar. It indicates that Sheet1, 
Sheet2 and Sheet3 are grouped 
together.

v Enter the data as shown in the figure, in 
the grouped worksheet.

v Format the heading by making it bold 
and increasing its font size to 18. Apply 
border around the heading 'FIRST 
QUARTER SALES' 2016.

v Select the Row 3, increase the Font size 
to 14 and bold it. Similarly, select 
Column A and apply same formatting 
effects.

v To ungroup the worksheet, click on any 
other Sheet tab except Sheet1 or right 
click on any grouped Sheet tab and 
select Ungroup Sheets option.

v All the three sheets will display the 
common data with formatting effects.

v Click on Sheet2 and change the year to 
2017 Similarly, change the heading to 
" C O N S O L I D A T I N G  F I R S T  
QUARTER SALES (2016 - 2017)" in 
Sheet3.

v Save the worksheet with the name 
"MULTIPLE"

CH-8 WORKING WITH FLASH CS6
Exercise
A. 1. Symbol, 2. Library, 3. Three, 4. Button, 

5. Morphing, 6. Instance, 7. two
B. 1. False, 2. True, 3. False, 4. False, 5. False, 

6. True, 7. False
C. 1. (c), 2. (b), 3. (c), 4. (b), 5. (b)
D. 1. A symbol is reusable static image that 

are used mainly to create animations.
The three types of symbols
Graphic Symbols : They are reusable 
static images that are used mainly to 
create animations.
Button Symbols : These symbols are 
used for time line navigation.
Movie clip Symbols : These symbols 
are reusable pieces of flash animation.

2. Follow these steps to create a symbol:
vDraw a car on the Stage, by using the 

Rectangle Tool , Oval Tool , Pencil Tool 
and , from the Tools panel.

v Choose the Selection Tool and drag the 
mouse pointer on the Stage to enclose 
the car within a rectangular selection 
marquee.

v Choose Modify > Convert to Symbol.
v You will get a Convert to Symbol dialog 

box. Choose Graphic from the Type 
drop down list.

v Specify the symbol's name - G-Car 
Name textbox and click OK. Your new 
symbol is now added in the library 
panel.

3. An animation is the illusion of 
movement created by showing a series 
of still pictures in rapid succession. In 
the world of computers, graphic 
software used to create this effect.

4. Instance is a copy of the original 
symbol. Which can have use own 
independent properties such as color, 
size, function etc, different from the 
original symbol.
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5. Motion guides are especially useful 
when you work with a shape that has an 
obvious orientation (or direction, such 
as the nose of a car or an airplane). For 
this reason, be sure to use a symbol 
with an obvious orientation.

6. Any object (or group of objects) that 
can appear on the stage can be made 
into a symbol. Here’s how to do it:

v Select one or more objects on the stage. 
The selected objects may include 
paths, text objects, bitmaps, or even 
other symbols.

v Choose Modify > Convert to Symbol, 
or press the F8 key. The Convert to 
Symbol dialog box appears.

v Enter a name for the symbol into the 
Name field.

v Click the radio button for the type of 
symbol you want to create: a movie 
clip, button, or graphic.

7. Animations can be created in Flash 
with the help of tweening, which 
means 'in between'. The movement 
from one keyframe to the other 
becomes well timed with the use of the 
tweening. There are two types of 
tweened animation.

vMotion tween        v  Shape tween
The main difference between both the 
tweening is that the Motion tweening 
works on symbols, whereas, shape 
tweening is used with objects that are 
not symbols and are ungrouped.

8. The Deco Tool has a symmetry brush, 
which enables you to create interesting 
textures, patterns and symmetrical 
drawings from symbols. It provides 
several distinctive effects, which can 
either be applied to the entire stage or 
any object that is selected on the stage.

9. The spray Brush tool paints with 
instances allows you to brush pattern 
of shapes at one time. By default, it 

emits a spray of dot particles using the 
currently selected Fill Color. However, 
it can also be used to apply a symbol as a 
pattern.

E. 1. Sohail need to use shape tween 
animation to show a smiling face 
changing into a crying face.

2. Mohini need to do following steps to 
move the clouds:

vOpen the saved file.
vNotice that the layer structure matches 

the Clouds demo. In fact, you may use 
your Cloud file in this exercise if you 
prefer.

v Add a new layer and name it clouds.
v Select the new layer and open the 

Library. Drag 2-3 instances of clouds 
onto the first keyframe of the new layer.

v Single-click on the cloud instances (to 
select them) and add a Motion Tween 
(by right-clicking or choosing Insert > 
Motion Tween from the Menu).

v Flash just added the default number of 
frames for a new Tween (about 24). 
Drag the playhead to frame 12 (or 
about half way to the end of the 
animation). Now, position the clouds 
about halfway across the screen.

v To complete the second part of the 
animation drag the play head to the last 
frame and reposition the clouds once 
again.

vWhen you run the movie, you might 
decide that it is moving too quickly. By 
adding more frames, the animation 
will take more time. 

v Adjust your animation until you are 
satisfied! Test the movie to watch your 
animation.

CH-9 THE MAIL MERGE
Exercises
A. 1. Main, 2. MS Excel or MS Access, 3. 

Modify, 4. Many, 5. MS Word
B. 1. True, 2. True, 3. False, 4. True, 5. True, 6. 

13Keys Computer (6-8)



True, 7. False, 8. False
C. 1. (b), 2. (a), 3. (b), 4. (a), 5. (b)
D. 1. The body of the standard letter to be 

sent to all recipients is called the Main 
Document as shown in the figure given 
below. It also contains the required 
field names for carrying out the merge 
process. Data Source as shown in the 
figure stores information to be brought 
into the main document. It is also 
called the data file. The data file has a 
table comprising columns for each 
field of information.

2. Once you have selected the type of mail 
merge, you can make your recipient list 
or data source. Apart from creating it 
in MS Word, you can import it from 
MS Excel or MS Access database.

3. Mail merge is used to create letters, e-
mail messages, envelopes, labels and 
directories. The data document holds 
the text that repeats for all merged 
documents. Click on start Mail Merge 
and select the document type on the 
mailing tab as shows in the figure.

4. The process of mail merge includes 
three main steps.

v Creating the main document 
consisting the body of the letter.

v Creating the data source that 
comprises the records of recipients.

vMerging the data source and the main 
document.

5. Click on the Preview Results button in 
the Preview Results group of the 
Mailings tab. It enables you to navigate 
through the recipients in the data 
document.

E. 1. It also contains the required field 
names for carrying out the merge 
process. Data Source as shown in the 
figure stores information to be brought 
into the main document. It is also 
called the data file. The data file has a 
table comprising columns for each 

field of information. For example, it 
may store names of people, their 
addresses and alike information. It has 
some variable data such as first name, 
last name of a recipients and the postal 
pin code of the place he/she belongs to. 
The header row is the first row of the 
table. It records collection of variable 
data regarding a person or a thing.

2. The different steps to choose your 
recipients are given below. Click on 
the Select Recipients button from the 
Start Mail Merge group of the 
Mailings tab. A drop-down menu 
comprising different options emerges.

CH-10 INTERNET SERVICES
Exercises
A. 1. Internet, 2. Web browser, 3. Skype, 4. E-

learning, 5. Internet Radio
B. 1. False, 2. True, 3. False, 4. True, 5. True
C. 1. (b), 2. (c), 3. (c), 4. (b), 5. (a)
D. 1.They devised a network of four 

computers to exchange and share their 
data.

2. BSNL, Tata, Airtel, Reliance
3. The only difference between Instant 

messaging and Online chat is that in 
Instant messaging (IM), the 
communication come about between 
known users, and involves only those 
people whom the user has invited, 
whereas, Online chat could happen 
between unknown users too.

4. E-learning can be implemented using 
an Internet connection, a network, an 
intranet, or a storage disk. It is less 
expensive than traditional learning 
and can be used to give training to a 
large group of students at the same 
time, in an interactive and interesting 
manner. Thus it saves time and lowers 
the need for costly classroom-based 
training.

5. Internet Radio, is an online radio 
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service that is broadcasted over the 
Internet on dedicated radio servers. It 
is broadcasted in much the same way as 
traditional radio with regard to its 
presentation and format. Here, audio 
stream is digitized and split into small 
pieces for transmission across the 
Internet. It provides the listeners with a 
continuous stream of audio, which 
cannot be paused or replayed.

E. 1. This technology is largely used for 
virtual meetings among a group of 
people to discuss political, business, 
medical, or social affairs. On television 
most often we see that a program host is 
conducting interview among several 
participant sitting in different cities and 
countries. This is done through video 
c on f e re n c i n g .  Popu l a r  Vi d e o  
conferencing applications include: 
Skype, Adobe Connect, Oovoo, Yugma, 
Ekiga, etc.

2. It is a net banking service that allows 
customers to perform all routine 
transactions such as account transfers, 
balance enquiries, bill payments and 
stop payment requests, and some 
even offer online loan and credit 
applications. These transactions can 
be performed from anywhere 
regardless of time, if one has an 
Internet connection on his computer. 
As all the services are web enabled, 
the customer needs to log in to the 
website of a bank and access the 
centralized database by stating the 
desired bank service.

                  My Activity Question

                MODEL TEST PAPER-1
A. 1. (b), 2. (b), 3. (a), 4. (b), 5. (c)
B. 1. Machine, 2. Disk Clean Up, 3. start/stop, 

4. copying, 5. Add level
C. 1. True, 2. False, 3. True, 4. True, 5. False
D. 1. A computer language includes various 

languages that are used to communicate 
with a computer machine. Some of the 
languages like programming language 
which is a set of codes or instructions 
used for communicating the machine. 
Machine code is also considered as a 
computer language that can be used for 
programming.

2. Start/Stop Symbol: This symbol is used 
to show where your flow begins or ends.

Input/Output Symbol: This symbol is 
used to indicate the acceptance of 
inputs from a user or the output or the 
result concluded.

Flow Lines: The flowchart symbols are 
connected with the help of flow lines.

Processing Symbol: his symbol is used 
to illustrate a process, action or an 
operation. 

Decision Box: his symbol is used in a 
process flow to as a question. And the 
answer to the question determines the 
arrows coming out of the symbol.

Connector: In flowcharts, this symbol 
is typically small and is used as a 
connector to show a jump from one 
point in the process flow to another.
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3. Advantages of flowcharts :
  v Communication: Flowcharts are 

better way of communicating the logic 
of a system to all  concerned or 
involved.

    v  Effective Analysis: With the help of 
flowchart, problem can be analyzed  in 
more effective way therefore reducing 
cost and wastage of time.

  v Proper Documentation: Program 
flowcharts save as a good program 
documentation, which is needed for 
various purposes, making things more 
efficient.

Disadvantages of Flowcharts
    v Complex logic: Sometimes, the 

program logic is quick complicated. 
In that case flowchart becomes 
complex and clumsy. This will 
become a pain for the user, resulting 
in a waste of time.

  v Alterations and Modifications: If 
alternations are required the flowchart 
may require re-drawing completely. 
This will usually waste valuable time.

 v Reproduction: As the flowchart 
symbols cannot be typed, reproduction 
of flowchart becomes a problem.

4. Windows Media Player is a media 
player and media library applicator 
developed by Microsoft that is used for 
playing audio, video and viewing 
images on personal computer running 
the Microsoft Windows Operating 
System, as well as on pocket PC and 
windows Mobile based devices.

E. 1. Machine Language: Machine language 
is a low level programming language. It 
is the first generation language 
developed for communicating with a 
computer. It is written in machine code 
which represents 0 and 1 binary digits 
inside the computer string which 
makes it easy to understand and 

perform the operations.
2. Features of Windows 10 : Windows 10 

is loaded with multi-tasking tools such 
as custom start menu, live tiles, snap 
assist, task view and virtual desktops to 
keep you organized focused and ready 
for anything.

3. High Level languages : The High 
level languages are the most used and 
also more considered programming 
languages that helps a programmer to 
read, write and maintain. It is also the 
third generation language that is used 
and also running till now by many 
programmers. 

4. Flowchart: A flowchart is a type of 
diagram that represent an algorithm, 
workflow or process showing the steps 
as boxes of various kinds and their 
order by connecting them with arrows. 
This diagrammatic representation 
illustrates a solution model to a given 
problem.

5.4GL: Fourth generation computer 
languages are closer to human language 
than other high-level languages and are 
accessible to people without formal 
training as programmers.

MODEL TEST PAPER-2
A. 1. (b), 2. (c), 3. (c), 4. (c), 5. (a)
B. 1. Transitions, 2. Text, Object, 3. Format, 

4.  Concentration, 5. Arguments
C. 1. True, 2. False, 3. False, 4. False, 5. True
D. 1. Rules To Enter A Function

v All Excel functions must start with = 
sign.

vFunction name must be a valid 
Excel name. For example, SUM, 
AVERAGE.

vFunction name must be followed by 
an opening and closing parenthesis.

vArguments are enclosed in the 
parenthesis. For example; = SUM 
(A1:A5).
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2. v After making changes in a cell, you 
may want to cancel the changes and 
retrieve the earlier data. To undo the 
last action (s) done, use the Undo 
button on the Quick Access Toolbar.

vThe Redo command is used to 
quickly repeat the last action (s) that 
you have undone using Undo 
command. To do so, click on the 
Redo button on the Quick Access 
Toolbar.

3. Ways of entering a cell reference in a 
formula:
Using Copy-paste Option: 
vClick on the button New Sheet 

present to the right of the Sheet 1 tab 
at the bottom of the screen. A new 
worksheet with the name Sheet 2 will 
be added. Now, enter the data as 
shown in the Figure.

vClick on the Sheet 1 tab. Now, click 
on cell B11 where the 'SUM' function 
is used.

vCopy the formula using Ctrl+C.
vClick on the Sheet 2 tab. Click on the 

cell B11. Now, paste the formula 
using Ctrl + V. The cell will display 
the result of the formula i.e., 
summation of the cell values.

Using Sheet Reference
In this method, we use sheet number, 
exclamation mark, and cell address to 
refer to a cell a particular worksheet. 
For example, by writing Sheet1! D4, we 
are referring to the cell D4 of Sheet1. 
Let us try to use this method to 
calculate the total salary.
vClick on the cell C4 of Sheet 2.
vType = B4 +Sheet1:D4 in it and press 

Enter. This will add the 'Incentive 
Amount' present in the cell D4 of 
Sheet1 with the 'Salary' present in 
cell B4 of Sheet2.

4. Moving objects, such as text, graphics, 

charts, logos, etc. that are made up of a 
sequence of images displayed after this 
other on the slide are called Animations.

Animation is quite helpful when you 
want to focus on important points. It 
also controls the sequence of the flow 
of information and helps in making 
information more extraordinary. 
Apart from giving visual effects to your 
presentation, you can also sizzle up 
your slide objects – the text, pictures, 
shapes, tables, Smart Art graphics, etc. 
by applying sound effects.

 To modify the row Height
vSelect the row.
vIn the cells group on the Home tab. 

Click on the drop-down of arrow the 
Format button.

vClick on the Row Height option.
vThe Row Height dialog box displays. 

Enter the required value and click 
OK.

vThe change will be shown on the 
selected row.

To modify the Column Width
vSelect the column.
vClick on the drop-down arrow of the 

Format button on the Home tab. 
From the displayed list of options, 
click on Column Width.

vThe Column Width dialog box 
displays. Enter the required value 
and click OK.
Notice the change on the selected 
column.

E. 1. Animation Effects: Moving objects, 
such as text, graphics, charts, logos, 
etc. that are made up of a sequence of 
images displayed after this other on 
the slide are called Animations.

2. Formula Errors: If any formula is 
entered incorrectly in MS Excel, then 
Excel shows an error message rather 
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than the proper value. It also helps 
you in finding and solving the 
problem.

4. Redo features: The Redo command 
is used to quickly repeat the last 
action (s) that you have undone 
using Undo command. To do so, 
click on the Redo button on the 
Quick Access Toolbar.

5. Video Clips: Video clips are short 
clips of video usually part of a longer 
recording. They add liveliness to the 
presentation. PowerPoint enables you 
to insert a video onto a slide and play it 
during your presentation.

MODEL TEST PAPER-3
A. 1. (c), 2. (b), 3. (a), 4. (b), 5. (a)
B. 1. Symbol, 2. data form, 3. Main, 4. Many,

 5. MS Word
C. 1. True, 2. False, 3. True, 4. False, 5. True
D. 1. Motion guides are especially useful 

when you work with a shape that has an 
obvious orientation (or direction, such 
as the nose of a car or an airplane). For 
this reason, be sure to use a symbol 
with an obvious orientation.

2. The only difference between Instant 
messaging and Online chat is that in 
Instant messaging (IM), the 
communication come about between 
known users, and involves only those 
people whom the user has invited, 
whereas, Online chat could happen 
between unknown users too.

3. They devised a network of four 
computers to exchange and share their 
data.

4. The process of mail merge includes 
three main steps.

v Creating the main document 
consisting the body of the letter.

v Creating the data source that 
comprises the records of recipients.

vMerging the data source and the main 

document.
5. Sorting is the process of arranging data 

into meaningful order so that you can 
analyze it more effectively. We can sort 
data according to a particular. Field 
either in increasing or decreasing order 
in a worksheet.

E. 1. Adobe Flash is a multimedia software 
platform used for production of 
animations, rich Internet applications, 
desktop applications, mobile 
applications, mobile games and 
embedded web browser video players. 
Flash displays text, vector graphics 
and raster graphics to provide 
animations, video games and 
applications. It allows streaming of 
audio and video, and can capture 
mouse, keyboard, microphone and 
camera input.

2. Flash provides us with the ability to 
create a motion guide that specifies the 
path of the movement for an object. 
Instead of having an object move from 
one point to another in straight path, we 
can make it follow an arbitrary path that 
we draw, i.e. a motion guide.

3. Once you have selected the type of mail 
merge, you can make your recipient list 
or data source. Apart from creating it in 
MS Word, you can import it from MS 
Excel or MS Access database.

4. E-Banking stands for Electronic 
Banking. It is a net banking service 
that allows customers to perform all 
routine transactions such as account 
transfers, balance enquiries, bill 
payments and stop payment requests, 
and some even offer online loan and 
credit applications. These transactions 
can be performed from anywhere 
regardless of time, if one has an 
Internet connection on his computer. 
As all the services are web enabled, the 
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customer needs to log in to the 
website of a bank and access the 
centralized database by stating the 
desired bank service.

5. Video Call or Video Conference  
means to conduct a conference 
between two or more participants at 
different sites by using computer 
network to transmit audio and video 
data. The participants can view each 
other on their monitors as well as hear 
voice over speakers of their laptops or 
desktop computers.
It implies the use of camera called Web 
cam and also microphone at the end of 
each participant to capture video and 
audio data in real time. Images and 
sounds are transmitted through 
Internet and delivered to other 
participants.
This technology is largely used for 
virtual meetings among a group of 
people to discuss political, business, 
medical, or social affairs. On 
television most often we see that a 
program host is conducting interview 
among several participant sitting in 
different cities and countries. This is 
done through video conferencing. 
Popular Video conferencing 
applications include: Skype, Adobe 
Connect, Oovoo, Yugma, Ekiga, etc.



CH-1 NUMBER SYSTEM
Exercise
A. 1. 2,  2. Decimal Number,  3. 8,  4. 10,

5. Binary,  6. Hexadecimal, 7. 0
B. 1. True,  2. True,  3. True, 4. True,  5. False,

6. False.
C. 1. (b), 2. (a), 3. ©,  4. (b), 5. (b)
D. 1. A number system is a set of values used 

to represent different quantities.
      1.) Decimal Number System,  2.) Binary        

System, 3.) Octal Number System 
      4.) Hexadecimal Number System  
      5.) Computer Arithmetic

2. Multiply each binary number with its 
place value, which is in terms of powers 
of 2, starting from the extreme right 
digit.
Increase the power one by one, keeping 
the base fixed as 2.
Sum up all products to get the decimal 
number.

3. The number is borrowed when 1 is 
subtracted from 0 (10-1=1).

4. The octal number system (oct) 
comprises 8 digits: 0 to 7 with the base 
8. The concept of octal number 
system came from the Native 
Americans as they used to count 
numbers by using the space between 
their fingers instead of using their 
fingers. 

5. This number system comprises 16 
digits: 0-9 and the letters A-F, where 
A-F represents digits 10 to 15 with the 
base 16. This number system is also 
known as Hex, where Hex=6 and 
Decimal = 10, so it is called 
Hexadecimal.

E. 1. Convert any octal number to decimal 

number, we have to multiplying the 
digits of the number from right hand 
side with the increasing power of 8 
beginning form 0.

2. The number is borrowed when 1 is 
subtracted from 0 (10-1=1).

CH-2 CREATING CHARTS IN MS EXCEL
Exercise
A. 1. Pie,  2. Bar,  3. legend,  4. X-axis,

5. Ribbon,  
6. Design, layout and format tabs.

B. 1. True,  2. False,  3. False,  4. False,   
5. False,  6. True.

C. 1. (b),  2. (a),  3. (c),  4. (b),  5. (a),  6. (b)
D. 1. (d),  2. (a),  3. (e),  4. (b),  5. (c)
E. 1. X-Axis : It is the horizontal axis of a 

chart. It is also known as the category 
axis.

    Y-Axis : It is the vertical axis of a chart. 
It is also known as the  value axis.

2. Chart tittle : It contains a summary or 
short description to the chart. It is 
usually placed at the top of a chart 
which helps the users to understand 
what the chart represents.
Axis tittle : It is the tittle given to an 
axis. A 2D graph has two axes (X, Y) 
and a 3D graph has 3 axes (X, Y, Z)

3. 2D chart : A 2D graph has two axes (X, Y)
3D chart : A 3D graph has 3 axes (X, Y, Z).

4. Chart Area : This is the area that makes 
up the chart. All charts have a chart 
area. This include the plot area and the 
space outside it.

     Plot Area : It is  the rectangular area 
bounded by the X-axis define the two 
sides of a rectangular plot area.

5. Column Chart : These charts are used 
to compare values across the different  

Computer-7
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categories. Marks obtained in 
different subjects by different are 
shown through column charts.
Line Chart : The line chart is equally 
effective in displaying trends for 
multiple series as shown in the figure.

6. Pie chart : A pie chart can only display 
one series of the data. If we had 
selected multiple series of data. Excel 
would ignore all but the first series.

          Bar chart : A Bar chart displays 
comparisons among individual items 
through a group of bars.  It is used to 
compare multiple values through 
horizontal and vertical bars.

7. Area Chart : An area chart  are like 
line chart except that the area below 
the plot line is solid. This chart is 
mainly used for representing sales 
and production figures of a company.
XY scatter chart : The purpose of a 
scatter chart is to observe how the 
values of two series compares over 
time or other category. The 
relationship between two variables is 
called correlation. 

8. Layout tab : on the layout tab you have 
various options to choose from and 
select for your chart. You can place 
pictures, Shapes, Text boxes, labels or 
Background to your chart.
Format tab : You will find several 
options to modify the Shape styles, 
word art styles or size of the chart.

F. 1. A chart is a graphical representation of 
data, in which the data is represented 
by symbols such as bars in a bar chart, 
lines in a line chart or slices in a pie 
chart. A chart can represent tabular 
numeric qualitative structure and 
provides different information.

2. Types of Charts
1. Column  Chart 2. Line  Chart
3. Pie  Chart 4. Bar  Chart
5. Area  Chart 6.XY Scatter  Chart

3. A pie chart can only display one 
series of the data. Excel uses the 
series identified as the identifier as 
the chart title and displays the values 
for that series as proportional slices 
of a pie. Excel would ignore all but 
the first series.

4. Select the chart. On the layout tab, 
click  on the chart title or the data 
labels button from the labels group. A 
drop-down menu displays. Select the 
appropriate option from the drop-
down menu. Change the chart title or 
the data labels and press the enter 
key.

5. First, select the chart, click on the 
select data button from the data 
group of the design tab of the ribbon. 
A select data source dialog box 
displays. Do the desired changes in it.

6. Select the chart, click on the copy 
button from the clipboard group to 
select it. Open the MS Word 
document where you want to copy 
the chart. Click on the Paste button 
from the Clip board group of the 
Home tab. You get the copy of the 
chart there.

G. Select the cells that comprises the data 
you want to use in the chart. Click on the 
insert tab of the Ribbon to choose the 
type of chart you want to create from the 
charts group. A chart of your choice is 
created. It is based on the data series. On 
clicking the chart different options are 
shown in the chart styles  group to 
choose from.
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CH-3  WORKING WITH FLASH CS6
Exercise
A. 1. Graphic / Adobe Systems,  2. Library,

3. Stage,  4. Work Area,  5. Time line,
6. Layers.

B. 1. True,  2. False,  3. True,  4. True, 5. True
C. 1. (c),  2. (b),  3. (a),  4. (a),  5. (c)
D. 1. Flash is multimedia graphic program 

developed by Adobe Systems (formerly 
Macro media). It is used to create 
animations, games, cartoons, text, 
graphics and other special effects. It 
also helps to design movies on the web 
and create animations with out using 
programming skills.

2. A gradient is a multicolor fill in which 
one color gradually turns into another 
color. Gradients are created by mixing 
of two or more colors in an objects. 
You can use the color panel to form 
your own gradients and add them to 
the Swatches panel. Two types of 
Gradients 1) Linear Gradient : If 
changes color from the starting point 
to the end point in a straight line.
2) Radial Gradient : If changes color 
in a circular outward direction, 
starting from the focal point.

3. It is used to organize and modify the 
properties of the current selection.

4. Select the File
v Import – Import to Stage.
vThe Import dialog box displays. 
vBrowse and select the file that you 

want to import and click on Open.
5. Animation includes a series of still 

images, generally painted or sketched, 
appeared in rapid sequence. This 
transition from one image to another 
is so quick that it seems to show 
movement.

6. Filters enable you to interesting visual 
effects to text, buttons and movie clips. 
Filters generally include effects, such as 
drop shadows, blurs, glows, and bevels, 
etc. These effect can be easily applied 
using the properties panel.
Animated Filtered Text , Flash furnishes 
a unique feature to animate movie clips 
that have filters, using motion tweens. 
You can make an animation that 
involves light source effect, highlights, 
bevels and distortions by converting 
the filter properties at different 
keyframe ad using motion tween. 

E. 1. Press Ctrl+F8. A convert to symbol 
dialog box is appeared give a suitable 
name to the symbol and click on the 
Graphic option. Click Ok button. The 
symbol is created.

2. Color option to display the color panel. 
v Select either Linear gradient or 

Radial gradient from the color type 
drop-down list.

v Double click on the Left Pointer 
below the gradient definition bar. 
The color palette displays. Select 
the brown color.

v Double-click on the right pointer 
and select the color.

v Select the paint bucket tool and 
click on the trunk.

v Adjust the color blends of the 
gradient by dragging the pointers 
closer to each other or farther apart.

v Select any mode like Extend, 
Reflect or Repeat under the Flow 
section to apply to the gradient.

v To add more color to your gradient, 
click anywhere on the gradient 
definitions bar to add a slider 
(pointer). You can then double-
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click this slider to set the color.
v Click on the drop-down arrow on 

the upper right corner of the color 
panel bar, and select the Add 
Swatch from the menu.

CH-4  WORKING WITH LAYERS
Exercise
A. 1. Transparent,  2. Pencil Icon,  3. 

4. View, Grid, Show Grid,  5. 
B. 1. False,  2. True,  3. True,  4. True,  5. False
C. 1. (a),  2. (c),  3. (c)
D. 1. Layers are like sheets of transparent 

paper arranged in a stack. Each layer is 
a separate thing, but when you have a 
stack of layers, each with drawings on 
them, they can create an entire scene.

2. You can hide the layers to see the 
contents on the other layers. While 
hiding the layers, you have the option 
either to hide all the layers in your 
document at once or hide the layers 
individually.
v Click on the icon above the layers. A 

red cross symbol display Eyes in the 
Eye column. You will find that all 
the contents disappear from the 
stage.

v Click on each red cross symbol one 
by one in the column, and notice 
that the contents on the layer on the 
stage.

3. Click on the layer that to be renamed.
v Double click on the layer name and 

type the new name.
4. The concept of Masking in Flash CS6 

involves using a shapes to hide or 
reveal portions of a piece of artwork. It 
is like view the outside through a small 
window in your house. The window's 
size limits what you can see when you 
are inside. Masking is generally used in 

Flash to create spotlight effect that 
would display the text or object 
through a hoke.

E. 1. You can lock the layer to avoid any 
further changes to the content added 
by you.

CH-5 INTRODUCTION TO HTML 5
Exercise
A. 1. 1. Network, 2. Two, 3. Six, 4. Container, 

5. Cascading.
B. 1. True, 2. True, 3. False, 4. True, 5 False.
C. 1. (c),  2. (a), 3. (b), 4. (a), 5. (c), 6. (b).
D. 1. HTML stands for Hypertext Mark-up 

language. It is a complete code 
package that enables the user to create 
web pages that comprise both text 
and graphics. It is simple mark-up 
language  that expresses the structure 
and behaviors of the web document. 
All the web browsers are created to 
understand and interpret this 
language.

2. Container Elements
The elements that consist of both ON 
and OFF tags are called Container 
Elements. 
E.g., <b> This makes the text bold 
</b>
Empty Elements
Empty elements include only ON 
tags. They do not have OFF tags. 
These elements do not enclose any 
data; instead they do some function 
on their own.
E.g., <br>tag (It breaks the line and 
displays the text from the next line.)

3. To create a web page in HTML, follow 
the steps given below.
v Open Notepad by clicking on Start 

> All apps > Windows Accessories > 
Notepad.
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v The Notepad window will display.
v Type the HTML code as shown in 

the figure.
v Click on the File > Save option. 

The Save As dialog box will 
display. Select the target folder to 
save the file and mention the 
name in File name text box with 
an extension .html.

v Click on the Save button to save 
your web page.

4. A markup language is a computer 
language that uses tags to define 
elements within a document. It is 
human-readable, meaning marking 
files contain standard words, rather 
than typical programming syntax.
Originally, HTML was designed with 
the intent of defining the structure of 
documents to simplify the sharing of 
scientific information between 
researchers. Now, it is being widely 
used to format web pages with the 
help of different tags.

5. Cascading style sheets are used to 
format the layout of web pages. They 
can be used to define text styles table 
sizes, and other aspecting web pages 
that previously could only be defined 
in a page's HTML.

The concrete benefits of CSS include:
v Control layout of many documents 

from one single style sheet. (External 
Style Sheet).

vMore precise control of layout.
v Apply different layout to different 

media types (screen, print, etc.)
vMore advanced options and 

sophisticated techniques.
E. 1. This property is used to add an image 

in the background of an HTML 

document.
SYNTAX : background-image:value
where value = url (path of the image)
<html>
<head>
<style type = “text/css”>
body {background-mage:url (“c:/ 
Users/User/Desktop/Html/Temwork.
png”)}
</style>

2. This property enables us in inserting 
the picture or image at a desired place 
on the HTML document. By default, a 
image is inserted at the top-left corner 
of the element.
SYNTAX: background where 
value=xpos

 ypos|x%y%|[top|center|bottom]||[left|c
enter|right].

CH-6 INTRODUCTION TO QBASIC
Exercise
A. 1. Program, 2. IDE,  3. Statements, 4. 7.1,

5. F5, 6. bar, 7. Mode, 8. Loading, 9. Pixel
10. Sound.

B. 1. False, 2. True, 3. True, 4. True, 5. True,
6. False, 7. True, 8. True, 9. True, 10. False.

C. 1. (b), 2. (a), 3. (b), 4. (a)
D. 1. E= Upper – Right H= Upper – Left

G= Lower – Left F= Lower – Right
R= Right L= Left
D= Down U= Up

E. 1. Writing Program -Every program in 
QBASIC contains statements. Follow 
the steps given below to write a 
program in QBASIC.
v Click on the File menu.
v Select New Program option.
v Write the program.
SCREEN 2
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LINE (500, 50)-(100, 100
Running Program -To run a program 
in QBASIC follow the steps given 
below.
v Click on Run Menu.
v Select Start option or type Run in the 

Immediate mode of the window.
2. The different steps to save a program in 

QBASIC are given below.
v Click on the File menu and Select 

Save or Save As option. A Save As 
dialog box emerges on the window.

v Type the file name and click on OK 
in the dialog box.

Your program is saved with the .BAS 
extension. Any file generated in 
QBASIC is automatically given an 
extension .BAS. This makes it easy to 
identify files generated in BASIC.

3. While naming a file follow the rules 
given below.
v The file name should not have more 

than 8 characters.
v It should start with an alphabet.
v There should be no space in the 

name.
v There should be no special characters 

in the name.
4. Syntax : PAINT (X, Y), Fill Color, 

Border Color
X, Y – The coordinates that show the 
location of the shape.
Fill Colour - This is for the colour to be 
filled inside the figure. A particular 
colour is denoted through a number.
Border Colour - This is for the colour 
of the border of the figure. It is also 
denoted through a number.

5. The lowest frequency allowed by 
QBASIC is 3,7 HZ. The highest 
frequency is 32,737 HZ, but this sound 

cannot be heard because the normal 
human hearing range ends at 20,000 
HZ.

F. DRAW is same as the turtle in the 
programming language MSW Logo. With 
DRAW, you can move around the screen 
and draw lines along the way. Here are the 
directional commands given below.
U = Up
D = Down
L = Left
R = Right
E = Upper-right
F = Lower-right
G = Lower-left
H = Upper-left
To drag a cursor without drawing the line, 
use the alphabet B before the command.
After each directional command, the 
length of the line (pixels) should be 
denoted. If no length is defined then the 
value is supposed to be 1.

CH-7 WORKING WITH WEB
 BROWSERS
Exercise
A. 1. software, 2. Cache, 3. Search, 

4. Plug-ins, 5. Image.
B. 1. False, 2. True, 3. True, 4. False, 5. True.
C. 1. (a), 2. (b), 3. (a), 4. (c), 5. (c), 6. (c).
D. 1. Graphical Web Browser : Graphical 

browser like Internet Explorer, 
Mozilla Firefox, Netscape, Opera and 
Google Chrome can display text, 
images, audio and video files. They 
are accessible for operating systems 
such as Windows, Apple and Linux. 
You can even download and install a 
graphical browser on your computer.
Text Web Browser: A text web browser 
like a graphical browser, Lets you surf 
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the web. However, there is one big 
difference the complete absence of a 
nice Looking interface. You hardly ever 
use the mouse to more about but rather 
employ keys like the tab and the enter 
key. opening a web site shows you only 
text.

2. Links : A link is an HTML object that 
allows you to jump to a new location 
when you click or tap it. links are found 
on almost every web page and provide 
a simple means of navigating between 
pages on the web. It can be text or an 
image. Sometimes you are not sure if it 
is a link or not. Place the cursor over it 
if it turns to a hand symbol then it is a 
link.
Bookmarks : Bookmarks is an Internet 
browser feature that allows a user to go 
back to a previously visited website by 
clicking on the saved link- without 
retyping the site's address. It is also 
called favorites. In Internet Explorer, 
you can add a bookmark by clicking 
Favorites and then Add to Favorites. 
You can also click on Bookmarks and 
select Save this page option to save the 
web page. Other browsers are similar, 
but they may use different names for 
book marking.

3. Hyperlinks : A hyperlink is an element 
in an HTML document that links to 
either another portion of the 
document or to another document 
altogether. On webpages, hyperlinks 
are usually colored purple or blue and 
are sometimes underlined.
Plug-ins : Plug-ins applications are 
program that can easily be installed 
and used as part if your web browser. 
Examples  of  plug-ins  include 
QuickTime Player and Flash player. 

Your browser may have come with 
some plug-ins already installed. Once 
you have the necessary plug-ins, you 
will be able to enjoy watching videos 
and playing games on web sites.

4. Internet Explorer: Internet Explorer is 
a web browser that allows computer 
users to view web pages on the Internet 
users can also use Internet Explorer to 
listen and watch streaming content, 
access online banking, make purchases 
over the Internet and much more. 
Internet Explorer was first introduced 
in August 16, 1995 by Microsoft as 
Internet Explorer 1.0. So far 11 versions 
of Internet Explorer were released. 
Internet Explorer 11. Which was 
released in 2013, is the last version of 
the web browser.
Google Chrome: Google Chrome is 
yet another popular web browser that 
was developed by Google. It was 
released on December 11, 2008. It 
allows the users to quickly access web 
pages and make local desktop shortcuts 
to open the web application in the 
browser. Google Chrome is extensively 
used by the users due to its stability and 
simplicity.

E. 1. A web browser or frequently called as 
browser is an application software that 
is installed on a computer to provide 
access to the World Wide Web. It brings 
the Web pages from the servers along 
with the necessary files such as images, 
Hashes, videos etc. interprets them and 
then displays it on the serves. Example: 
internet explorer, chrome, safari etc.

2. Some popular web browsers are 
Internet Explorer, Mozilla Firefox, 
Google Chrome, Safari and Opera.
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Internet Explorer: Internet Explorer is 
a web browser that allows computer 
users to view web pages on the Internet 
users can also use Internet Explorer to 
listen to and watch streaming content, 
access online banking, make purchases 
over the Internet and much more. 
Internet Explorer was first introduced 
in August 16, 1995 by Microsoft as 
Internet Explorer 1.0. So far 11 versions 
of Internet Explorer were released. 
Internet Explorer 11. Which was 
released in 2013, is the last version of 
the web browser.
Google Chrome: Google Chrome is 
yet another popular web browser that 
was developed by Google. It was 
released on December 11, 2008. It 
allows the users to quickly access web 
pages and make local desktop 
shortcuts to open the web application 
in the browser. Google Chrome is 
extensively used by the users due to its 
stability and simplicity.

3. There are mainly two types of 
browsers- Graphical and Text.
Graphical Web Browser : Graphical 
browser like Internet Explorer, Mozilla 
Firefox, Netscape, Opera and Google 
Chrome can display text, images, audio 
and video files. They are accessible for 
operating systems such as Windows, 
Apple and Linux. You can even 
download and install a graphical 
browser on your computer.
Text Web Browser: A text web browser 
like a graphical browser, Lets you surf 
the web. However, there is one big 
difference the complete absence of a 
nice Looking interface. You hardly ever 
use the mouse to more about but rather 
employ keys like the tab and the enter 

key. opening a web site shows you only 
text. In Short 'A text web browser 
displays only the text on a web sites 
with any links. It cannot display any 
images, video or flash animations. 
Gopher is the popular text web 
browser.

4. A search engine is a software program 
available through the Internet that 
helps you to search specific 
information. Today there are 
thousands of different search engines 
available on the Internet each with 
their own abilities. These search 
engines are software on the web that 
help you to search specific 
information. The result that you get is 
a list of links that match with the 
keywords Search engines vary in the 
way they find and list the content on 
the web.
Today the most popular and well-
known search engine is Google. Other 
popular search engines include 
Ask.com, Yahoo, Rediff, AOL, and 
Baidu.

5. Bookmarks is an Internet browser 
feature that allows a user to go back to a 
previously visited website by clicking 
on the saved link- without retyping the 
site's address. It is also called favorites. 
In Internet Explorer, you can add a 
bookmark by clicking Favorites and 
then Add to Favorites. You can also 
click on Bookmarks and select Save this 
page option to save the web page. Other 
browsers are similar, but they may use 
different names for book marking.

F. 1. We should not click on the irrelevant 
links or advertisements on a web page 
while browsing. Given below the 
harmful effects of irrelevant links:
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v Hacking your website.
v Building hundreds or thousands of 

spammy links to your website.
v Copying your content and distributing 

it all over the internet.
v Pointing vulgar links to your website.
v Creating fake social profiles and 

ruining your reputation online.
2. When you use the and buttons your 

browser may use its web Back 
Forward cache to display the page. 
The web cache stores lately viewed 
web pages so that they do not need to 
be downloaded again. You can use the 
Refresh button (sometimes called 
Reload) to tell the browser to load the 
page again.

CH-8 INTRODUCTION TO E-MAIL
Exercise
A. 1. Server, 2. G mail and Yahoo, 3. E-mail,

4. Bcc, 5. Domain.
B. 1. True, 2. False, 3. True, 4. True, 5. True,

6. True, 7. True.
C. 1. (a), 2. (b),  3. (c), 4. (b), 5. (b), 6. (a).
D. 1. Email or electronic mail is a way to 

send or respective messages through 
the Internet. E-mail is very fast, usually 
taking only a few seconds to reach its 
destination.

2. v Click on the Attach option in the New 
Message box. An Insert Attachment 
dialog box appears.

v Find and select the files you want to 
attach, and then click on Attach. 
Perform this step for each file you 
want to add.

v The attached file information 
display in the New Message box.

v Click on the Send button after 
typing the e-mail address of the sent 
message is started in the Sent folder.

3. On successfully logging into an email 
account, several options such as Inbox, 
Drafts, Compose and Sent Mail are 
visible on the screen.

4. Netiquette or net etiquette refers to 
etiquette on the Internet. Good 
netquette involves respecting other 
privacy and doing anything online that 
will annoy or frustrate other people. 

5. Some of the websites that provide free 
e-mail accounts are www.gmail.com, 
www.yahoomail.com 
and www.hotmail.com
v Connect to the internet by double-

clicking the internet explorer or the 
google chrome.

v Type gmail.com in the address bar 
and go to Gmail site.

v Click on the link Create an account 
present at the bottom.

v A form will appear on the screen. 
Fill in the information that has been 
asked for like your name, date of 
birth, e-mails address you prefer or 
password. Be very careful while 
your password. Memorize it and 
keep changing the password 
periodically to maintain the 
security of password.

v There is a section in the form that 
includes security questions which 
makes it possible for you to retrieve 
the password in case you forget it. 
The question that you choose to 
answer in the form is asked by 
Google to verify your identify.

v In the next section of the form, you 
have to type the code in the box to 
security reasons.

v Finally you have to agree to the 
Terms of Service. After reading the 
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text properly click on I Agree.
v After filling the form and agreeing 

to the terms and conditions, your e-
mail account is created and you 
receive a new e-mail address and a 
password.

6. A blog is also known as weblog. It is a 
personal online diary or for can say 
journal which allows you to share 
thoughts are ideas. You can add video, 
games, pictures music. You can do all 
there things without the need of any 
programming knowledge.
v Blogging is the act of posting 

content on a blog or posting 
comments on someone else's blog.

v Blogging is very popular today 
because it allows people to 
interact with each other. Blogging 
has also become a popular search 
engine optimization tool because 
search engines like Google and 
Yahoo know that a blog is 
frequenly updated with content in 
visitor comments.

v Sometimes blogging can also be 
used as actual media that spreads 
news. There has been more than 
one occasion where a major 
newspaper decided to run only a 
small article about something that 
lots of people would consider big 
news.

v There are many different types of 
blogs like personal blogs, 
corporate and organizational 
blogs are interactive, allowing 
visitors to leave comments to a 
bloggers postings. 

F. 1. Spam filters can help, but they are not 
error-free. If you are receiving lots of 

spam from the same source, complain 
to your Internet service provider.

2. No, it consequences very bad. 
CH-9 COMPUTER VIRUSES
Exercise
A. 1. Antivirus, 2. Virus, 3. Trojans, 

4. Worm, 5. Hardware.
B. 1. False, 2. False, 3. False, 4. True, 5. False,

6. True, 7. True, 8. False.
C. 1. (b), 2. (a), 3. (b), 4. (b), 5. (a), 6. (c), 

7. (a).
D. 1. Technically, a computer virus is a type 

of ill-natured code or program written 
to after the way a computer operators 
and that is designed to spread from one 
computer to another. A virus operates 
by inserting or attaching itself to a valid 
program or a document that supports 
macros on order to carry out its code. 
In the process a virus has the potential 
to cause damaging effects. Such as 
harming the system software by 
corrupting or destroying data.

2. A computer virus carries out the 
following actions.
v It can infect the executable 

program files like Microsoft Word 
and operating system programs. 

v It can infect the file before it is 
attached to an e-mail message or 
transferred to a disk.
Thus, the virus spreads from one 
computer to another.

3. Computer viruses generally spread in 
one of the three ways:
v From removable media,
v From files downloaded from the 

Internet and
v From e-mail attachments.

4. Antivirus software is an application 
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software developed to detect and 
remove the virus from the computer 
system. Whenever the computer 
system is started antivirus starts 
automatically. It detects the virus in 
all the directories and files of 
computer system. When the virus is 
detected, it removes that virus. Some 
popular antivirus software are given 
below.
v Norton AVG † Avast † McAfee † 

Symantec
v Kaspersky (It is well-known for its 

high detection rate.) † SmartDog
5. Most viruses are developed to avoid 

detection by the computer user. But 
there are a few signs that denote the 
existence of a virus in our computer.
v The computer starts to operate 

slower than normal.
v The computer does not respond to our 

instruction and shuts down frequently.
v The computer generally restarts on 

its own.
v Applications we store in the 

computer do not work as usual.
v Some or the whole part of disk 

drives becomes difficult to access.
v Strange error messages might 

display on the screen.
v A virus-infected file will have double 

extensions like image.jpg.vbs or 
image.jpg.exe.

v Strange icons emerge on our 
desktop that are not associated with 
to any program.

6. To prevent viruses from entering our 
computer, we must update information 
about existing viruses in the antivirus 
program. We should careful while 
browsing the internet, downloading 

files or open an email attachment. By 
doing these things, we can keep our 
computer free from harmful virus 
programs. Some preventive measures 
are given.
v Obstruct access of viruses to your 

system both offline and online.
v Allow only authentic users to use 

your system.
v Keep programs and data on 

separate disks, if possible.
v Scan all the pen drives and CDs 

with the antivirus software before 
using them.

v Make sure that the latest version of 
an antivirus software is installed in 
your computer.

E. 1. It can enter the computer through an 
infected floppy, CD, pen drive or the 
internet. It can attach itself to an item in 
the computer system.
Most viruses stay active in the 
computer memory until for turn off the 
computer.
Scan all the pen drives and CDs with 
the antivirus software before using 
them.

CH-10  CYBER THREATS & SECURITY
Exercise
A. 1. Spoof, 2. Cyber Bullying, 3. Pharming,

4. Hacking, 5. Biometrics.
B. 1. False, 2. True, 3. True, 4. True, 5. True,

6. True, 7. False, 8. False, 9. False.
C. 1. (c), 2. (b), 3. (b), 4. (a), 5. 
D. 1. Computer and Internet have become an 

integral parts of our life. The fast 
growing technologies of the modern 
age have made our life much easier and 
more connected around the globe 
through interconnected networks.

Keys Computer (6-8)42



Today we are connected to the 
Internet through computer, smart 
phone or tablet. These devices are 
used for storing personal information, 
online banking, online shopping, 
bookings tickets, playing games, and 
connecting with friends over social 
media.
Although networks of today have made 
the communication process very easy 
and have provided great opportunities 
in almost all spheres, yet there are 
various kinds of challenges and threats 
related to the use of these networks of 
today. These threats are called 
Cybercrimes.

2. A Cyber crime is any unlawful activity 
done through Internet such as identity 
theft; where somebody can steal your 
e-mail Id or password and use it to send 
fake emails to people comprising false 
information about the product or 
winning a lottery etc.
Then there are credit card account 
thefts, Internet frauds such as 
purchasing goods in your name, 
fishing out mobile phone contacts etc., 
forgery i.e., parroting documents, 
currency and objects of other people 
with bad purposes harassing others 
and mischief mongering, by sending 
threatening messages, all of which 
come under the jurisdiction of Indian 
Penal Code (IPC).
Cybercrimes can be divided into three 
main groups.
v Crime against an Individual person
v Crime against property
v Crime against an organization/society

3. CYBER STALKING
In cyber stalking the person can:

v Harass and humiliate the victim by 
posting false information about 
him.

v Monitor or view a victim's online 
activities.

v Damage the victim's computer by 
sending viruses.

v Threaten the victim or his family.
v Order humiliating items or subscribe 

cheap magazines and deliver these at 
victim's house or workplace.

CYBER BULLYING
It is an act of harming or harassing 
through information technology in an 
intentional manner. This involves 
insulting remarks and threating 
messages sent by e-mails spreading 
rumors about the person either by e-
mails or social networking sites, 
posting shameful photos and videos to 
hurt the person, offensive remarks 
against gender, race, religion, or 
nationality.

4. Phishing is a form of Freud in which an 
attacker masquerades as a reputable 
entity or person in email or other 
communication channels. The user is 
asked to visit a websites in which he is 
asked to update or validate his personal 
details, like user name, password, credit 
card details, etc. In this way the operators 
of the fake websites perpetrate crimes in 
your name after stealing your identity.

5. Procuring or stealing someone's 
personal information is called Identity 
theft. It is a major issue for people who 
use Internet for online shopping, cash 
transactions, and banking services. 
The stolen information generally 
includes a person' name, date of birth, 
account number, credit/debit card 
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numb er,  ATM pin ,  e tc .  This  
information is then misused to acquire 
genuine documents, new credit cards 
to make purchase, withdraw money, 
get passports and driving licences in 
the victims name. Hackers steal the 
information either through hacking 
the network that a person is connected 
to or placing a software unknowingly 
on a person's computer.

6. A password is a sequence of characters, 
such as letters, numbers and symbols 
used as secret key for accessing a 
computer system or network. It 
guarantees that the system is accessed 
only by the authorized users. To protect 
data and important information, 
strong passwords should be used.

7. In computer terminology, backup 
refers to the process of making copies 
of data or data files to use in the event 
the original data files are lost or 
destroyed. These additional copies are 
called backups. Backups can also be 
used to restore the files that have been 
deleted accidentally or corrupted by 
the virus.

8. Firewall is a security system that 
protects your computer by preventing 
unauthorized users from acquiring 
access to it through network or 
internet. It can either be hardware or 
software or a combination of both. It is 
enacted on the gateway of a network 
and follows a particular set of rules 
defined by the user or the network 
administrator. Based on these rules, it 
checks the incoming and outgoing 
network traffic.

E. 1. ENCRYPTION SOFTWARE
While transferring data over 
networks, we may lose data privacy. 

We can protect our data from 
unauthorized access by using the 
technique called Encryption. 
Encryption is the process of 
converting information or data into a 
code, especially to prevent 
unauthorized access. Encryption 
software is used to create the 
encrypted text called 'Cipher text'. To 
read an encrypted message, it has to 
be decrypted with the same software 
on the receivers's side. This process is 
called Decryption. The software 
applications, like GnuPg can be 
applied to encrypt data files and E-
mails.

2. CYBER BULLYING
It is an act of harming or harassing 
through information technology in an 
intentional manner. This involves 
insulting remarks and threating 
messages sent by e-mails spreading 
rumors about the person either by e-
mails or social networking sites, 
posting shameful photos and videos to 
hurt the person, offensive remarks 
against gender, race, religion, or 
nationality.

MODEL TEST PAPER-1
A. 1. (c), 2. (c), 3. (a), 4. (b), 5. (b)
B. 1. Hexodecimal, 2. 0, 3. Design, Layout 

and Format tabs, 4. Timeline, 5. Layers
C. 1. True, 2. True, 3. False, 4. True, 5. True
D. 1. The number is borrowed when 1 is 

subtracted from 0 (10-1=1).
2. 2D chart : A 2D graph has two axes (X, 

Y)
3D chart : A 3D graph has 3 axes (X, Y, 
Z).

3. Select the File
v Import – Import to Stage.
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vThe Import dialog box displays. 
vBrowse and select the file that you 

want to import and click on Open.
4. X-Axis : It is the horizontal axis of a 

chart. It is also known as the category 
axis.

    Y-Axis : It is the vertical axis of a chart. 
It is also known as the category axis.

5. It is used to organise and modify the 
properties of the current selection.

5. 1. Machine Language: a computer 
programming language consisting of 
binary or hexadecimal instructions 
which a computer can respond to 
directly.

2. MS Excel Bar: The menu bar is the part 
of a browser or application window, 
typically at the top left side, that houses 
drop-down menus that allow the user 
to interact with the content or 
application in various ways.  In 
Microsoft Word, for example, the 
"File" menu provides options to open a 
file, create a new one, and save or print 
-- among others. The "Edit" menu 
allows the user to perform such 
functions as copying and pasting, 
finding and replacing text.

3. Gradient: A gradient is multicolor fill 
in which one colour gradually turns in 
another colour. Gradients a created by 
mixing of two or more colours in an 
object. You can use the colour panel to 
form your own gradients and add to 
form your own Swatches panel.

4. Rotation Handle: You can move the 
rotation handle clockwise or anticlockwise 
to rotate the gradient as needed.

5. Symbols: A Symbol is a name for any 
object created by the user and is stored 
in the library. It can be used to add to a 

movie or animation when required. 
Symbols can be graphics buttons or 
movie chips. These are very useful 
elements.

Model Test Paper-2
A. 1. (b), 2. (b), 3. (a), 4. (c), 5. (c)
B. 1. View, Grid, Show Grid 2. Two, 3. 

Sound, 4. Transparent, 5. Cascading
C. 1. False, 2. True, 3. True, 4. True, 5. False
D. 1. You can hide the layers to see the 

contents on the other layers. While 
hiding the layers, you have the option 
either to hide all the layers in your 
document at once or hide the layers 
individually.
v Click on the icon above the layers. A 

red cross symbol display Eye s in the 
Eye column. You will find that all 
the contents disappear from the 
stage.

v Click on each red cross symbol one 
by one in the column, and notice 
that the contents on the layer on the 
stage.

2. . Writing Program -Every program 
in QBASIC contains statements. 
Follow the steps given below to 
write a program in QBASIC.

v Click on the File menu.
v Select New Program option.
v Write the program.
SCREEN 2
LINE (500, 50)-(100, 100

Ÿ Running Program -To run a program 
in QBASIC follow the steps given 
below.

Ÿ v Click on Run Menu.
Ÿ v Select Start option or type Run in 

the Immediate mode of the 
window.
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3. Container Elements
The elements that consist of both ON 
and OFF tags are called Container 
Elements. 
E.g., <b> This makes the text bold </b>
Empty Elements
Empty elements include only ON tags. 
They do not have OFF tags. These 
elements do not enclose any data; 
instead they do some function on their 
own.
E.g., <br>tag (It breaks the line and 
displays the text from the next line.)

4. Writing Program -Every program in 
QBASIC contains statements. Follow 
the steps given below to write a 
program in QBASIC.
v Click on the File menu.
v Select New Program option.
v Write the program.
SCREEN 2
LINE (500, 50)-(100, 100
Running Program -To run a program 
in QBASIC follow the steps given 
below.
v Click on Run Menu.
v Select Start option or type Run in 

the Immediate mode of the 
window.

5. The concept of masking in Flash CS6 
involves using a shapes to hide or reveal 
portions of a piece of art work. It is like 
view the outside through a small 
window in your house. The window's 
size limits what you can see when you 
are inside. Masking is generally used in 
Flash to create spotlight effect that 
would display the text or object 
through a hoke.

E. 1. Attribute: In HTML an attribute is a 
characteristic of page elements, such as 

font size or color. All attributes contain 
two parts a name and a value. The 
'name' is the characteristic that you 
want to set and the 'value' is what you 
want for the specific characteristic.

2. Markup Language: A markup language 
is a computer language that uses tags to 
define elements within a document. It 
is human-readable, meaning marking 
files contain standard words, rather 
than typical programming syntax.

3. QBASIC: QBASIC is one of the versions 
of BASIC. It refers to Quick Beginners 
All purposes Symbolic Instruction 
Code.

4. Link Break Element: Link break 
element separates the line and shows 
the text on a new line. It is like an Enter 
key on a keyboard which takes the 
cursor on the next lie towards the left 
margin on the screen. Line breaks are 
good for ending lines after short pieces 
of information such as address.

5. Masking In Flash : The concept of 
masking in Flash CS6 involves using a 
shapes to hide or reveal portions of a 
piece of art work. It is like view the 
outside through a small window in 
your house. The window's size limits 
what you can see when you are inside. 
Masking is generally used in Flash to 
create spotlight effect that would 
display the text or object through a 
hoke.

Model Test Paper-3
A. 1. (a), 2. (a), 3. (c), 4. (a), 5. (a)
B. 1. Search, 2. Server, 3. Worm, 4. Hacking, 

5. Biometrics
C. 1. True, 2. True, 3. True, 4. True, 5. True
D. 1. Graphical Web Browser : Graphical 

browser like Internet Explorer, Mozilla 
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Firefox, Netscape, Opera and Google 
Chrome can display text, images, audio 
and video files. They are accessible for 
operating systems such as Windows, 
Apple and Linux. You can even 
download and install a graphical 
browser on your computer.
Text Web Browser: A text web browser 
like a graphical browser, Lets you surf 
the web. However, there is one big 
difference the complete absence of a 
nice Looking interface. You hardly ever 
use the mouse to more about but rather 
employ keys like the tab and the enter 
key. opening a web site shows you only 
text.

2. v  Click on the Attach option in the 
New Message box. An Insert 
Attachment dialog box appears.

v Find and select the files your want 
to attach, and then click on Attach. 
Perform this step for each file you 
want to add.

v The attached file information 
display in the New Message box.

v Click on the Send button after 
typing the e-mail address of the 
sent message is started in the Sent 
folder.

3. Netiquette or net etiquette refers to 
etiquette on the Internet. Good 
netquette involves respecting other 
privacy and doing anything online that 
will annoy or frustrate other people.

4. In computer terminology, backup refers 
to the process of making copies of data 
or data files to use in the event the 
original data files are lost or destroyed. 
These additional copies are called 
backups. Backups can also be used to 
restore the files that have been deleted 
accidentally or corrupted by the virus.

5. Computer viruses generally spread in 
one of the three ways:
v From removable media,
v From files downloaded from the 

Internet and
v From e-mail attachments.

E. 1. Domain:  A group of computers and 
devices on a network that are 
administered as a unit with common 
rules and procedures. Within the 
Internet, domains are defined by the IP 
address. All devices sharing a common 
part of the IP address are said to be in 
the same domain.

2. Viruses: Technically, a computer virus 
is a type of ill-natured code or program 
written to after the way a computer 
operators and that is designed to 
spread from one computer to another.

3. Links: A link is an HTML object that 
allows you to jump to a new location 
when you click or trap it. Links are 
found on almost every webpage and 
provide on the web. It can be text or an 
image.

4. Navigation Buttons: Sometimes, when 
you click on a link, you may need go 
back to the previous page. It can be 
done by using browser's Back button. 
Once you have pressed the Back 
button, you can press the Forward 
button to the follow the link again.

5. Website: A set of interconnected 
webpages, usually including a homepage, 
generally located on the same server, and 
prepared and maintained as a collection 
of information by a person, group, or 
organization.
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CH-1 CONCEPT  OF  NETWORKING
Exercises
A. 1. Network, 2. Area of Network, 3. PAN, 

4. Tree, 5. Rights
B. 1. True, 2. True, 3. True, 4. True, 5. False
C. 1. (b), 2. (a), 3. (a), 4. (b), 5. (b)
D. 1. Importance of A Network

 Networks have made communication 
cheaper and faster and also help in 
saving resources. Let us understand the 
importance of network in our daily life.
Share and Save Resources: Computers 
on a network can share resources like 
printers, modems, scanners, plotters, 
CD drive, USB ports etc. This allows to 
cost serving.
Storage Media: When a computer 
network is created, one computer acts 
as the main computer or the server. 
This Server serves or distributes the 
software or hardware that the other 
networked computers would required.
Effective Backup: You can make two 
copies of important files and save them 
on another networked computer or the 
server. If one system faces hardware 
failure, the data will not lost, which 
ultimately is the most important.
Effective Means of communication: 
A network builds a very effective 
means of communication, as it 
provides cheap and quick 
communication.
Sharing information: Information can be 
easily means of communication, as it 
provides cheap and quick 
communication.
Sharing Information: Information 
can be easily shared among the 
computers connected through a 
network.
Makes Administration Easy: The 

person can sit at one place and still 
keep an eye on all the computers being 
used.
Effective Security Measure: The security 
of a network is managed through 
passwords and user names. Also, when 
all the important files are saved at one 
place, it is easier to protect them.

2. A network is made up of different 
parts or components are given below:
Network Interface Card (NIC): It is 
an important hardware device that 
differentiates between a networked 
computer and a stand-alone computer.
Communication Media: It can be 
wired or wireless.

3. Wired Network: Electrical cables such 
as (twisted pair coaxial cable or optical 
fibre) are used to carry signals from 
one end to other.
Wireless Network: They do not require 
cables rather than signals are transmitted 
using Bluetooth, Infrared, Microwave or 
Radiowave.

4. Following are  the types of topologies:
Bus Topology: In this topology, a 
single cable, known as a backbone 
with multiple points is involved. All 
the computers, printers and other 
hardware are connected to this cable. 
Any electronic signal passed by any 
node can be received by all the nodes 
on this cable, as the signal can travel 
in both directions. The cable has 
terminators at its end so that the 
signals can be absorbed by them. 
They do not clutter the network line.
Star Topology: In this topology, all 
the computers are connected to a 
central hub/switch. All the computers 
are connected separately with 
individual wires to the central hub.

Computer-8
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Ring Topology (Circular Topology): 
This topology uses multiple links to 
form a loop of computers. Each 
computer is connected to the loop, 
thus forming a kind of a ring or a 
circle. A message or a token goes 
round the loop continuously. All the 
computers or the nodes are equipped 
with a Token Ring Adapter Card 
(TRAC), which helps them to read 
the token or the message that passes 
through the loop continuously.

Tree Topology: Tree topology is the 
combination of Bus topology and the 
Star topology. This type of network 
arrangement, can have multiple 
servers. This topology is used when 
there are a large number of computers 
to be connected and there are distinct 
branches of an organization that need 
to be connected. It needs a lot of 
cables to be used and the success of 
the Tree topology depends largely on 
the cables installed.

5.Security of  Networks
When you installed a network, you 
enable a number of people to access and 
share important data stored in the 
computers on the network. For this 
purpose, the network requires to be 
secured. There are usually two ways in 
which a network can be secured. let us 
understand about both of these in a 
detail.
Login Security: Applying this security 
measure, all the users who want to 
access the data are provided unique 
user names and passwords. Only those 
people who have a username and a 
password can access the data.
Rights Security: Rights security is a 
step forward to login security. 
Applying this security measure, 
restricted access rights can be 

provided to users. Depending on the 
username, the access rights are 
restricted to particular folders, where 
the user can access only particular 
folders pertaining to his/her own 
work.

E. 1.Rahul use  a local area Network is a type 
of network that is used to connect 
personal computers in a room, building 
or campus. A  LAN is used broadly in 
offices as it allows its users to use 
resources such as printers, scanners, 
plotters, speakers, etc. on a common 
basis.

2. Mohit will use the PAN (Personal 
Area Networks). This may 
incorporate bluetooth enabled devices 
or infra-red enabled devices. PAN has 
connectivity range up to 10 meters. 
PAN may comprise wireless computer 
keyboard and mouse, bluetooth 
enabled headphones, wireless printers 
and TV remote.

My Activity
a. SERVER, b. CONNECTOR, c. 
TOPOLOGY, d. CIRCULAR, e. LOGIN

CH-2 LOG  ON  TO  MS ACCESS
Exercises
A. 1. MS Access, 2. Management, 3. Navigation, 

4. Alpha  Numeric, 5. Primary key
B. 1. True, 2. False, 3. False, 4. True, 5. True
C. 1.(a), 2.(c), 3. (c), 4. (b), 5. (b)
D. 1. (c), 2.(d), 3.(a), 4. (e), 5. (b)
E. 1.Components of Microsoft Access 

Window 
Title Bar
It shows the name of currently opened 
database.
File Tab
It displays the backstage view of file 
commands, like New and Open.
Quick Access Toolbar
It shows quick access buttons to the 
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Save, Undo and Redo commands.
Ribbon
It displays groups of related 
commands in tabs. Each tab provides 
shortcut button to common tasks.
Database Object
An Access database has four main objects– 
Tables, Queries, Forms and Reports. These 
objects are displayed in the Navigation 
Pane.
Navigation Pane
It contains all available database objects.
Status Bar
It displays information about the 
current object or view.
Work Area
It differs according to database element 
selected.

2.A database is a collection of information 
that is organized so that it can be easily 
accessed managed and updated. For 
example, you must have a telephone 
directory in which you maintain all the 
contact details of your friends. The 
contact details would include the 
telephone numbers, addresses and the 
email addresses of your friends. This 
telephone directory can be called your 
database.
Advantages of Using Database
The main advantages of using database 
are as follows:
Minimum data redundancy: Database 
system stores data at one place in the 
database. The data is integrated into a 
single, logical structure. Different 
applications refer to the data from the 
centrally controlled location. The central 
storage of the data reduces data 
redundancy.
Minimum data inconsistency: It also 
helps us to minimize data inconsistency. 
Updating of data values is simple and 
there is no disagreement in the stored 

values. For example, students home 
address is stored at a single location and 
gets updated centrally.
Improvement in data sharing: Data 
sharing refers to sharing the same data 
among more than one user. Each user 
has access to the same data, though they 
may use it for different purposes. The 
database is develop to support shared 
data. Authorised users are allowed to 
use the data from the database.
Improvement in data integrity: The 
database you have created is very 
important for you and it needs 
protection. The database is kept 
secured by limiting access to the 
database by authorised user.
Standardisation of data: Since the data 
is stored centrally, it is easy to enforce 
standards on the database. Standards 
could include naming conventions and 
standard for updating, accessing and 
protecting data.

3. A blank database comprises only a 
single blank table. After creating a 
blank database, you can add tables, 
forms, reports and other objects to it.
To create a blank database, follow the 
steps given below:
v Select Blank database option in the 

File tab.
v Type a name for the database in the 

File Name box.
v Click on Create.

4. To create a new table in Design View, 
follow the steps are given below:
vOpen the database and click on Create 

tab on the Ribbon.
vThe Table Tools tab will displays on 

the top of Title bar, Select Design tab.
v In the Field Name column, enter the 

name of the first field for example 
Employee _ID.

v Press the Tab key to move the 
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insertion point to the Data Type 
field.

vTo alter the data type, click on the 
drop-down arrow and modify the 
data type as per your choice.

v Press the Tab key to bring the 
insertion point to the Description 
column. Enter your text as the 
description in Description column.

v Press the Tab key again to move to the 
Field Name column in the second 
row and enter the text in the column.

vYou will notice the word 'Text' 
currently appeared in that field.

v Press Tab key to move the insertion 
point to Data type column.

v Press the Tab key to move the 
insertion point to Description 
column. Enter the text for the 
column.

vRepeat the steps to make the rest 
entries. The table is now complete.

5.To add records to a table, follow the steps 
given below:
vDouble-click on table Personal detail 

in the Database window.
vType the ID Number in the first 

Employee_ID field.
v Press the Tab key to complete other 

entries for the Employee_ID 1001. 
Type the following entries pressing 
the Tab key after each one to 
complete the record.

vAfter entering the last entry, contact 
number, press the Tab key. The 
insertion point comes to the ID field 
in the second row.

v Enter the remaining records follow 
the same steps as you used to add the 
first recording.

vWhen you complete entering data, 
click on Save button to save the 
changes. MS Access saves the table 
and you can see the name of the table 

in the Navigation table.
6.Understanding Field Properties

Each field has a set of properties that 
signifies and controls it. These 
properties contain basics like its size 
and format, as well as rules for entries 
in it.
Properties Pane
When a field is selected in Design View, 
its properties displays in the lower pane.
General Tab
The General Tab comprises most of the 
properties you will work with.
Lookup Tab
The Lookup Tab is mainly used for 
setting up lookup lists.
Drop-down Lists
Some properties have drop-down lists. 
Click the arrow to open the drop-down 
lists.
Property Information
When the insertion point is in 
property's box, information about that 
property displays here.
Yes/No Properties
Some properties illustrate yes/no 
questions, these are typically already 
filled in for you with default values.
Setting Field Size Properties
The default field size for a field with a 
data type of text is 255 characters. You 
can modify this size in the range of 0-
255 characters.

7. Data Type: Each field has a data type  
that specifies what you can store in it. 
Data entry is limited to valid entries for 
the type you select, which helps prevent 
data entry errors. For example, you 
cannot enter letters in a field set to 
Number, and you must enter valid 
dates or times in a Date/Time field.
Text: It enables to enter alpha-
mumeric characters. It has a limit of 
255 characters and it cannot be used 
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for numeric calculations. For eg. 
telephone numbers and ZIP codes.
Memo: It has a limit of 63,999 
characters are used for detailed, 
descriptive fields.

E. 1. Anmol is using a Data sheet view to add 
a table. 
v Click on the Create tab on the 

Ribbon.
v Click on the Table option. MS Access 

will open a new table in Datasheet 
View.

v Double-click the column header to 
create a field name. Type a name for 
the field.

v Press Enter key from the keyboard.
v Click on the next column. The Data 

Type menu will display.
v Select the data type for the field, 

example select Text, if you want to 
add the Name to the field.

v Type a name for the field.
v Click inside the first field of the first 

row and type the data to enter the 
first records.

v Press Tab key.
v Type the next field's data.
When you reach the last field. You can 
press Enter to start a new record.

2. Mansi used Access to write the 
description for the field of the table by 
press. Press the Tab key to bring the 
insertion point to the Description 
column. Enter your text as the 
description in Description column.

CH-3 MORE FEATURES OF MS ACCESS
Exercises
A. 1. Look, 2. Datasheet, 3. Foreign key, 4. 

Form Wizard, 5. Toggle Filter
B. 1. True, 2. True, 3. True, 4. False, 5. False
C. 1. (a), 2. (c), 3.(b), 4. (b), 5. (c)
D. 1. Find and Replace commands are also 

useful in MS Access when you have to 
find and replace something in a large 

database. Find enables you to quickly 
search tables, queries and form quickly 
for specified database task. Select a field 
to search through all records in the 
current field only.

2. To crate an AND criteria statement, 
follow the steps given below:

   v Click on the Emp_Name field, click 
on the Name list arrow and select the 
name Rakesh Arora of Employee 
from the list.

v Click on the Toggle Filter option MS 
Access uses the filter and shows only 
those records whose Designation 
field equals "Graphic Designer" AND 
whose Name field equals "Rakesh 
Arora". Only one record meets the 
filter criteria.

3. In MS Access, we can sort records in a 
specific order, ascending or descending.

    You can change the order of records in a 
table. This can enable you find, 
categories and analyze data.

 To sort the records, follow the Steps 
given below.
v Open the table where you want to 

sort records.
v Click on the column header for the 

field that to be sorted.
v Click on the Home tab on the 

Ribbon.
v Click on either of the Sort options.
v Click on Ascending to sort the 

records in ascending order.
v Click on Descending to sort the 

records in descending order.
4. To filter data using Filter by Form, 

follow the steps given below:
v Open the table if it is not already 

open.
v Click on Home tab on Ribbon.
v Click on Advanced option drop-

down arrow located in Sort & Filter 
group.
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v Click on Filter By Form.
v In the Filter by Form window.
v Select the field and value that to be 

used as criteria.
v Select Department field. Click on 

the Department drop-down arrow.
v Select "Sales" from the list. This will 

contain only records whose 
department comprises "Sales".

5. To add a new field, follow the steps 
given below.
v Right- click the name of the field 

that you want to be displayed after 
the new field. A menu will emerge.

v Click on Insert Field. A new field 
displays in the table. MS Access will 
assign a name to the new field as 
Field 1. Now, you can rename the 
field name and add information to it.

You can remove a field that is not 
required in a table.
To delete a field in the table, follow the 
steps given below:
v Right-click on the field that to be 

removed. A menu will display.
v Click on Delete Field. A prompt box 

displays.
v MS Access removes the field and 

record content for the field from the 
table.

6. Switch to Design View
  To use Design View, follow the steps 

given below:
    vClick on the Home tab on the 

Ribbon.
v Click on the View option drop-down 

arrow.
v Click on the Design View.
v MS Access will show the design of the 

table and display the field properties.
Switch to Datasheet View
To switch to Datasheet view, follow the 
steps given below:
v Click on the Home tab on the 

Ribbon.
v Click on the View option drop-down 

arrow.
v Click on the Datasheet View. MS 

Access shows the default Datasheet 
view of the table.

E. 1. Filtering data by form allows you to 
filter by multiple fields and define 
criteria for as many fields as you like. 
When you filter by form, you can 
merge the criteria using AND, OR or a 
amalgamation of the two. An AND 
combination finds records where both 
criteria are met; OR combination finds 
records where at least one criterion is 
met.

2.  Switch to Design View
     To use Design View, follow the steps give 

below:
v Click on the Home tab on the Ribbon.
v Click on the View option drop-down 

arrow.
v Click on the Design View.
vMS Access will show the design of the 

table and display the field properties.
CH-4             WORKING WITH

      QUERIES/FORMS/REPORTS
Exercises
A. 1. Query, 2. Criteria, 3. Sort, 4. Form, 
5. Report
B. 1. True, 2. True, 3. True, 4. True, 5. True, 6. 

True, 7. False, 8. True
C. 1. (b), 2.(c), 3.(c), 4.(b), 5.(a)
D. 1. A Query is a simple question that you 

ask to find a particular information from 
the database. Similarly in Access, when 
you create a query, you are defining 
particular search conditions. You can 
queries to view, change, summerize and 
analyses the particular data in different 
ways. 
2. Criteria: It includes the condition on 
the basis of which the records will be 
filtered in the Query output. We identify 
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criteria in the Criteria row of the design 
grid. Define the criteria value in the 
Criteria row and the data will be filtered 
accordingly in the query output.

The Simple Query Wizard screen displays as 
shown in the figure. Select the table that 
includes the data in the Tables/Queries 
list box.

Now, add the fields that you want to have in 
the query result.
4. A form is a piece of paper, on which a 
user fills the desired information in the 
particular fields. Similarly, in Microsoft 
Access 2016, Forms perform quite 
similar to it. Forms enable you to add and 
update data in one record at a time in a 
table. Although Access provides a 
Datasheet View, which is a suitable way of 
entering data, but it is not a convenient 
tool for every data entry situation.

To format a form using design tab, follow the 
steps given below:
v Click on Logo in the Header/Footer 
group. The Insert-Picture dialog box 
display. Select any picture and click OK.
v Click on Title  in the Header/Footer 
group.  Enter “Students Query as the 
Title for the Form.  
v Click on Date and time in the 
Header/Footer group. The Date and 
Time dialog box will display. Choose the 
required format of the Date and Time 
and click OK.
v Click on Themes in the Themes group. 
Click on the desired theme from the 
drop-down menu.

5. Exporting A Report
  v Click on the drop-down arrow of the 

View button on the Home tab and select 
Print Preview from the drop-down list of 
options.
v The report will be opened in the Print 
Preview layout and the ribbon will show 

the commands associated with the Print 
Preview layout.
v On the Data group, click on the drop-
down arrow of the More button and select 
Word.
v The Export-RTF File dialog box will 
display on the screen. Select the location 
where you want to save the report and 
give a suitable name to the report.
v Click OK.
v A final screen will display on the 
screen informing you about the 
successful completion of the exporting 
process.
v Click on the Close button.
v Find the word file where the report has 
been exported and open it.

E. 1. Madhu open the table that contain the 
information about percentage. 
v Click on the Database Tools tab. Select 
the Relationships button from the 
Relationships group.
v The Show table dialog box emerges, 
select the desired table and click on the 
Add button. The selected table will 
display in the object Relationships 
window. Similarly, add another table to 
the Relationships window.
v You can start the 'Queries' tab if your 
relationships are based on queries, or 
Start ' Both' tab if relationships are based 
on both-Tables and Queries.
Click on the Close button to close the 
Show Table dialog box.
v Move the Primary key of the parent 
table (e.g., Students Table) and drop it 
over the same field in the child table (e.g., 
Marks Table). In our example, Roll No is 
the primary key.
v The Edit Relationships dialog box 
displays.
v Click on the Create button. Access 
creates the relationship between the 
tables.
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A line linking the two tables will 
appear denoting that both have been 
linked on the basis of the linked field.
v Click on the Save button on the Quick 
Access Toolbar to save the relationship 
and then close the Relationships window 
by clicking on the Close button on the 
Relationships group.
2. To make a form, select a table or query 
in the Navigation Pane that you want to 
use as the data source for the form.
v Click on the Create tab on the Ribbon. 
Select the Form option in the Forms 
group.
v A new form is created and opens in the 
Layout view, in which you can modify the 
look of form. You will observe that three 
new tabs: Design, Arrange and Format 
display on the Ribbon.
v If you want to modify or enter data in 
the form, click on the Home tab> View 
button> Form View.
v Use the Record Navigation Bar to 
move through the records in the form.
v After completing the data entry, save 
your work by clicking on the Save option 
in Quick Access Toolbar or the Save 
option in the File tab. You will notice that 
the Form object gets added in the 
Navigation Pane.

CH-5 USING LISTS AND TABLES 
           IN HTML 5
Exercise
A. 1. List, 2. Unordered, 3. Border-spacing, 4. 

Reversed, 5. Description
B. 1. False, 2. True, 3. True, 4. False, 5. True
C. 1. (a), 2. (b), 3.(a), 4. (b), 5. (c)
D. 1.An unordered list is applied when the 

items are not to be displayed in any 
specific sequence. The list starts end 
with <ul and </ul> tags respectively. It 
indents each item in the list and 
incorporates a bullet against each of 
them. 

v The ordered list is used to show the list 
of items in a particular order. The list 
starts and ends with <ol> and </ol> tags 
respectively. Ordered lists are generally 
used in situations where order of the 
items is important or where it is needed 
to keep a count of the number of items.

2. HTML supports different elements to 
creates a list for displaying items in 
particular order. A list can be specified 
in different styles. The types of list that 
HTML provides are:
Unordered List, Ordered List, Description 
List
1. Unordered List: An unordered list is 

applied when the items are not to be 
displayed in any specific sequence. 
The list starts and end with <ul> and 
</ul> tag respectively.

2. Ordered List: The or ordered list is 
used to show the list of items in a 
particular order. An ordered list 
incises and gives a number to each 
item in the list that is why it is also 
called the Numbered list.

3. Description List: A description list 
comprises a term followed by its 
definition. It is used to present a 
glossary, list of terms or other 
name/value list. It begins and end 
with <dl> and </dl> tag respectively.

3. Tables are very popular on the web 
since they are flexible and an effective 
way of presenting information in the 
form of rows and columns.

To make a tables in HTML, <table> tag 
is applied. Each table starts with a 
<table> tag and ends with </table> tag.

Each row in table starts with the <tr> 
table row tag and optionally end with 
the </tr> tag. Rows must be placed 
inside the <table> tag. The columns 
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consists of cells, each of which starts 
with the <td> table data tag and ends 
with </td>tag. <td>tag must always be 
present inside the row tags <tr>. To 
define a column heading, we apply the 
<th> tag that also ends with </th> tag. 
It creates the text bold. The <caption> 
tag is applied to define the title for the 
table.

4. (a) List-Style-Image:
You can define an image as the list 
item marker with this property.

      SYNTAX : list-style=image:value
       where value = url (“path of the 

image")|none
  (b) List-style: This is the shorthand 

feature wherein all the list features 
can be defined in one declaration.

   SYNTAX : list-style:value
        Where value = value for list-style-

type value for list-style-position 
value for list-style-image.

(c) Empt-cells: This property allows in 
defining whether or not the border 
and background are to be put 
around empty cells in a table.

  SYNTAX : empty-cells:value
       where value = show (default)| 

                      hide
E. 1. With this property one can define 

whether the table borders are to be 
collapsed into a single border or 
detached (as usual).

SYNTAX: border-collapse:value
 Where value = separate |collapse

Example: border-collapse:collapse
2. Monika should use the list-style image 

property. In this property. She can 
define an image as the list item maker.

SYNTAX : list-style-image:value
Where value = url ("path of the 

image") |none

CH-6 IMAGE  LINKS & FRAMES 
          IN  HTML5
Exercises
A. 1. <img>, 2. ALT, 3. Hyperlinking, 4. 

internal, 5. Frames, 6. border-style
B. 1. True, 2. False, 3. False, 4. True, 5. True, 

6. True
C. 1. (a), 2. (b), 3. (c), 4. (c), 5. (b), 6. (c)
D. 1. The <img> tag is applied to add images 

in an HTML web page. It is an empty tag 
and needs different features to be 
defined with it. These features for the 
<img> tag indicates the browser how to 
layout the page so that text can flow 
appropriately around the image.
Attributes of an image elements:
Defining the Source of an Image
To add and specify the source of an 
image on a web page, the src feature is 
used. 
SYNTAX: <img src = "Address or path 
of the image file"
While defining the image file, one 
should be well aware of its location i.e., 
where the file stays.
The HEIGHT feature defines height (in 
pixels) for an image either in the form of 
an integer or a percentage value.  

The WIDTH feature defines width (in 
pixel) for an image either in the form of 
an integer or a percentage value.
To align an image to the right or left of a 
text, use the CSS property-float
Example: <p> <img src = "imag1.jpg" 
style=float:right;width:50px,heights50px>
Image will display to the right of the 
text. </p>.

2.Many a times a browser on the user's 
computer does not show images due to 
some reasons (may be because of slow 
connection or error in the src attribute). 
In that case, you can display the text to 
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give a description about the ALT 
attribute allows you define the text as an 
alternate to the image. The only 
purpose of ALT feature is to give a 
description of the contents of an image 
file. It is usually applied when the user is 
having a text-based browser on his 
computer like Lynx. It also proves to be 
beneficial when the user is a blind surfer 
for whom the browser is programmed 
to read aloud the alternate text rather 
than displaying the image. In situations, 
people have the image display disabled 
on their browsers or use settings that do 
not support automatic loading of 
images. In such situations ALT feature is 
applied.

3. A websites comprises a number of 
web pages that provide you access to 
related information. HTML gives a 
powerful feature of linking these web 
pages together. This feature is called 
Hyperlinking. Applying these 
hyperlinks, one can open any linked 
web page on the Internet instantly. 
When you place the mouse pointer 
over a link, it will turn into a little 
hand.
Types of Linking
1.)InternalLinking  2.)External Linking
1.)Internal Linking: When one part of 
a web page is linked to another part on 
the same page, it is called internal 
linking.
2.)External linking: When one page is 
linked to another web page or website, it 
is called external linking.

4. Inserting Audio: HTML 5 specifies a 
new tag-<audio> tag that defines a 
standard way to place an audio file in a 
web page. It can be used for any file 
format like mp3, ogg, wav etc.
<html>
<head>

<title>Adding Audio Clip</title>
<style type = "text/css">
body {background-color:RGB(255,251,214)}
</styles>
</head>
<body>
<h3 style = color:blue> we can't help 
everyone, can help someone.</h3>
<audio controls
Src = "C:\Users\UserDesktop\Kalimba.mp3">
Your browser does not support the 
audio tag.
</audio> </body>
</html>

          Place Video:
We can place video files in our HTML 
pages with the help of Video tag. 
Supported file formats include: .mp4, 
.webm, .ogg.  The <video>tag are given 
below.
<html>
<head>
<title>Video</title>
<body>
<h1> A Video Clip</h1>
<video controls src =
 "C:\Users\USer\Desktop\video1.mp4"
Width = "720" height = "540" autoplay>
Your browser does not support the 
video tag.
</video>
</body>
</html>

5.Frames are a way of organizing your 
website. They allow the user to divide a 
page into number of rectangular 
segments for various purposes.
Frames enable multiple HTML 
documents to be presented as 
independent window within one 
browser window. This gives greater 
flexibility to design and maintain your 
site than simply dumping everything 
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onto one page. Frames make your site 
interesting as you can incorporate the 
site theme (image, logo, banners, etc.). 
The navigation menu in frames is not 
to be downloaded each time when you 
visit a new page, only you have to 
change the contents of the page.

E. 1. Rekha will use ALT attribute on the 
image element. The ALT attribute value 
should be less than 100 character and 
should be as concise as possible.
Images that convey information: 
Images that convey information should 
not be defined as background images 
useless a text equivalent is provided in 
HTML code that can be seen in 
Windows High Contrast mode.
Active Images: If the image identifies a 
specific state, the alt text should also 
describe the state.
Large Images: Large images include 
charts, graphs, diagrams and even some 
photos. To make these images 
accessible provide a short all-text on the 
image and have information also 
presented in an alternative formal such 
as-table, list or text so that non-visula 
users can get the same information.

2. Rohit will use these given tags to link an 
image.
<html>
<head>
<title> Adding Image link </title>
</head>
<body>
<img src = “ Typres of computer. jpg">
</body>
</html>
To placing video clip, Rohit will take 
following steps.
<html>
<head>
<title>video</itle>

<body>
<h1> A video clip </h1>
<video controls src =
 "C:\User\Desktop\Video1.mp4."
Width = "720" height = "540" auto play>
</video>
</body>
</html>

CH-7 INTRODUCTION TO VISUAL BASIC
Exercises
A. 1. Instruction, 2. BASIC, 3. Top, 4. Caption, 

5. flat
B. 1. True, 2. True, 3. True, 4. True, 5. False
C. 1. (b), 2. (b), 3.(b) 4. (c), 5. (a)
D. 1. (b), 2. (d), 3.(e), 4.(c), 5.(a)
E. 1. Visual basic different from the BASIC 

in many ways. Visual Basic (VB) is an 
object- oriented language. In BASIC, 
programming is performed in a text-
only environment however in Visual 
Basic, programming is performed in a 
graphical environment. So, Visual 
Basic provides GUI (Graphical User 
Interface) features. In BASIC, if you 
have to write program code for 
graphical object, you need to define its 
position and other features by writing 
statements. However, in Visual Basic 
you just require to drag and drop any 
graphical object anywhere on the form 
and you can change its properties by 
using the Properties window.

2. Properties: Properties specify the 
name of the form or an object. The 
common properties of the form are 
given below.
Name: It defines the name of the form 
by which it is referred to in the code. 
The default name of the form is Form1.
Caption: It provides the title of the 
form.
Appearance: It can have different 
values. The values 0 creates the form 
look flat, while the value 1 creates the 
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form look three-dimensional.
Font: It is used to define the font type, 
font style and font size for the text.
Font Color: This property sets the colour 
of the form.
BackColor: This property sets background 
colour of the form.

Enabled: It can have True or False value. 
The value True allows the form respond 
to mouse and keyboard events, while 
the value False allows it unable to 
respond.

Visible: It can also have True or False 
value. The value True causes the form 
visible, while the value false causes it 
invisible.
Methods
Methods are the actions performed on 
the form or objects. The common 
methods of the form are given below.
Show: This method causes the form 
visible. It is the same as setting a form's 
visible property to True.
Hide: It makes the form invisible.
Print: It shows text string on the form.
Events:
 An event is a message sent by an object 
denoting that something has occurred. 
The common events of the form are 
given below.
Form-Click: When the user clicks on 
the form, Form-click event is triggered.
Form-Load: When the form is loaded, 
Form-load event is triggered.

3. In Visual Basic, an application is created 
in the following three steps:
v Design the interface
v Set properties of the controls(Objects)
vWrite the event procedures

4. The command button is applied to carry 
out commands. When the user clicks on 
the command button, it displays an 
illusion that the button is pressed. Some 

important properties related to command 
button are given below.

Appearance: It can be 3D or flat in 
appearance.

Caption: It is the text displayed on the 
command button.

Visible: It can have the value True or 
False depending upon whether it is 
visible or not.

Enables: It can have the value True or 
False depending upon whether it 
responds to an event or not.
An event related to the command 
button is Clicked, which is triggered 
when it is selected by clicking on it.

5. To start Visual Basic, follow the steps 
given below.
v Click on the Start button.
v Select All Programs option from 

the Start menu.
v Click on the Microsoft Visual Studio 

6.0 option.
v Select Standard. EXE option from 

the New tab of New Project window 
and click on the OK button.

v Microsoft Visual Basic Window 
will display on the screen.

E. Tarun should be used Microsoft Excel 
because Microsoft Excel useful in computing 
and managing grades. It has features like, 
calculate the total, percentage and grade etc.

CH-8  INTRODUCTION TO JAVA
Exercises
A. 1. access, 2. Arithmetic, 3. Benefits, 4. 

Standard, 5. Java, 6. Objects, procedures, 
7. Compiled, 8. Data, 9. Encapsulation

B. 1. False, 2. True,3. False, 4. True, 5. True
C. 1.(a), 2.(c), 3. (b), 4. (c), 5. (b)
D. 1.(a), 2. (e), 3. (d), 4. (c), 5. (b)
E. 1. Java is a programming language that 

produces software for multiple 
platforms.
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The basic features of Java are listed 
below.
v Java is strongly type programming 

language. For example, the types of 
used variables must be pre-defined 
and conversion to other objects is 
relatively strict.

v Java is an object-oriented language 
providing features such as 
inheritance, polymorphism and 
abstraction.

v Java programs can access data both 
from local machines and the web.

v Java can be used to develop 
distributed applications across the 
networks and the Internet.

v Data in Java is specified as objects 
and procedures.

v Java programs can be carried out on 
any platform that have Java-enabled 
Internet browser.

2. Object means a real word entity such as 
pen, chair, table etc. Object-oriented 
programming is a methodology to design 
a program using classes and objects. In 
object-oriented programming, a problem 
is viewed not as sequence of steps to be 
done but as a collection of different units 
(called objects) that model the real world 
things.
Let's know about the basic terminology 
used in object-oriented programming 
(OOP).
Object: The fundamental idea behind 
OOP is to store the data and functions 
operating on-that data into a single 
unit called an object. An object may 
represent a person, a student, an 
employee, an account, an examination 
or any item that closely resembles the 
objects of real world.
Class: A class is a collection of similar 
objects. For example, different kinds of 
fish come under the category of class.

Encapsulation: Binding (or wrapping) 
code and data together into a single unit 
is known as encapsulation. For 
example, capsule. It is wrapped with 
different medicines.
Data Hiding: Data hiding is the 
important feature of objects, by which 
data are not made accessible for other 
functions outside the objects.
Data Abstraction: In java, hiding 
internal details and showing functionality 
is know as abstraction. Classes use this 
concept and represent essential properties 
of the objects.
Inheritance: When an object of one 
class (base class) can inherit the 
properties of another class (derived 
class) by a process called inheritance. 
For example, petrol vehicle is a class 
that inherits the properties of another 
class, vehicle.
Polymorphism: When one task is 
performed by different way i.e known 
as polymorphism. For example, to 
convince the customer differently to 
draw something e.g shape or rectangle 
etc.
Reusability of the code is the major benefit 
of  object-oriented programming.

3. In order to develop applications on Java, 
we first need to install Java Development 
Kit (JDK ver. 1.5 or 1.6) in our computer. 
Then, we follow the three-step procedure 
to develop applications.
v Enter the program in Notepad.
v Compile the program with Java 

Compiler (javac).
v Run the program in Java.
Entering the Java Program
Java program is entered into the 
computer using a text editor such as 
Notepad. To enter the program using 
Notepad, follow the steps given below.
v Click Start à All programs à 
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Accessories à Notepad menu options 
to load Notepad.

v Type the program in the New 
Document.

v Choose File  Save menu option in 
the Notepad to save the program.

v Click All Files option in the Save As 
type box of the Save As dialog box 
and type the name of the file with 
extension name java in File name 
box.

v Then, click on the Save button.
Compiling the Java Program
Java program is compiled at the DOS 

prompt. So, you need to go to the 
Command prompt in order to compile 
your program. Now, to compile the Java 
program, follow the steps given below.
v Click Start All Programs Accessories 

Command Prompt menu options for 
accessing the DOS prompt.

v In DOS prompt, change to that 
directory (folder) where your 
program is saved by typing the DOS 
command, cd <folder name>.

v To compile the program, type Java < 
file name with extension>. The 
program will be compiled.

Running the Java Program
In order to run the compiled Java 
program, type the command, java < file 
name without extension>. The program 
will run and you will get the output.

4. It refers to the type of data that can be 
used in a program. There are two kinds of 
data types in Java-Standard and Derived. 
Standard data types are built into the Java 
language, which includes the following 
data types.
v Byte: 8 bit byte-length integer data 

type with range - 128 to 128 (signed) 
and 0 to 255 (unsigned)

v Short: 16 bit short integer data type 
15 15-1with range - 2  to 2

v Int: 32 bit integer data type with range  
31 31-1- 2  to 2

v Long: 64 bit long integer data type 
63 63-1with range - 2  to 2

v Float: 32 bit single precision floating 
39point data type with range up o 10

v Double: 64 bit double-precision 
floating point data type with range 

317up to 10
v Char: 16 bit single-character data 

type.
v Boolean : 1 bit Boolean data type with 

True/False value
Derived data types are based on 
standard data types. For example, a 
string which is based on char data 
type. Can store alphabets, digits and 
other characters including space.

5. Operators are the symbols such as 
+,*,++,––,etc. used for different 
purposes in a program code. There are 
many types of operators used in Java. 
Following are the common types of 
operators given below.
v Relational Operators
v Arithmetic Operators
v Increment and Decrement Operators
v Logical Operators
Relational Operators
Relational operators are used to 
compare the values of two variables. 
Following are the operators which they 
include.
v > : Is used to find whether the first 

number is greater than the second, 
for example num1 > num2

v < : Is used to find whether two 
numbers are equal, for example, 
num1 < num 2

v = = : Is used to find whether two 
numbers are equal, for example, 
num = = num 2

v ! =: Is used to find whether two 
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numbers are not equal, for example, 
num 1! = num2

v >= : Is used to find whether the first 
number is greater than or equal to 
the second, for example, num1> = 
num2

v <= : Is used to find whether the first 
number is less than or equal to the 
second, for example, num 1 < = 
num 2

Arithmetic Operators
Arithmetic operators are used for 
various arithmetic calculations. They 
include the following operators.
v + : Is used to add two numbers, for 

example, num 1+ num2
v – : Is used to subtract two numbers, 

for example, num 1 – num 2
v * : Is used to multiply two numbers, 

for example, num 1 * num 2
v / : Is used to divide two numbers, for 

example, num1/num2
v % : Is used to calculate the 

remainder on dividing two 
numbers, for example, num 1% 
num 2

Increment and Decrement Operators
Increment operator + + is used to add 1 to 
the value of a variable, while decrement 
operator - - is used to subtract 1 from the 
value of a variable. For example, num ++ 
will add 1 to the value of a variable num 
and num --will subtract 1 from the value 
of a variable num.
Increment and decrement operators + 
+ and - - can also be placed before the 
name of variables (such as + + num and 
- - num), but they may give different 
outputs depending upon the logic of a 
program.
Logical Operators
Logical operators are used to find 
whether one or both the conditions are 

true or false. Following are the operators 
which they include.
v &&: Is used to find whether both the 

conditions are true, for example, 
num 1 && num 2

v !! : Is used to find whether one of the 
two conditions is true, for example, 
num 1 !! num 2

v !: Is used to find whether the 
condition is false, for example, !num

6. (a) Main () method: It is the method 
that is always executed first.
Print ln() method: It shows the 
output on the screen.

          (b)System Class : It contains all that are 
methods that are required to run a 
java program .It  provides a 
standard interface to common 
system resources

(c)Out Object: It represents the 
standard output device.

7. For loop statement: It contains the 
statements that are repeated based on 
the increment or decrement condition 
as illustrated in the following example.
for (i=0, i<=5; i + +)
{

System.out.printIn(i);
}
The above code will display the 
numbers from 1 to 5.
The syntax of for loop statement is as 
follows.
for (intial-value; termination-condition; 
increment/decrement value)
v While loop statement: It contains 

the statements that are repeated until 
the conditional expression is true as 
illustrated in the following example.
while (1 < = 5)
{

System.out.printIn(i);
i + +
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}
The above code will also display the 
numbers from 1 to 5. The syntax of 
while loop statement is as follows.
while (condition)

{
statements

}
8. Gross salary is the final salary 

computed after the additions of DA, 
HRA and other allowances. The 
formula for DA and HRA is:
# inculdue <studio.h>
int main ()
{
float basic. gross. da, hra;
/* Input basic salary of employee */
printf (*Enter basic salary of an 
employee:");
scanf ("%", & basic);
/* calculate D.A and H.R.A according 
to specified conditions */
if (basic < = 10000)
{

da = basic * 0.8;
hra = basic * 0.2;

}
else if (basic < = 20000)

{
da = basic * 0.9;
hra = basic * 0.25;

}
else
{

da = basic * 0.95;
hra = basic * 0.3;

}
/* calculate gross salary */
gross = basic + hra + da;
prinf ("Gross salary of employee = % 
2fgoss return O;
}

E. Ananya should use the Java in preparing 
result of her class
{
public static void main(String arg [ ]) 
{
int marks = 50; 
if (marks >= 30); 
System.out.println ("Your marks 
are"+marks+ "and you are passed"); else 
System.out.println ("Your marks 
are"+marks+"and you are failed"); }

CH-9 WINDOWS INSTALLATION AND
            TROUBLESHOOTING
Exercises
A. 1. Drivers, 2. User Support, 3. Trouble 

Shooting, 4. System, 5. Dick Partitioning
B. 1. True, 2.True, 3. False, 4. True, 5. True
C. 1(b), 2. (a), 3. (a), 4. (b), 5. (b)
D. 1. Troubleshooting refers to problem solving, 

which is often applied to repairing 
products, processes or systems. In 
computer terminology, troubleshooting 
often involves the process of determining 
and resolving any problem related with 
computer hardware and/or software. So, 
troubleshooting is a systematic approach 
to problem solving.
If you know the-process of 
troubleshooting, you can find and resolve 
many of the hardware and software 
problems yourself. Before discussing this 
process, let's first discuss what are various 
types troubleshooting.

2. The process of Windows 7 upgrade 
installation is described in the 
following steps.
v Insert the Microsoft Windows 7 

DVD in the DVD drive of your 
computer. The Setup exp program 
will launch automatically and the 
Setup files will be loaded in the 
hard disk.

v Now, choose your language, time 
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and currency format, keyboard or 
input method and click on the Next 
button as shown.

v The next screen will show. Click on 
the Install Now button.

v Now, you will see the Microsoft 
Software License Terms screen. 
Check'l accept the license terms' 
box and click on the Next button.

v In the next screen, click on the 
Custom (advance) option to install 
a fresh copy of Windows 7 as shown 
below.

v Now, choose the drive where you 
want to install Windows 7 and click 
on the Next button.

v During the fifth step, the computer 
will restart and installation will 
continue. This is the most time 
consuming step.

v The computer will restart again and 
the setup will continue to prepare 
your computer for first time use 
and check the video performance.

v After the fifth step, type your 
desired username and click on the 
Next button. If you want to set a 
password, type in the text boxes 
and click on the Next button.

v Now, yow need to enter your 
product key. Enter the key and click 
on the Next button.

v In the next screen, choose your 
desired option for windows update.

v Now, choose your time zone and 
enter the correct date and time in 
the next screen. Click on the Next 
button to continue.

v In the last step of Windows 7 
installation the set up will finalize 
the various setting and prepare the 
desktop as shown below.

3. There are two forms of installation- 
Upgrade Installation and Custom 

(Advanced) Installation.
Upgrade Installation versus Custom 
Installation.
v Where you simply start the 

installation inside of your existing 
operating system. It recognizes that 
an OS already exists, and it upgrades 
to the newest version of this 
operating system and makes sure 
that it keeps all your applications in 
place, and all of your files exactly the 
way they are.

v When you wish to retain your 
existing files or system configuration 
settings, you should upgrade your 
existing Windows Operating System 
by replacing the current windows 
files. Such an installation of 
Windows 7 is called Custom 
(Advanced) Installation.

4. Following are the basic steps of trouble 
shooting.
v Determine the Problem: In order 

to troubleshoot your PC, first you 
should analyze the nature of the 
problem such as:

v What messages is your system 
showing on the screen?

v Are you able to boot your PC?
v Are the power indicators of monitor 

and CPU on?
v Why has the problem occurred? 

Have you shifted your computer 
recently or loaded some software 
into it?

v Categorize the Problem: After 
analyzing you can categorize the proble 
into one of the five types of support - 
User, Software, Hardware, Operating 
System  and  Networking.

v Action Plan: During the action plan, 
first of all decide whether the problem 
can be fixed by the user or it needs a 

Keys Computer (6-8)64



technician. If the problem is relate 
with windows, you can go to the 
control Panel from the Start menu 
and fix the problem yourself. So, it is 
better to document your action plan 
and proceed further.

v Implement the Plan: If you have 
decided to resolve the problem 
yourself, proceed with the 
implementation of the plan. For 
software or operating system 
troubleshooting, you should 
follow the basic guidelines as 
given below.

v Always take backup of your data if 
you are able to boot your system 
before fixing the problem.

v If you are unable to boot your system, 
check all the cable connections and 
try to reboot the computer.

v If you have recently installed any 
software that could have caused 
windows to stop loading, try the 
windows recovery procedure 
through System Restore option 
from the Control Panel.

v Most of the software problems 
occur because of virus attack. So 
scan your system for viruses using 
an  antivirus.

v Run and Test the System: The last 
step in troubleshooting is to 
operate the computer for hours 
and text it properly to make sure 
that the problem has been 
resolved.

5. Sometimes, you need to remove 
unwanted files/programs stored on 
the hard disk. You can delete 
unwanted files and programs from 
your system by choosing any or both 
of these methods.

E. Sheena should use the software is cloud. It 
stores all the photos and videos in the 

computer and run a windows task to copy 
all the photos to another computer in 
home on a nightly basis for backup 
purposes. It essential to keep a set of all 
pictures online in the cloud.
Uploading photos to the cloud has a 
couple of advantages over storing them 
all locally.
1. It can easily share the albus with others.
2. It provides a backup of all your photos in 

case something happens to your local copy.
CH-10           INTERNET APPS
Exercises
A. 1. gadgets, 2. Skype, 3. Group Screen Sharing, 

4. Internet, 5. ARPA, 6. Plugin, 7. Blogs
B. 1. True, 2. True, 3. True, 4. True, 5. False, 6. 

False
C. 1. (a), 2. (c), 3. (b), 4. (a), 5. (c), 6. (a)
D. 1. Internet: The Internet, sometimes 

called simply 'the Net' is a worldwide 
system of computer networks-a 
network of networks in which users at 
any one computer can get information 
from any other computers (and 
sometimes talk directly to users at 
other computers. It was conceived by 
the Advanced Research Projects 
A g e n c y  ( A R PA )  o f  t h e  U. S .  
government in 1969 and was first 
known as the ARPA Net.

2. Multimedia: Multimedia is a term used 
to describe how multiple means of 
media like, text, audio, graphics, 
animation, video and interactivity are 
u s e d  t o  c o m m u n i c a t e  w i t h  
information. It is also often used to 
describe any computer media. This 
helps us to understand information at a 
faster way.

3. RSS: RSS(Rich Site Summary), often 
called (Really Simple Syndication) is a 
type of web feed which allow a user to 
access updates to online content in a 
standardized format. For example: 
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Allow a user to keep track of many 
different web sites in a single news 
aggregator. News and blog sites, 
medical websites, religious 
organization information pages. 
Checking such website repeatedly for 
updating is a difficult job. RSS proves 
to be helpful in such cases.
RSS Feed is refers to a list of items 
presented in an order from newest to 
oldest. Each item usually consists of a 
simple title briefly describing the 
updated content along with a complete 
description and a link to a web page 
with the actual information being 
described.

4. Live cams are another aspect of the 
multimedia available on the web. Live 
cams are video cameras that send their 
data in real-time to a web server.

5. Skype: is an IP telephy service 
provider that offers free calling 
between subscribes and low-cost 
calling to people who don't use the 
service. It includes telephone calls, 
Skype enables file transfer, texting 
video chart and video conferencing.
This service is available for desktop 
computers, notebook, tablet, computers 
and mobile  phone.
Features of Skype
v The Group Video Call feature of 

Skype enables you to make video 
calls that can involves as many as 25 
people at the same time.

v Video Messaging Feature lets you 
capture and share any moment of 
your day with your family and 
friends.

6. The real-time communication tools 
include:
Chat: Text message in real-time.
Audio: Conduct a telephone 
conversation on web.

Skype 

Video : View your audience.
File transfer: Send files back and forth 
among participants.
Document/application sharing: View 
and use a program on another's 
desktop machine.

7. Blogs are refer to a series of entries 
posted to a single page in reverse order. 
Blogs generally represents the 
personality of the author or reflect the 
purpose of the website that hosts the 
blog. The topic of the blog can be an 
anything from personal to professional. 
A blog is what you make of it. Blogging 
can be an interactive activity. Readers 
can add comments to blogger's 
postings, other persons, other persons 
can respond, and  a conversation issues. 
Lately bloggers have become well-
known commentators on the political 
scene, but blogging can encompass 
any topic or no topic at all.

E. 1. Ankit should use the skype to share his 
poem with the word using Internet. 
He will create a blog using given steps:
v Open the site www.blogger.com. 

The Blogger site will open. Click on 
the CREATE YOUR BLOG option.

v To create a blog with the blogger 
site, you must have your account (e-
mail) in Gmail. Else, you will have to 
create a new Gmail account.

v Sign in by applying your Gmail user 
name and password.

v The display page gives you two 
options to create your profile, i.e., a 
Google + profile or a Blogger 
profile. Click on the Create a limited 
Blogger  profile  button.

v Applying a name in the Display 
Name text box as shown on the 
screen. This name will appear as 
your signature in the articles you 
will post on this blog. Click on the 
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Continue to Blogger button and 
select the New blog option from the 
left pane.

v A dialog box appears, give a tittle for 
your blog, say 'My poems' in the 
Title text box. The title will appear at 
the top of every page of your blog. 
The title should reflect the contents 
of  your  blog.

v Applying the URL (address) of your 
blog in the Address: text box, say 
bhaskarips. blogspot.com. Your 
blog address (URL) will be your 
identity on the web and it will be 
used to read and link to your blog.

v Different templates for your blog 
will be displayed in the same 
window under the Template 
section.

v Click the template of your choice. 
Click on the Create blog! Button.

v Your blog has been created.
2. Harshit should use the skype to make a 

video call for conference. Follow the 
given steps to calling on Skype.
vTo make a call on the Skype, select the 

person you wish to call from the 
Contacts tab.

vThe information of the selected contact 
appears on the right pane.

vClick on the Call button if you wish to 
have voice call. Clicking the Video 
call button allows you to have voice as 
well as video calling.

vAfter using any of the selected facility, 
click the Skype > Sign Out option to 
close  your  account.

Model Test Paper- 1
A. 1. (a), 2. (b), 3. (a), 4.(a), 5. (a), 6. (a)
B. 1. Tree, 2. Navigation, 3. Look, 4. 

Datasheet, 5. MS Access
C. 1. False, 2. True, 3. True, 4. True, 5. False
D. 1. Wired Network: Electrical cables such 

as (twisted pair coaxial cable or optical 

fibre) are used to carry signals from one 
end to other.
Wireless Network: They do not 
require cables rather than signals are 
transmitted using Bluetooth, Infrared, 
Microwave or Radiowave.

2. Data Type: Each field has a data type  
that specifies what you can store in it. 
Data entry is limited to valid entries for 
the type you select, which helps prevent 
data entry errors. For example, you 
cannot enter letters in a field set to 
Number and you must enter valid dates 
or times in a Date/Time field.
Text: It enables to enter alpha-numeric 
characters. It has a limit of 255 
characters and it cannot be used for 
numeric calculations. For eg. 
telephone numbers and ZIP codes.
Memo: It has a limit of 63,999 characters 
are used for detailed, descriptive fields.

3. A data base is a collection of information 
that is organized so that it can be easily 
accessed,managed and updated. For 
example, you must have a telephone 
directory in which you maintain all the 
contact details of your friends. The 
contact details would include the 
telephone numbers, addresses and the 
email addresses of your friends. This 
telephone directory can be called your 
database.
Advantages of Using Database
The main advantages of using database 
are as follows:
Minimum data redundancy: Database 
system stores data at one place in the data 
base. The data is integrated into a single, 
logical structure. Different applications 
refer to the data from the centrally 
controlled location. The central storage 
of the data reduces data redundancy.
Minimum data inconsistency: It also 
helps us to minimise data inconsistency. 
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Updating of data values is simple and 
there is no disagreement in the stored 
values. For example, students home 
address is stored at a single location and 
gets updated centrally.
Improvement in data sharing: Data 
sharing refers to sharing the same data 
among more than one user. Each user 
has access to the same data, through 
they may use it for different purposes. 
The database is develop to support 
shared data. Authorised users are 
allowed to use the data from the data 
base.
Improvement in data integrity: The 
database you have created is very 
important for you and it needs 
protection. The database is kept 
secured by limiting access to the 
database by authorised user.
Standardization of data: Since the 
data is stored centrally, it is easy to 
enforce standards on the database. 
Standards could include naming 
conventions and standard for updating, 
accessing and protecting data.

4. To add a new field, follow the steps 
given below.
v Right- click the name of the field 

that you want to be displayed after 
the new field. A menu will emerge.

v Click on Insert Field. A new field 
displays in the table. MS Access will 
assign a name to the new field as 
Field 1. Now, you can rename the 
field name and add information to it.

v Delete a Field in the table.
v You can remove a field that is not 

required in a table.
To delete a field in the table, follow the 
steps given below:
v Right-click on the field that to be 

removed. A menu will display.
v Click on Delete Field. A prompt box 

displays.
v MS Access removes the field and 

record content for the field from the 
table.

5.  Find and Replace commands are also 
useful in MS Access when you have to 
find and replace something in a large 
database. Find enables you to quickly 
search tables, queries and form 
quickly for specified database task. 
Select a field to search through all 
records in the current field only.

E. 1. Effective Backup: In information 
technology, a backup, or the process of 
backing up, refers to the copying and 
archiving of computer data so it may 
be used to restore the original after a 
data loss event.

2. Ribbon: In computer interface design, 
a ribbon is a graphical control element 
in the form of a set of toolbars placed 
on several tabs. ... However, in 2007, 
Microsoft Office 2007 used the term to 
refer to its own implementation of 
tabbed toolbars bearing heterogeneous 
controls, which Microsoft calls "The 
Fluent UI".

3. Alpha-Numeric: The definition of 
alphanumeric is something that 
contains letters and numbers. A 
password that requires both letters 
and numbers is an example of an 
alphanumeric password. A computer 
keyboard is an example of an 
alphanumeric keyboard.

4. Modifying Table: Create or modify 
tables or indexes by using a data-
definition query. Applies To: Access 
2010. You can create and modify tables, 
constraints, indexes and relationships 
by writing data-definition queries in 
SQL view.

5. Wireless: A wireless modem is a 
modem that bypasses the telephone 
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system and connects directly to a 
wireless network, through which it can 
directly access the Internet connectivity 
provided by an Internet service provider 
(ISP).

Model Test paper-2
A.  1. (c), 2. (b), 3. (b), 4. (b), 5. (c), 6. (c)
B. 1. Internal, 2. Unordered, 3. Form, 4. 

Border Spacing, 5. Report
C. 1. False, 2. True, 3. False, 4. True, 5. True
D. 1. A Query is a simple question that you 

ask to find a particular information 
from the database. Similarly in Access, 
when you create a query, you are 
defining particular search conditions. 
You can queries to view, change, 
summarise and analyse the particular 
data in different ways.

2. Tables are very popular on the web 
since they are flexible and an effective 
way of presenting information in the 
form of rows and columns.
v To make a table in HTML, <table> 

tag is applied. Each table starts with 
a <table> tag and ends with </table> 
tag.

Types of Linking
Internal Linking External Linking
Internal Linking: When one part of a 
web page is linked to another part on 
the same page, it is called internal 
linking.
External linking: When one page is 
linked to another web page or website, 
it is called external linking.

E. 1. Flash Memory: Flash memory is a non-
volatile memory chip used for storage 
and for transfering data between a 
personal computer (PC) and digital 
devices. It has the ability to be 
electronically reprogrammed and 
erased. It is often found in USB flash 
drives, MP3 players, digital cameras 
and solid-state drives.

2. Markup Language: Markup languages 
are designed for the processing, 
definition and presentation of text. The 
language specifies code for formatting, 
both the layout and style, within a text 
file. The code used to specify the 
formatting are called tags. HTMLis a an 
example of a widely known and used 
markup language.

3. QBASIC: QBasic short form of Quick 
Beginners All purpose Symbolic 
Instruction Code is an IDE and 
interpreter for a variety of the BASIC 
programming language which is 
based on Quick BASIC. Code entered 
into the IDE is compiled to an 
intermediate representation, and this 
IR is immediately interpreted on 
demand with in the  IDE.

4. Link Break: On the Data tab, in the 
Connections group, click Edit Links. ... 
In the Source list, click the link that you 
want to break. To select multiple linked 
objects, hold down Ctrl, and then click 
each linked object.

5. Mask Layer flash: Masking is a way for 
you to control the content that your 
audience sees. For example, you can 
make a circular mask and allow your 
audience to only see through the 
circular area, so that you get a keyhole 
or spotlight effect. In Flash, you put a 
mask on one layer and the content that 
is masked in a layer below it.

Model Test Paper-3

A.  1 (c), 2. (a), 3. (a), 4. (b), 5. (c), 6. (b)

B. 1. Objects, Procedures 2. Group Screen 
Sharing, 3. Disk Partitioning 4. Flat, 5. 
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Data

C. 1. False, 2. False, 3. True, 4. False, 5. True

D. 1. Properties: Properties specify the name 
of the form or an object. The common 
properties of the form are given below.

Name: It defines the name of the form 
by which it is referred to in the code. The 
default name of the form is Form1.

Caption: It provides the title of the 
form.

Appearance: It can have different 
values. The values 0 creates the form 
look flat, while the value 1 creates the 
form look three-dimensional.

Font: It is used to define the font type, 
font style and font size for the text.

Font Color: This property sets the 
colour of the form.

Back Color: This property sets background 
colour of the form.

Enabled: It can have True or False value. 
The value True allows the form respond 
to mouse and keyboard events, while 
the value False allows it unable to 
respond.

Visible: It can also have True or False 
value. The value True causes the form 
visible, while the value false causes it 
invisible.

Methods:
Methods are the actions performed on 
the form or objects. The common 
methods of the form are given below.

Show: This method causes the form 
visible. It is the same as setting a form's 
visible property to True.

Hide: It makes the form invisible.

Print: It shows text string on the form.

Events: An event is a message sent by an 
object denoting that something has 
occurred. The common events of the 
form are given below.

Form-Click: When the user clicks on 
the form, Form-click event is triggered.

Form-load: When the form is loaded, 
Form-load event is triggered.

2. Sometimes, you need to remove 
unwanted files/programs stored on the 
hard disk. You can delete unwanted 
files and programs from your system by 
choosing any or both of these methods.

3. In order to develop applications on 
Java, we first need to install Java 
Development Kit (JDK ver. 1.5 or 1.6) 
in our computer. Then, we follow the 
three-step procedure to develop 
applications.
v Enter the program in Notepad.
v Compile the program with Java 

Compiler (javac).
v Run the program in Java.
v Entering the Java Program
Java program is entered into the 
computer using a text editor such as 
Notepad. To enter the program using 
Notepad, follow the steps given below.
v Click Start à All programs à 

Accessories à Notepad menu 
options to load Notepad.

v Type the program in the New 
Document.

v Choose File Save menu option in 
the Notepad to save the program.

v Click All Files option in the Save As 
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type box of the Save As dialog box 
and type the name of the file with 
extension name java in File name 
box.

v Then, click on the Save button.
v Compiling the Java Program
Java program is compiled at the DOS 
prompt. So, you need to go to the 
Command prompt in order to compile 
your program. Now, to compile the 
Java program, follow the steps given 
below.
v Click Start All Programs Accessories 

Command Prompt menu options 
for accessing the DOS prompt.

v In DOS prompt, change to that 
directory (folder) where your 
program is saved by typing the 
DOS command, cd <folder name>.

v To compile the program, type Java 
< file name with extension>. The 
program will be compiled.

v Running the Java Program
v In order to run the compiled Java 

program, type the command, java < 
file name without extension>. The 
program will run and you will get 
the output.

5. There are two forms of installation- 
Upgrade Installation and Custom 
(Advanced) Installation.

Upgrade Installation versus Custom 
Installation:
Where you simply start the installation 
inside of your existing operating 
system. It recognizes that an OS 
already exists, and it upgrades to the 

newest version of this operating 
system and makes sure that it keeps all 
your applications in place, and all of 
your files exactly the way they are.

When you wish to retain your 
existing files or system configuration 
settings, you should upgrade your 
existing Windows Operating System by 
replacing the current windows files. 
Such an installation of Windows 7 is 
called Custom (Advanced) Installation.

E. 1. Forms in Access: A form in Access is a 
database object that you can use to 
create a user interface for a database 
application. A "bound" form is one that 
is directly connected to a data source 
such as a table or query, and can be used 
to enter, edit, or display data from that 
data source.

2. Ordered List: Use the HTML <ol> 
element to define an ordered list. Use 
the HTML type attribute to define the 
numbering type. Use the HTML <li> 
element to define a list item. Use the 
HTML <dl> element to define a 
description list. Use the HTML <dt> 
element to define the description term.

3. Report in Microsoft Access: A report 
is an object in Microsoft Access that is 
used to display and print your data in 
an organized manner. The Navigation 
Pane is where you can find all of the 
saved reports in the database. To view 
your reports, make sure that all objects 
are visible in the Navigation Pane. 

4. Img HTML: The <img> tag defines an 
image in an HTML page. The <img> 
tag has two required attributes: src and 
alt. Note: Images are not technically 
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inserted into an HTML page, images 
are linked to HTML pages. ... Tip: To 
link an image to another document, 
simply nest the <img> tag inside <a> 
tags.

5. Border in excel: By Vangie Beal In the 
Microsoft Excel program, "borders" is a 
built-in tool that lets users access 
predefined border styles to add a 
border around two or more cells on a 
spreadsheet. You can also use the 
borders tool to create your own custom 
border.
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